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PREFACE 

This book Comp-162 Computer Applications has been written according to 

the revised curriculum approved by TEVTA for Diploma of Associate 

Engineers first year electrical technology.  

This is the age of information technology and computer is essential part of this 

technology. Computer has come out from its earlier specific applications i.e. 

research and engineering etc. Now it is becoming an integral part of general 

society. Today we can see the computer in our daily life, like in colleges, 

schools, offices, vehicles and even in pockets. 

The main objective to write this book is to provide ready reference facility for 

students of electrical technology to explain the enduring concepts of computer 

hardware and software, and to show you the concrete ways that these ideas 

affect the correctness, performance, and utilities of operating systems 

Windows and application programs like MS Word, MS PowerPoint and web 

browser. This book also helps you understand the principles and acquire the 

practical skills of programming using the C++ programming language 

according to technology.  
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C H A P T E R  1  

 

E L E C T R O N I C S  D A T A  

P R O C E S S I N G  

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of Electronic Data Processing. 

 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 

 

 Basic Terms of Computer Science Data & its, types, Information, 

Hardware, Software  

 Computer & its types  

 Generations of Computers  

 Block diagram of a computer system  

 BIT, Byte, RAM & ROM  

 Input &Output devices  

 Secondary storage devices  

 Types of Software  

 Programming Languages  

 Applications of computer in different fields  

 Application in Engineering, Education & Business  
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ELECTRONIC DATA PROCESSING 

(E.D.P) 
Electronic Data Processing is the use of computers in recording, classifying, 

manipulating, and summarizing of the data. 

Some Examples of E.D.P 

 Students Admission or Examination System 

 Payroll System 

 ATM System 

 Stock Control System 

 Electronic Fund Transfer 

 Ticket Buying System 

 

1.1 - BASIC OVERVIEW OF COMPUTER 

1.1.1- COMPUTER 

The term computer is derived from the word compute. The word 

compute means to calculate. A computer is an electronic data processing 

machine that accepts data from user as input, processes that data by 

performing calculations and operations on it according to the given 

instructions, stores data for later retrieval and generates the desired output 

results (information) as illustrated in figure 1.1. 

 

 
Figure 1.1 – Data Processing Cycle 

1.1.2 - DATA AND ITS TYPES 

Data 

A collection of raw facts and figures is called data. These facts can be 

the numbers, words, images, audio, measurements and observations. The word 

raw means that the facts have not yet been processed to get their actual 

meanings.  

 

Examples 

 Each student's test score is one piece of data. 

 A product purchased by a customer is also piece of data. 
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Types of data 

There are different types of data that may consist of numbers, text, 

symbols, images, videos and voice. 

 

1. NUMERIC DATA 

Numeric data consists of positive or negative numbers that may also 

be integer without any fractional part or real number which includes integers 

with fractions. Numeric type data is usually used for calculations.  

Examples of Integer numbers Examples of Real numbers 

12, 256, -23, -87 3.1415, -5.40, 7.86 

2. ALPHABETIC DATA 

Alphabetic data contains the letters a, b, c… up to z. These letters may 

be small or capitals. Alphabets are basic part of any human language. In real 

life everything is called with its name and every name made up with 

alphabets.  

Examples of Alphabetic Data 

Islamabad, Zain, Table, Office, College, TEVTA, computer etc 

3. ALPHANUMERIC DATA 

Alphanumeric data is combination of alphabets, numbers, special 

characters (symbols) and space character. 

Examples of Alphanumeric Data 

Year2017, Roll No 15EA04, $46, 0330-1234567 

4. GRAPHIC DATA 

Graphics includes pictures, snaps, drawings, charts and moving 

pictures (movies) etc. 

5. AUDIO DATA 

Audio includes any type of voice that may be Tilawat, Naats, National 

Songs, human voice, etc. 

 

1.1.3 - DATA PROCESSING 

Microprocessor is the central part in computer system, also known as 

processor. Processing is carried out by microprocessor. Processing is the stage 

where the input data is manipulated in order to produce meaningful 
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information. Processing can include a number of stages such as sorting, 

searching, calculations, graphing etc.  

1.1.4 - INFORMATION 

Information is the data produced by computer after processing. The 

use of information is to have decisions. 

 Information is also defined as processed, organized, useful, purified 

and meaningful form of data. 

 

Example 

The average score of a class or of the entire school is information that 

can be derived from the given data. 

 

1.1.5 - INFORMATION TECHNOLOGY (IT) 

Information technology (IT) refers to anything related to computing 

technology, such as networking, hardware, software, the Internet, or the 

people that work with these technologies.  

 

HARDWARE 

Computer hardware includes the physical parts of a computer, such as 

the case, central processing unit, monitor, mouse, keyboard, computer data 

storage, graphics card, sound card, speakers and motherboard. By contrast, 

software is the set of instructions that can be stored and run by hardware. Or 

Hardware refers to the physical elements of a computer. Also referred to as 

the machinery or the equipment of the computer. Examples of hardware in a 

computer are the keyboard, the monitor, the mouse and the processing unit 

However, most of a computer's hardware cannot be seen; it’s inside the 

computer case. 

 

SOFTWARE 

Computer software, or simply software, is a collection of data or 

computer instructions that tell the computer how to work. This is in contrast to 

physical hardware, from which the system is built and actually performs the 

work. Or Software is a set of instructions, data or programs used to operate 

computers and execute specific tasks. Examples of applications include office 
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suites, database programs, web browsers, word processors, software 

development tools, image editors and communication platforms. 

1.2 - COMPUTER AND ITS TYPES   

There are three types of computers; 

1- ANALOG COMPUTERS 

Analog computers are used to process analog data. Analog data is of 

continuous nature and which is not discrete or separate. Such type of data 

includes temperature, pressure, speed weight, voltage, depth etc. These 

quantities are continuous and having an infinite variety of values. 

Analog computers are used to in making and in chemical industry and 

oil refinery etc. where flow and temperature measurements are important.  

2- DIGITAL COMPUTERS 

Most of the computers available today are digital computers. Digital 

computers process the digits to represent numerals, letters or other special 

symbols. 

Digital computers operate on inputs which are ON-OFF type and its 

output is also in the form of ON-OFF signal. 

Normally, an ON is represented by a 1 and an OFF is represented by a 

0. It is also known as binary 1 or 0. 

Examples of digital electronic computers include the IBM PC, 

calculators, the Apple Macintosh as well as modern smart-phones. 

 

3- HYBRID COMPUTERS 

A hybrid is a combination of digital and analog computers. It 

combines the best features of both types of computers, i-e. It has the speed of 

analog computer and the memory and accuracy of digital computer.  

Hybrid computers for example are used for scientific calculations, in 

defense and radar systems, In Intensive Care Unit (ICU) to measure patient’s 

blood pressure and temperature etc. 

 

1.3 – COMPUTER GENERATIONS 

Computers are such an integral part of our everyday life now most 

people take them and what they have added to life totally for granted. There 

are following five generations of computers. 
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Figure 1.2 First Generation Computers 

1940 – 1956:  First Generation – Vacuum Tubes 

These early computers used vacuum tubes as circuitry and magnetic 

drums for memory. As a result, they were enormous, literally taking up entire 

rooms and costing a fortune to run. 

These were inefficient materials which generated a lot of heat, sucked 

huge electricity and subsequently generated a lot of heat which caused 

ongoing breakdowns. These first generation computers relied on ‘machine 

language’ (which is the most basic programming language that can be 

understood by computers). These computers were limited to solving one 

problem at a time. Input was based on punched cards and paper tape. Output 

came out on print-outs. The two notable machines of this era were the 

UNIVAC and ENIAC machines – the UNIVAC is the first every commercial 

computer which was purchased in 1951 by a business. 

1956 – 1963: Second Generation – Transistors 

The replacement of vacuum tubes by transistors saw the advent of the 

second generation of computing. Although first invented in 1947, transistors 

weren’t used significantly in computers until the end of the 1950s. They were 

a big improvement over the vacuum tube, despite still subjecting computers to 

damaging levels of heat.  
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However, they were hugely superior to the vacuum tubes, making 

computers smaller, faster, cheaper and less heavy on electricity use. They still 

relied on punched card for input/printouts. 

The language evolved from cryptic binary language to symbolic 

(‘assembly’) languages. These meant programmers could create instructions 

in words. About the same time high level programming languages were being 

developed (early versions of COBOL and FORTRAN). 

Transistor-driven machines were the first computers to store 

instructions into their memories – moving from magnetic drum to magnetic 

core ‘technology’. The early versions of these machines were developed for 

the atomic energy industry. 

 

1964 – 1971: Third Generation – Integrated Circuits 

By this phase, transistors were now being miniaturized and put on 

silicon chips (called semiconductors). This led to a massive increase in speed 

and efficiency of these machines.   

These were the first computers where users interacted, using 

keyboards and monitors who interfaced with an operating system, a 

significant leap up from the punch cards and printouts. This enabled these 

machines to run several applications at once using a central program which 

functioned to monitor memory. 

As a result of these advances which again made machines cheaper and 

smaller, a new mass market of users emerged during the ‘60s. 

 

1972 – 2010: Fourth Generation – Microprocessors 

This revolution can be summed in one word: Intel. The chip-maker 

developed the Intel 4004 chip in 1971, which positioned all computer 

components (CPU, memory, input/output controls) onto a single chip. What 

filled a room in the 1940s now fit in the palm of the hand. The Intel chip 

housed thousands of integrated circuits. The year 1981 saw the first ever 

computer (IBM) specifically designed for home use and 1984 saw the 

Macintosh introduced by Apple. Microprocessors even moved beyond the 

realm of computers and into an increasing number of everyday products. 
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The increased power of these small computers meant they could be 

linked, creating networks which ultimately led to the development, birth and 

rapid evolution of the Internet. Other major advances during this period have 

been the Graphical user interface (GUI), the mouse and more recently the 

astounding advances in lap-top capability and hand-held devices. 

2010- : Fifth Generation – Artificial Intelligence 

Computer devices with artificial intelligence are still in development, 

but some of these technologies are beginning to emerge and be used such as 

voice recognition. 

Artificial Intelligence (AI) is a reality made possible by using parallel 

processing and superconductors. Leaning to the future, computers will be 

radically transformed again by quantum computation, molecular and nano 

technology. 

The essence of fifth generation will be using these technologies to ultimately 

create machines which can process and respond to natural language, and have 

capability to learn and organize themselves. 

1.4 - COMPONENTS OF COMPUTER SYSTEM 

Computer system can be divided into following parts 

 Computer Hardware 

 Computer Software 

1.4.1 - COMPUTER HARDWARE   

 Hardware represents the physical and tangible components of a 

computer i.e. the components that can be seen and touched. These components 

include keyboard, mouse, memory, processor, disks, disk drives, display 

screens, printers, speakers, mother boards, and chips etc. 

1.4.2 - COMPUTER SOFTWARE 

 Software represents the logical or intangible parts of computer. 

Software is collection of different programs. A program is set of electronic 

instructions that tell the computer what to do and how to do a particular task. 

Software is developed in a computer programming language.  

 Software can be categorized according to what it is designed to 

accomplish. Different software's are used to solve different problems. There 

are two major software categories, the system software and the application 

software or apps.  
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BLOCK DIAGRAM OF COMPUTER 

Computer hardware further divided into following three units as 

described and shown above in diagram 1.3. 

 Input Unit: deals with input devices, these devices are used to feed 

data into computer. Six widely used input devices are keyboard, 

mouse, scanner, microphone, digital camera, web cam. 

 Output Unit: consists of output devices which are used to deliver 

processed information. Four widely used output devices are monitor, 

printer, plotter and speakers. 

 System Unit: The system unit is a case consists of electronic 

components of the computer that provide data processing and storage 

facility. Some important devices houses in this units are CPU, RAM, 

mother board, hard disk, CD drive etc.  

 

Figure 1.3 – Block Diagram of Computer 

 

 Memory Unit 

Memory unit is divided into two types i.e primary unit and secondary 

unit. Primary unit include the RAM (Random Access Memory) it 

stores data temporarily as long as the computer system is ON. 

Secondary memory unit include the storage devices like Hard Disk, 

Flash Drive, SD Cards, CDs, DVDs etc. These devices can store data 

permanently. 
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 CPU 

A central processing unit (CPU), also called a central processor, 

main processor or just processor, is the electronic circuitry within a 

computer that executes instructions that make up a computer program. 

The computer's central processing unit (CPU) is the portion of a 

computer that retrieves and executes instructions. The CPU is 

essentially the brain of a CAD system. It consists of an arithmetic and 

logic unit (ALU), a control unit, and various registers. The CPU is 

often simply referred to as the processor. 

 

 

 

Components of CPU CPU 

 

The Control Unit 

The control unit (CU) is a component of a computer's central 

processing unit (CPU) that directs the operation of the processor. It tells the 

computer's memory, arithmetic and logic unit and input and output devices 

how to respond to the instructions that have been sent to the processor. Control 

unit or CU is circuitry that directs operations within a computer's processor. It 

lets the computer's logic unit, memory, and both input and output devices 

know how to respond to instructions received from a program. Examples of 

devices that utilize control units include CPUs and GPUs. 
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The Arithmetic Logic Unit 

An arithmetic-logic unit (ALU) is the part of a computer processor (CPU) that 

carries out arithmetic and logic operations on the operands in 

computer instruction words. In some processors, the ALU is divided into two 

units, an arithmetic unit (AU) and a logic unit (LU).  

Typically, the ALU has direct input and output access to the processor 

controller, main memory (random access memory or RAM in a personal 

computer), and input/output devices. Inputs and outputs flow along an 

electronic path that is called a bus. In general, the ALU includes storage places 

for input operands, operands that are being added, the accumulated result 

(stored in an accumulator), and shifted results. The flow of bits and the 

operations performed on them in the subunits of the ALU is controlled by 

gated circuits. The gates in these circuits are controlled by a sequence logic 

unit that uses a particular algorithm or sequence for each operation code. In the 

arithmetic unit, multiplication and division are done by a series of adding or 

subtracting and shifting operations. 

The design of the ALU is obviously a critical part of the processor and new 

approaches to speeding up instruction handling are continually being 

developed. 

 

 

ALU Input & Output Flow 

 

 

 Memory Unit 

Memory unit is divided into two types i.e primary unit and secondary 

unit. Primary unit include the RAM (Random Access Memory) it 

stores data temporarily as long as the computer system is ON. 

Secondary memory unit include the storage devices like Hard Disk, 
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Flash Drive, SD Cards, CDs, DVDs etc. These devices can store data 

permanently. 

1.5 INPUT AND OUTPUT DEVICES 

 Input and output devices are used to interact with the computer system. 

Input devices let you to transfer data and user command into the computer 

system. Most commonly used input devices are keyboard, mouse, touch pad, 

scanner, microphone, joystick and digital camera etc. 

 On the other hand, output devices display the result of input data or 

signals after processing it. Examples of these could be your computer’s 

monitor, printer, plotter and speakers. 

1.5.1 - INPUT DEVICES 

KEYBOARD 

 The keyboard is one of the primary ways we communicate with the 

computer and enter data. The most widely used layout in the English language 

is called QWERTY.A standard desktop computer keyboard contains 101 to 

105 keys as shown in figure 1.4. 

 

Figure 1.4 – Desktop Computer Keyboard 

 There are many different types of computer keyboards, including 

wired, wireless, ergonomic, and multimedia. 

TYPES OF KEYS 

Alphabetic Keys 

 All of the letters on the keyboard A-Z either may be small or capitals.  

Numeric Keypad 

Numeric keypad is located on the right side of the keyboard and 

consists of keys having numbers (0 to 9) and mathematical operators (+ − * /) 
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defined on them. This keypad is provided to support quick entry for numeric 

data. 
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Punctuation Keys 

 All of the keys associated with punctuation such as the comma, period, 

semicolon, brackets, and parenthesis etc. Also, all of the mathematical 

operators such as the plus sign, minus sign, and equal sign etc. 

Special Keys 

 All of the other keys on the computer keyboard such as the control 

keys, arrow keys, caps lock key, delete key etc. 

Cursor Movement Keys 

 These are arrow keys and used to 

move the cursor in the direction 

indicated by the arrow (up, down, left, 

right). 

Function Keys 

 Function keys labeled F1 to F12. 

These keys have different meaning 

depending on which program is running. 

MOUSE 

A mouse (figure 1.5) is the most widely used pointing device with a  

          

   Figure 1.5 - Mouse 

 

GUI (Graphical User Interface) environment on personal computers. A 

mechanical mouse has a rubber ball on its underside to detect movement of 

the mouse. An optical mouse uses devices that emit and sense light to detect 

the mouse's movement. A cordless mouse (either mechanical or optical) 

transmits data using wireless technology. 

 Some common mouse operations are point, click, right click, double 

click, drag and rotate wheel etc. 

TRACK BALL 

Track Ball (figure 1.6) is an input device 

like a mouse. It is used in Lap top 

computers to control motion of pointer on 

screen. It is a pointing device like upside 

down mouse. It has a ball on its upper side. 

 This ball is moved by fingers or 

Figure 1.6 – Track Ball 
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thumb and the pointer moves accordingly on screen. 

TOUCH PAD 

Touch pad (figure 1.7) is a pointing 

input device. It is used in Lap top computers 

to control motion of pointer on screen. 

Touch pad is a stationary input device. It 

has a flat surface of 1.5 to 2 square inch. 

 Finger is moved on this surface to 

move pointer on screen. 

JOY STICK 

 Joystick (figure 1.8) is an input 

device used to play games on computer. It is 

used to control motion of an object quickly in 

game with the help of a hand held stick. 

 This stick can be moved forward, 

backward or sideways. The buttons called the 

triggers. Joystick also used occasionally 

for CAD/CAM systems. 

LIGHT PEN 

 Light Pen (figure 1.9) let you move 

the pointer and allow the user to point to 

displayed objects or draw on the screen in a 

similar way to a touch-screen but with 

greater positional accuracy. 

 

SCANNER 

Scanner (figure 1.10) is important input 

device of a computer system. A scanner 

converts printed documents in to images. 

Some types of scanners scan documents 

and produce the results in black and white 

images. The scanner operates in the same manner as a photocopier.  

MICROPHONE 

Figure 1.7 – Touch Pad 

Figure 1.9 – Light Pen 

Figure 1.10 - Scanner 

Figure 1.8 - Joystick 
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 Microphone (figure 1.11) is an input device used to enter voice data 

into the computer. Computer microphones are used for a variety of purposes, 

from recording audio, voice chatting, teleconferencing to video conferencing. 

TOUCH SCREEN  

A touch screen (figure 1.12) is 

display screen that enables the user to 

interact with the computer by touching areas 

on the screen. It allows the user to interact 

with a device without a mouse or keyboard 

and is used with smart phones, tablets 

and computer screens 

 Touch screen is used in ATM and in 

latest smart phones to receive input from the 

user. 

DIGITAL CAMERA 

 Digital Cameras (figure 1.13) are 

used to capture images. Those images are 

then transferred to a computer when the 

Camera is connected to the computer.  

 Mostly the Digital Camera images 

are in JPEG format. 

1.5.2 - OUTPUT DEVICES 

 

MONITOR 

 Monitor or display screen is most important output device. It is used 

to display the video and graphics information generated by the computer 

through the video card. Monitors are very similar to televisions but with 

higher resolution. Figure 1.14 shows different types of monitors. 

Figure 1.11 - Microphone 

Figure 1.12 – Touch Screen 

Figure 1.13 – Digital Cameras 
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Figure 1.14 – Different Types of Monitor 

TYPES OF MONITORS 

According to technology, size, weight, price and picture quality 

following monitors are widely used in computer.  

CRT 

 CRT (short for Cathode Rays Tube) monitors look much like old-

fashioned televisions and are very deep in size. It works by moving an 

electron beam produced by picture tube across the back of the screen.  

LCD 

LCD (Liquid Crystal Display) monitors are much thinner, use less 

energy, and provide a greater graphics quality. LCD technology can be 

mostly found in portable devices like digital watches, tablets, and smart 

phones etc.It is also offered in full size monitor as alternatives to CRT 

monitors.  

The technology works by passing an electric current through liquid 

crystal which is contained between two sheets of polarizing material. 

LED 

LED (Light-Emitting diode) is a semiconductor light source used as 

indicator lamp in many devices. It is simple a LCD that uses LEDs for back 

lighting, which creates images/Pictures in display devices like TV. 

PLASMA 

 Plasma Display Panel (PDP) is flat panel display. They contains small 

cells containing electrically charged ionized gases, when electrical current 

pass through the phosphors it lights up themselves to create the image on the 

screen. 

 

PRINTERS 

A printer is an output device that prints characters, symbols and 

graphics, on paper. The printed output is called hard copy.  
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There are two types of printers Impact Printers & Non-Impact Printers. 
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(A) - IMPACT PRINTERS 

Impact type printers used pins and hammer that strikes against the 

paper through ribbon .Printing quality of impact printer is not good, it create 

noise while printing. The impact printers are used where low-cost printing is 

required.  

Three common forms of impact printers (figure 1.15) are as follows 

 Dot matrix printers 

 Daisy wheel printer 

 Line printer 

 

Figure 1.15 – Impact Printers 

DOT MATRIX PRINTER 

Dot matrix printer creates characters by striking pins against an ink 

ribbon. Each pin makes a dot, and combinations of dots form characters. The 

dot-matrix printer uses print heads containing from 9 to 24 pins. Dot-matrix 

printers are inexpensive and typically print at speeds of 100-600 characters 

per second. 

DAISY WHEEL PRINTER 

Similar to a ball-head typewriter, the printer uses a metal or plastic 

disk containing each of the letters, numbers, and other characters it supports. 

When something is printed, the printer rotates the disk to each character and 

then using a hammer strikes each character into an ink ribbon to create the 

character on paper. 

LINE PRINTER 

Line printer contains a chain of characters or pins that print an entire 

line at one time. Line printers are very fast, but produce low-quality print. 

They can typically print the range of 1,200 to 6,000 lines per minute. Drum, 

chain, and band printers are line printers. 

(B) - NON-IMPACT PRINTERS 
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A non-impact printer prints characters and graphics on paper without 

striking paper. Some printers use sprays ink while others use heat and 

pressure. 

These printers are costly but faster and having no noise during 

printing. Different kinds of non-impact printers (figure 1.16) are as follows 

 LASER printer 

 Inkjet printer 

 Thermal printer 

 
Figure 1.16 – Non Impact Printers 

LASER PRINTER 

LASER is short for Light Amplification by Stimulated Emission of 

Radiation. Laser printer uses the same technology as photo copy machines 

and produce very high quality text and graphics. The speed of laser printers is 

high and they print quietly without producing much noise. Many home-use 

laser printers can print eight pages per minute, but faster and print 

approximately 21,000 lines per minute, or 437 pages per minute if each page 

contains 48 lines. 

INKJET PRINTER  

Ink-jet printers form characters on paper by spraying ink from tiny 

nozzles through an electrical field that arranges the charged ink particles into 

characters at the rate of approximately 250 characters per second. The ink is 

absorbed into the paper and dries instantly. Various colors of ink can also be 

used. 

PLOTTERS 

Plotter (figure 1.17) is hardcopy 

output device used to print large linear 

drawings. The drawing or design is 

conveyed to the paper surface by plotting a 

Figure 1.17 - Plotter 



COMP-162 COMPUTER APPLICATIONS 

 

 
21 | P a g e  

 

serial of points and connecting them with lines. 

 Plotters are most often used for drafting or map making. It can 

produce full color renderings as well as geometric line drawings. 

SPEAKERS 

A speaker is a softcopy output device 

that plays sound generated by the computer. 

They are usually in a group of two and come in 

various sizes and shapes. You can listen to 

songs which are stored on the hard disk of the 

computer through the speaker. 

  

1.6- SYSTEM UNIT AND ITS DEVICES 

 The system unit is a case consists of electronic components of the 

computer that provide data processing and storage facility. Some important 

devices houses in this units are CPU, RAM, mother board, hard disk, CD 

drive etc. 

1.6.1 - CPU (Central Processing Unit) 

 CPU or central processing unit is a chip 

considered as the brain of the computer. It is 

also called processor.  

It performs all types of data processing 

operations. It stores data, intermediate results 

and instructions (program).It controls the 

operation of all parts of computer. Figure 1.19 

shows the CPU for personal computers. 

 

COMPONENTS OF CPU 

CPU itself has following three components 

 Arithmetic Logic Unit) 

 Control Unit 

 Memory or Storage Unit  

Figure 1.18 - Speaker 

Figure 1.19 – CPU 
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1. ARITHMETIC LOGIC UNIT (ALU) 

This unit consists of two subsections namely 

 Arithmetic section 

 Logic Section 

Arithmetic Section 

Function of arithmetic section is to perform arithmetic operations like 

addition, subtraction, multiplication and division. All complex operations are 

done by making repetitive use of above operations. 

Logic Section  

Function of logic section is to perform logic operations such as 

comparing, selecting, matching and merging of data. 

2. MEMORY OR STORAGE UNIT (MU) 

These are high speed memory locations built into CPU. The memory 

registers temporarily hold the program instructions for the program to be 

executed, the input data to be processed and the intermediate results of any 

calculations when the processing is being done. 

3. CONTROL UNIT  (CU) 

This unit controls the operations of all parts of computer. It is 

responsible for controlling the transfer of data and instructions among other 

units of a computer. It manages and coordinates all the units of the computer. 

It communicates with Input/output devices for transfer of data or 

results from storage. 

1.6.2 - PRIMARY MEMORY 

Primary memory is accessible directly by the processing unit. RAM, 

ROM and Cache are examples of primary memory. 

RAM - (Random Access Memory) 

 RAM (figure 1.20) is main memory of 

computer. It is referred to as random access memory 

(RAM) because it. It is also called read/write 

memory. The storage of data and instructions inside 

the primary storage is temporary. All data and 

instructions disappear from RAM as soon as the 

power to the computer is switched off because it is 

the type of volatile memory.  

Figure 1.20 - RAM 
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TYPES OF RAM 

D-RAM 

 Dynamic Random Access Memory is the more common type. It is 

slower because it needs to be refreshed thousands of times per second. 

DRAM supports access times of about 60 nanoseconds. It is an inexpensive 

memory. 

S-RAM 

 Static Random Access Memory is faster than DRAM in term of speed 

because it does not need to be refreshed.  SRAM can give access times as low 

as 10 nanoseconds. Despite SRAM being faster, it's not as commonly used as 

DRAM because it's so much more expensive.  

ROM  

ROM (read-only memory) refers to special 

memory chip (figure 1.21) used to store programs 

that boot the computer and perform diagnostics. The 

ROM can only be read by the CPU but it cannot be 

changed. The basic input/output system (BIOS) 

program is stored in the ROM that examines and 

initializes different equipment attached with the PC. 

ROM is type of non-volatile memory. 

PROM 

 PROM is programmable read only memory. PROM allows the data to 

be loaded by the user but it can be written only once. Once a program has 

been written onto a PROM, it remains there forever. 

EPROM 

 EPROM (Erasable programmable read only memory) is a special type 

of PROM that can be erased by exposing it to ultraviolet light. Once it is 

erased, it can be reprogrammed. An EPROM is similar to a PROM, but 

requires only ultraviolet light to be erased. 

EEPROM 

 Pronounced e-e-prom, an EEPROM (Electrically erasable 

programmable read only memory) is a special type of PROM that can be 

erased by exposing it to an electrical charge. Like other types of PROM, 

Figure 1.21 – ROM Chip 

http://www.webopedia.com/TERM/S/store.html
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EEPROM retains its contents even when the power is turned off. Also like 

other types of ROM, EEPROM is not as fast as RAM. 

1.6.3 - CACHE MEMORY 

Cache memory, also called CPU memory, is static type random access 

memory (RAM) that a computer microprocessor can access more quickly than 

it can access regular RAM. This memory is typically integrated directly with 

the CPU chip or placed on a separate chip that has a separate bus interconnect 

with the CPU. 

Cache memory is a small-sized type of volatile computer memory that 

provides high-speed data access to a processor and stores frequently used 

computer programs, applications and data. It stores and retains data only until 

a computer is powered up. 

1.6.4 – BIT & BYTE 

BIT 

 A bit (short for Binary digit) is the smallest unit of data/information 

that can be stored or manipulated in a computer. A bit can have a binary value 

of either 0 or 1.  

 Binary means that there are only two logical choices or states i.e.  

True/false or on/off.  A bit can be a tiny magnetic region on a hard disk, a 

tiny dent on a CD or DVD, or a tiny transistor on a memory stick. 

BYTE 

 A byte is a set of 8 bits that represent a single character in the 

computer's memory. Bytes are used to measure file sizes, hard disk space, and 

computer memory. Larger amounts of data are measured in units such as 

megabytes, gigabytes, and terabytes. For example, one kilobyte is equal to 

1,024 bytes. The short form of a byte is an upper-case B. 

 

1.7 - SECONDARY STORAGE DEVICES 

 Secondary storage devices are used to store data and instructions 

permanently. These devices also called auxiliary storage or external storage. 

These are non-volatile storage that is not under the direct control of a 
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computer's central processing unit(CPU). Examples of secondary storage 

devices are Floppy Disk, Hard Disk, CD and DVD etc. 

MAGNETIC TAPE 

 Magnetic tape is the oldest storage device. It is made of plastic coated 

with magnetic material. Tape drive is used to read and write data on tape. 

Magnetic tape is sequential access device. 

It is slower device than magnetic disk or optical disk. Usually 

magnetic tapes are used to take data backups. 

FLOPPY DISK 

The floppy disk (figure 1.22) was 

introduced by IBM in 1971. It was 

officially called “diskette”. FD is 

removable storage medium that 

consists of a thin and flexible magnetic 

disk inside a plastic carrier. 

 The floppy disk drive or FDD is a piece of computer hardware that 

reads data from, and writes data to, a floppy disk. The 3.5inches’floppy disk 

can store 1.44 MB data. 

HARD DISK DRIVE  

 The hard disk (figure 1.23) is also called fixed disk. It consists of one 

or more metal plates. Metal plates are coated with magnetic material to store 

data. 

 Each platter is broken up into 

tracks and sectors. Tracks are 

concentric circles on the disk; each 

track is broken up into a series of 

sectors. A motor rotates disks. There 

is also an access arm and read / write 

heads to read and write data on disks. 

Hard disks are available in different 

size like 150 GB, 300 GB and more 

up to Tera Bytes.  

Figure 1.22 – Floppy Disk 

Figure 1.23 – Hard Disk Drive 
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CD (Compact Disk) 

CD (Compact Disk) is type of optical 

storage media that is used to hold 

prerecorded text, graphics and sound. 

CD-ROM is a read-only disk. Read 

only means the disk’s content is 

recorded at the time of manufacture 

and cannot be written on or erased by 

the user. A CD-ROM disk can hold up 

to 700 MB of data, equal to 300,000 pages of text. 

 CD drive/writer (figure 1.24) is used to play/write CDs. CD drive use 

a combination of lasers and sensors to read the data stored on the surface of 

the compact disks. Types of CDs are CD-ROM, CD-R (recordable) and CD-

RW (re-writeable) 

DVD 

 DVD “digital video disk” or “digital versatile disk” is a type of optical 

disk technology similar to the CD-ROM. It can hold up to 17 GB of data, 

about 25 times an ordinary CD-ROM. For this reason, a DVD-ROM can store 

a large amount of multimedia software and complete movies in different 

languages. It can also play music CDs and CD-ROMs. 

 DVDs are read-only devices. To avoid this limitation, companies also 

produce DVD-R/DVD-RW disks and DVD-burners.    

 

BLU RAY DISK 

Developed by Blu-ray disc association 

(that includes Apple, Hitachi, HP, LG, 

Panasonic, Pioneer, Philips, Samsung, Sharp, 

and Sony). Blu-ray Disc figure 1.25 (BD) is an 

also an optical disc storage medium designed to 

supersede the DVD format.   

Figure 1.25 – Blu Ray Disk 

BD-ROM (read only) for reading recorded content, BD-R (recordable) for PC 

data storage, BD-RW (rewritable) is used for PC data storage. Single layer BD 

Can hold data up to 25/27 GB, Double layer BD can hold data up to 50 GB. 

Figure 1.24 – CD with CD-Drive 
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USB FLASH DRIVE 

A flash drive is a small, ultra-portable storage 

device which, unlike an optical drive or a 

traditional hard drive, has no moving parts. 

 Flash drives connect to computers and 

other devices via a built-in USB port, Flash 

drives are often referred to as pen drives; 

thumb drives, or jump drives.  

It can store several MB’s to GB’s of data. 

 

 

1.8 - COMPUTER SOFTWARE 

 Software represents the logical or intangible parts of computer. 

Software is collection of different programs. A program is 

series of instructions that tells the computer what to do and how to do 

accomplish a particular task. Software is developed in a computer 

programming language. The Two major software categories are system 

software and application software. 

1.8.1 – SYSTEMSOFTWARE 

 A program or set of programs that is especially designed to control 

different operations of computer system is called system software. It controls 

the working of different components of the computer. The system also enables 

the other application programs to execute properly.  

 Operating systems, utility programs, and device drivers are the 

examples of system software. Operating system is the main and most popular 

type of system software. 

1.8.2 – APPLICATION SOFTWARE 

 A program or set of programs that are especially designed to solve the 

specific problems of users, are called application software. It is also known as 

software package. 

 There are Different kinds of application software such as commercial 

software, scientific software, financial packages, Games, multimedia software.  

Figure 1.26 – Flash Drive 
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CATEGORIES OF APPLICATION SOFTWARE 

The application software are divided into two main categories 

1. Custom-built software 

2. Packaged software 

1. Custom Built Software 

 Software that is developed for a particular customer or organization is 

called custom built software. For example, software developed to maintain the 

records of students of a particular college is category of custom built software. 

2. Packaged Software 

 The software that is developed for sale to the general public is called 

packaged software. Packaged software is used to solve some common 

problems of many people or users. Some examples of packaged software are 

1. Word processor such as MS-Word and Word Perfect 

2. Spreadsheet such as MS-Excel 

3. Presentation software such as MS- Power Point and Apple Keynote 

4. Database software such as MS-Access, SQL Server and Oracle 

5. Graphic software such as Adobe Photoshop, CorelDraw and AutoCAD  

6. Communication Software such as Internet Explorer and Google 

Chrome etc. 

7. Entertainment software such as Windows Media Player and VLC 

Media Player 

8. Web development software such as MS-Expression, Adobe 

Dreamweaver and Net-Objects Fusion etc. 

1.9 - PROGRAMMING LANGUAGES 

 A language used to write instructions for the computer is called 

programming language. Programming language use vocabulary and set of 

grammatical rules for instructing a computer to perform specific tasks 

1.9.1 - TYPES OF PROGRAMMING LANGUAGES 

There are three main kinds of programming language: 

 Machine language 

 Assembly language 

 High-level language  
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1.  MACHINE LANGUAGE  

 Machine language is a low-level programming language. It is easily 

understood by computers but difficult to read by people. This is why people 

use higher level programming languages. Programs written in high-level 

languages are also either compiled and/or interpreted into machine language 

so that computers can execute them. 

2.  ASSEMBLY LANGUAGE  

 An assembly language consists of a set of symbols and letters. A 

translator is required to translate the assembly language to machine language. 

This translator program is called the 'Assembler.' It is use terms 

like MOVE, ADD, SUB and END. 

Many of the earliest computer programs were written in assembly 

languages. A disadvantage of assembly language is that it is not portable, 

because each platform comes with a particular Assembly Language. 

3.  HIGH-LEVEL LANGUAGE  

 A high level language is a computer programming language that 

resembles natural language or mathematical notation and is designed 

to reflect the requirements of a problem. Languages such as C, C++, BASIC, 

and Java are all high-level languages. Advantages of high-level languages are 

that they are very readable and portable. These languages require a compiler 

or interpreter to translate into a form that a particular machine understands. 

1.9.2 - CLASSIFICATION OF HIGH LEVEL LANGUAGE 

 Different languages have different purposes, so it makes sense to talk 

about different class. Computer languages are classified into following 

FUNCTIONAL LANGUAGES 

 In Functional language, a program is divided into function definitions. 

Some of the famous Function languages are Scala, F#, Clojure and Lisp. 

PROCEDURAL LANGUAGES 

 In Procedural Languages, a program is written in a sequence of steps 

that should be followed to produce a result. COBOL, FORTRAN and C are 

some Procedural languages. 

OBJECT ORIENTED PROGRAMMING LANGUAGES 

 In OOP languages, a program is divided into Object that contains data 

as well as methods that operate on the data. Java, C# and C++ are examples 

OOP languages. 
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LOGIC PROGRAMMING LANGUAGES 

 Logic Languages are used to create programs that enable the computer 

to reason logically e.g. Logic language and Prolog language 

1.9.3 - LANGUAGE TRANSLATOR 

 There are 3 types of system software used for translating the code that 

a programmer writes into a form that the computer can execute (i.e. machine 

code). These are 

1. Assemblers  

2. Compilers 

3. Interpreters 

Source Code is the code that is input to a translator. Executable code is the 

code that is output from the translator. 

ASSEMBLER 

 An Assembler converts an assembly program into machine code. 

Assembly language consists of mnemonics for machine opcodes so 

assemblers perform a 1:1 translation from mnemonic to a direct instruction. 

For example: 

MOV TOTAL, 48    ; Transfer the value 48 in the 

; memory variable TOTAL 

 

 

 

COMPILER 

 A Compiler is a program that translates a high level language into 

machine code. The compiler translates a program (source program) written in 

high level language into machine code that can be run on a PC. 

When using a compiler, the entire source code needs to be compiled before 

the program can be executed. The resulting machine code is typically a 

compiled file, such as a file with an .exe extension.  
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INTERPRETER 

 An Interpreter is also a program that translates high-level source code 

into executable code. However, the difference between a compiler and an 

interpreter is that an interpreter translates one line at a time and then executes 

it: no object code is produced, and so the program has to be interpreted each 

time when executed. If the program performs a section code 1000 times, then 

the section is translated into machine code 1000 times since each line is 

interpreted and then executed. 

 

 

1.10- APPLICATIONS OF COMPUTER IN 

VARIOUS FIELDS 

Today computer is playing very important role in every field of life. 

Many activities in daily life can be performed very easily and quickly. Many 

fields where computer are widely used that includes  

BUSINESS 

Today, in global markets, it is impossible to run the business without 

the use of computer technology. Many business activities are performed very 

quickly and efficiently by using computers. The administrative paperwork is 

also reduced by using computers. Many business use websites to sell their 

products and contact their customers. 

EDUCATION 

Computers are used in teaching and research. The students can solve 

different kinds of problems quickly and efficiently by using computers. They 

can also collect different information on the Internet. 

BANKS 

Computers are widely used in banks. They are used in banks for record 

keeping and maintaining accounts of customers. By the ATM facility the 

customers can draw money through ATM card from any branch of that bank 

(or another bank) at any time of a day. 
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ENTERTAINMENT 

Computers are also playing very important role for the entertainment. 

Nowadays, computer can be used to watch TV programs on the Internet. 

People can also watch movies, listen music, and play games on the computer.  

HOME 

At home, computer is used to maintain personal records and to access 

much other information on the Internet. People can also use computer at home 

for making home budgets etc. 

MEDICAL 

Nearly every area of the medical field uses computers. For example, 

computers are used for maintaining patient history & other records. They are 

also used for patient monitoring and diagnosis of diseases etc. 

DEFENSE 

Computers are the main tools which help in developing missiles and 

other equipment as well as designing and maintenance in the deference 

system. Computer builds the links between the soldiers and commanders 

through the satellite. 

DESIGNING & PUBLISHING 

Computers aid in designing buildings, magazines, prints, newspapers, 

books and many others. The construction layouts are designed beautifully on 

system using different tools and software. 

GOVERNMENT DEPARTMENTS/OFFICES 

Computer is used in government offices for communication, data processing 

and project management. Like businesses and individuals, computers are 

almost essential part of federal and provincial government offices for their 

daily office operations. 

1.11 - APPLICATIONS OF COMPUTER IN 

ENGINEERING, EDUCATION AND BUSINESS 

1.11.1 - COMPUTER IN ENGINEERING 

Engineering designers require effective means of collecting, storing, 

retrieving, processing, communicating, distributing, displaying, plotting and 

printing large quantities of information.  
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USE OF CAD SOFTWARE 

One of the major uses of computer technology in engineering is with 

CAD software. Computer aided design software is the application of computer 

technology for logical designing. This industrial art is now widely used in 

many traditional industries, such as automobile manufacturing, shipbuilding, 

aerospace, prosthetics, architectural projects and even special effects in 

movies.  

USE OF CFD SOFTWARE 

CFD (Computational Fluid Dynamics) software are used to virtually 

test airplane and automobiles etc. Using a computer, engineers can 

immediately calculate such effects without having to physically test them. 

PROBLEM SOLVING  

Computers can perform complex calculations much quicker than a 

human can. They can also be used to simulate situations to make the right 

decisions. 

 

AUTOMATION 

It is almost impossible for humans to perform the same task over and 

over again with no variation. So when a company needs hundreds of products 

that look and behave identically, they tend to use computers and robots to 

construct them. 

1.11.2 – COMPUTER IN EDUCATION 

 Computer technology has a deep impact in the education sector to 

make learning easier and much more interesting. 

Here is detail of some areas of education where computer has great impacts.  

INSTRUCTIONS TO STUDENTS 

Lecture delivering using PowerPoint slides, Word documents or Web 

pages is very useful for better concept and clarity. Computer can help in 

improving pronunciation of students by using microphones, headphones, 

speakers, specially prepared software and special dedicated websites. Video 

conferencing, chat and email may also be used for communication among 

instructors and students for e-learning.  
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STUDENTS LEARNING  

Students can use computers to collect notes, pictures, and videos from 

web pages for detailed information to manage their projects or assignments. A 

saved soft copy of documents can be used in future.  

EXAMINATION AND EVALUATION 

 Examination and evaluation of students can be easily done using 

computer because it may facilitate to keep records of students for their 

academic scores as well as their grade, personal history about exams etc. 

 Question bank for students can be created for online testing and 

evaluation.   

LIBRARY 

 Electronic library is more helpful for students/faculty members where 

documents, magazines, journals, brochures and research articles are stored as 

soft copy. Furthermore, special library software can be used in existing library 

to keep record of books as well as issues and returns of the books.   

INSTITUTE ADMINISTRATION 

 The administration of the institute can use computer to store student’s 

personal, academic and financial records. Similarly accounts of the institution 

and records of employees also can be stored.  

1.11.3 – COMPUTER IN BUSINESS 

Computers are used for all aspects of running a business. Here is detail 

of these aspects as follows 

BUSINESS COMMUNICATION 

 In this era companies are using email, live chat systems, online 

meeting tools, video conferencing system and smart phones for 

communication among employees, suppliers and customers. 

INVENTORY MANAGEMENT SYSTEM 

 Inventory management system is used to track the quantity of each 

item a company maintains in its stock. 

PAYROLL SYSTEM  

      Computerized payroll system is used in different organizations to maintain 

pay account of employees, easily and quickly.  
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DATA MANAGEMENT 

 Today, most companies store digital versions of documents on servers 

(large computers) and storage devices, these documents can be easily 

available geographically via internet. 

MANAGEMENT INFORMATION SYSTEM 

 Management Information System (MIS) enables companies to track 

sales data, expenses, productivity level, profitability, losses, identify areas of 

improvements and strategic decisions. 

HUMAN RESOURCE MANAGEMENT  

 Computerized HRM helps for the better human resource planning, 

recruitment, wages and salary planning, personnel record keeping, training 

and development. 
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EXERCISE 

SHORT QUESTIONS 

1. What does E.D.P stands for? 

E.D.P stands for Electronic Data Processing  

2. Define the electronic data processing 

Electronic Data Processing is the use of computers in recording, 

classifying, manipulating, and summarizing of the data. 

3. Define computer 

The term computer is derived from the word compute. The word 

compute means to calculate. A computer is an electronic machine that accepts 

data from user as input, processes that data by performing calculations and 

operations on it, stores data for later retrieval and generates the desired output 

results (information) 

4. Draw a figure to illustrate the computer 

 

5. Define data 

A collection of raw facts and figures is called data. These facts can be 

the numbers, words, images, audio, measurements and observations. The word 

raw means that the facts have not yet been processed to get their actual 

meanings.  

6. What are the types of data? 

There are different types of data that includes numeric data, alphabetic 

data, alphanumeric data, graphic data and voice data. 

7. Define the numeric data 

Numeric data consists of positive or negative numbers that may also 

be integer without any fractional part or real number which includes integers 

with fractions. 

8. What is use of numeric data? 

Numeric type data is usually used for calculations 

9. What are examples of numeric data? 

Data may contain integer and real numbers. Examples are illustrated below. 
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10. Define the alphabetic data 

Alphabetic data contains the letters a, b, c… up to z. These letters may 

be small or capitals. 

11. What is use of alphabetic data? 

Alphabets are basic part of any human language. In real life everything 

is called with its name and every name made up with alphabets. 

12. Give some examples of alphabetic data 

Examples of alphabetic data are Islamabad, Farhan, Table, Office, 

College, TEVTA, computer etc 

13. Define the alphanumeric data 

Alphanumeric data is combination of alphabets, numbers, special 

characters (symbols) and space character. 

14. What is use of alphanumeric data? 

 Alphanumeric data is used to identify any person, thing, place, event 

and object.  

15. What are examples of alphanumeric data? 

 Alphanumeric data examples are Year 2015, Roll No 15EA04, $46, 

0330-1234567 

16. What are examples of graphic data? 

Graphics includes pictures, snaps, drawings, charts and moving 

pictures (movies) etc 

17. What are examples of audio data? 

Audio includes any type of voice that may be Naats, songs, human 

voice, etc 

18. Define the data processing. 

Data processing can include a number of stages such as sorting, 

searching, calculations, graphing etc where the input data is manipulated in 

order to produce meaningful information. 

19. Define the information 

Information is the data produced by computer after processing. The 

use of information is to have decisions. 

20. Define the information technology 

Information technology (IT) refers to anything related to computing 

technology, such as networking, hardware, software, the Internet, or the 

people that work with these technologies. 
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21. Define the analog computers 

 Analog computers recognize and process the data as a continuous 

measurement of a physical property (voltage, pressure, speed and 

temperature). Automobile speedometer, analog clock, voltage meter, ampere 

meter and electric current meter are examples of analog computer. 

22. Define the digital computers 

Digital computers process the digits to represent numerals, letters or 

other special symbols. Digital computers operate on inputs which are ON-

OFF type and its output is also in the form of ON-OFF signal. Normally, an 

ON is represented by a 1 and an OFF is represented by a 0. It is also known as 

binary 1 or 0. 

23. Define the hybrid computers 

A hybrid is a combination of digital and analog computers. It 

combines the best features of both types of computers, i-e. It has the speed of 

analog computer and the memory and accuracy of digital computer. 

24. What are the categories of digital computer regarding classification? 

 Digital computers can be classified into four categories 

 Super Computers 

 Mainframe Computers 

 Mini Computers 

 Micro Computers 

25. Define the super computer 

A supercomputer is a computer that is among the largest, fastest or 

most powerful of the computers available. 

26. What is use of super computer? 

Traditionally, supercomputers have been used for scientific and 

engineering applications that must handle very large databases or do a great 

amount of computation (or both).  

27. Define the mainframe computer 

A large, expensive, and often highly redundant computer designed to 

support a large organization, support a large number of users, and make use of 

large volumes of secondary storage. 

28. Define the mini computer 

A small computer that is intermediate between a microcomputer and a 

mainframe in size, speed, and capacity 
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29. Define the micro computers 

Microcomputer is complete machine for personal use in home or at office that 

includes a microprocessor, memory, and input/output (I/O) facilities. 

30. Write the various field names where computer can be applied 

Following are the various fields where computer can be applied 

 Business 

 Education 

 Banks 

 Entertainment 

 Home  

 Medical 

 Defense 

 Designing & Publishing 

 Government Departments/Offices 

 Research Laboratories  

31. Define the role of computer in engineering  

Using computers and specialty computer software, engineers can 

design, test and make changes to products in minimal time. Computers help 

them complete the task at hand much more quickly. 

32. Define the CAD software 

Computer aided design software is the application of computer 

technology for logical designing. 

33. What is use of CFD software? 

CFD (Computational Fluid Dynamics) software are used to virtually 

test the airplane and automobiles etc.  

34. Define the Automation 

Automation is the use of scientific and technological principles in the 

manufacture of machines that take over work normally done by humans. 

35. What are the areas of education where computer has great impacts? 

 Instruction to students 

 Students learning 

 Examination and evaluation 

 Library 

 Institute administration 
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36. What is use of computer in business? 

Computers are used in business for following aspects.  

 Business communication 

 Inventory Management System 

 Payroll System 

 Data Management 

 Management Information System 

 Human Resource Management 

37. Define the computer hardware 

Hardware represents the physical and tangible components of a 

computer i.e. the components that can be seen and touched. These components 

include keyboard, mouse, memory, processor, disks, disk drives, display 

screens, printers, speakers, mother boards, and chips etc. 

38. Define the computer software 

Software represents the logical or intangible parts of computer. 

Software is collection of different programs. A program is set of electronic 

instructions that tell the computer what to do and how to do a particular task. 

39. What units of hardware are showed by the computer block diagram? 

1. The Input Unit 

2. The Output Unit 

3. The System Unit 

40. Define the input unit 

The input unit deals with input devices, these devices are used to feed 

data into computer. Six widely used input devices are keyboard, mouse, 

scanner, microphone, digital camera, web cam. 

41. Define the output unit 

 The output unit is used to deliver information from the computer to 

the user. Four widely used output devices are monitor, printer, plotter and 

speakers. 

42. Define the system unit 

The system unit is a case consists of electronic components of the 

computer that provide data processing and storage facility. Some important 

devices houses in this units are CPU, RAM, mother board, hard disk, CD 

drive etc.  
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43. Define the keyboard 

The keyboard is one of the primary ways we communicate with the 

computer and enter data. It is used to enter three most widely used types of 

data i.e. numeric data, alphabetic data, and alphanumeric data. 

44. What is the most widely used layout for keyboard? 

QWERTY is the most widely used keyboard layout in English 

language for computer keyboard. 

45. Define the pointing input devices 

The input devices used to move the pointer (arrow) on screen are 

called pointing input devices. The major pointing devices are the mouse for 

the desktop computer and the touchpad for the laptop. Track ball and pointing 

stick are also pointing input devices used by small number of users. 

46. What are types of mouse? 

There are two types of mouse; a mechanical mouse has a rubber ball 

on its underside to detect movement of the mouse. An optical mouse uses 

devices that emit and sense light to detect the mouse's movement. 

47. What are some common operations of mouse? 

Some common mouse operations are point, click, right click, double 

click, drag and rotate wheel etc. 

48. Define the trackball 

Track Ball is pointing input device like a mouse. It has a ball on its 

upper side. This ball is moved by fingers or thumb and the pointer moves 

accordingly on screen. 

49. Define the touch pad 

 Touch pad is stationary pointing input device used in laptop 

computers. It has a flat surface. Finger is moved on this surface to move the 

pointer on screen. 

50. Define the joystick 

 Joystick is an input device used to play games on computer. It is used 

to control motion of an object quickly in game. This stick can be moved 

forward, backward or sideways. The buttons called the triggers.  

51. Define the light pen 

A light pen is a light-sensitive computer input device that is used to 

select text, draw pictures and interact with user interface elements on a 

computer screen or monitor. 
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52. Define the scanner 

A scanner is input device that captures images from photographic 

prints, posters, magazine pages etc for computer editing and display. The 

scanner operates in the same manner as a photocopier. 

53. Define the microphone 

Microphone is a device that converts sound waves into analog 

electrical waves. Computer microphones are used for a variety of purposes, 

from recording audio, voice chatting, teleconferencing to video conferencing. 

54. Define the touch screen 

A touch screen is a computer display screen that is also an input 

device. The screens are sensitive to pressure; a user interacts with the 

computer by touching pictures or words on the screen. 

55. Define the digital camera 

Digital Cameras are used to capture images. Those images are then 

transferred to a computer when the Camera is connected to the computer. 

56. Define the output devices 

An output device is any device used to send data from a computer to 

another device or user. Most computer data output that is meant for humans is 

in the form of audio or video. 

57. Define the monitor 

Monitor or display screen is most important output device. It is used to 

display the video and graphics information generated by the computer through 

the video card. Monitors are very similar to televisions but with higher 

resolution. 

58. What types of monitors are widely used today? 

 According to technology following monitors are widely used in 

computer 

 CRT 

 LCD 

 LED 

 Plasma 

59. What is CRT stands for? 

CRT stands for Cathode Rays Tube  
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60. What is LCD stands for? 

 LCD stands for Liquid Crystal Display 

61. What is LED stands for? 

 LED stands for Light Emitting Diode 

62. Define the CRT monitor 

 This monitor used CRT (Cathode Ray Tube) a vacuum tube as a 

display screen in a computer. The viewing end of the tube is coated with 

phosphors, which emit light when struck by electrons. 

63. Define the printer 

A printer is an output device that prints characters, symbols and 

graphics, on paper. 

64. Define the term hard copy 

A hard copy is a printed copy of information from a computer. 

Sometimes referred to as a printout, a hard copy is so-called because it exists 

as a physical object. 

65. What are two major types of printers according to their technology? 

The two major types of printer according to their technology are 

 Impact printers 

 Non-Impact printers 

66. What are main parts used by Impact printers for printing? 

Impact printers use head with pins, hammer, and carbon ribbon for 

printing 

67. What are main parts used by non-Impact printers for printing? 

Non-Impact printers use spray ink, heat, pressure and LASER for 

printing 

68. Write some names of impact printers 

The Dot Matrix printer, the Line printer, and Daisy Wheel printer  

69. Write some names of non-impact printers 

The LASER printer, Inkjet printer, and Thermal Wax printer 

70. How many pins are there in Dot Matrix heads? 

There are 9 to 24 pins in Dot Matrix heads.  

71. Which unit is used to measure the speed of Dot Matrix printer? 

The working speed of Dot Matrix printer is measured in CPS  



COMP-162 COMPUTER APPLICATIONS 

 

 
44 | P a g e  

 

72. Why the Line printer is called Line printer? 

The Line printer prints an entire line at one time. 

73. What is LASER stands for? 

LASER is short for Light Amplification by Stimulated Emission of 

Radiation. 

74. What is the speed of LASER printer? 

Home-use laser printers can print eight pages per minute, but faster 

and print approximately 21,000 lines per minute or 450 pages per minute. 

75. Define the plotter 

A plotter is hard copy output device used to print large linear 

drawings. 

76. Define the speakers 

A speaker is a softcopy output device that plays sound generated by 

the computer. 

77. Define the System Unit 

The system unit is a case consists of electronic components of the 

computer that provide data processing and storage facility. 

78. What is CPU stands for? 

CPU stands for Central Processing Unit 

79. What is the job of CPU in computer system? 

It performs all types of data processing operations. It stores data, 

intermediate results and instructions (program).It controls the operation of all 

the parts of computer. All arithmetic and logical operations are also performed 

within CPU using its ALU. 

80. What are components of CPU? 

CPU itself has following three components 

 Arithmetic Logic Unit) 

 Control Unit 

 Memory or Storage Unit 

81. What is ALU stands for? 

ALU stands for Arithmetic Logic Unit  
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82. What is the job of ALU? 

The purpose of the ALU is to perform mathematical operations such as 

addition, subtraction, multiplication and division. Additionally, the ALU 

processes basic logical operations like AND/OR calculations. Also known as 

the arithmetic logic unit, it serves as the computational hub of the Central 

Processing Unit (CPU) for a computer system. 

83. What is MU stands for? 

MU stands for memory unit 

84. What is the function of Memory Unit? 

Functions of the memory unit are − 

 It stores all the data and the instructions required for processing. 

 It stores intermediate results of processing. 

 It stores the final results of processing before these results are released 

to an output device. 

 All inputs and outputs are transmitted through the main memory. 

85. What is the function of Control Unit (CU)? 

This unit controls the operations of all parts of computer. It is 

responsible for controlling the transfer of data and instructions among other 

units of a computer. It manages and coordinates all the units of the computer. 

It communicates with Input/output devices for transfer of data or 

results from storage. 

86. What is difference between primary and secondary memory? 

The memory which is directly accessible by processing unit (CPU) is 

called primary memory and the memory which is not directly accessible by 

processing unit (CPU) is called secondary memory. 

87. What is RAM stands for? 

RAM stands for Random Access Memory 

88. Why the RAM is referred to as random access memory? 

 It is referred to as random access memory (RAM) because it is 

randomly select and use any location of the memory to store and retrieve data.   
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89. What is difference between volatile and nonvolatile memory? 

Volatile memory is also called as temporary memory as it will 

hold memory temporarily. Non Volatile Memory: A device which can hold 

data in it even if it is not connected to any power source is called Non Volatile 

Memory. 

90. Define the DRAM 

Dynamic Random Access Memory is the more common type. It is 

slower because it needs to be refreshed thousands of times per second. DRAM 

supports access times of about 60 nanoseconds. It is an inexpensive 

memory.91. Define the SRAM 

 Static Random Access Memory is faster than DRAM in term of speed 

because it does not need to be refreshed.  SRAM can give access times as low 

as 10 nanoseconds. Despite SRAM being faster, it's not as commonly used as 

DRAM because it's so much more expensive.  

92. What is ROM stands for? 

 ROM stands for Read Only Memory 

93. What is BIOS stands for? 

BIOS stands for Basic Input Output System. 

94. What is PROM stands for? 

PROM stands for Programmable Read Only Memory 

95. What is EPROM stands for? 

EPROM stands for Erasable Programmable Read Only Memory 

96. What is EEPROM stands for? 

EEPROM stands for Electrically Erasable Programmable Read Only 

Memory 

97. Define the BIT 

A bit (short for BInary digiT) is the smallest unit of data/information 

that can be stored or manipulated in a computer. A bit can have a binary value 

of either 0 or 1. 

98. Define the Byte 

A byte is a set of 8 bits that represent a single character in the 

computer's memory. Bytes are used to measure file sizes, hard disk space, and 

computer memory. Larger amounts of data are measured in units such as 

megabytes, gigabytes, and terabytes.  
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99. Define the secondary storage devices 

Secondary storage devices are used to store data and instructions 

permanently. These devices also called auxiliary storage or external storage. 

100. Define the magnetic tape 

Magnetic tape is the oldest storage device. It is made of plastic coated 

with magnetic material. Tape drive is used to read and write data on tape. 

Magnetic disk is sequential access device. 

101. Define the Floppy Disk 

The Floppy Disk officially called “diskette” is removable storage 

medium that consists of a thin and flexible magnetic disk inside a plastic 

carrier. The 3.5 inches floppy disk can store 1.44 MB data. 

102. Define the hard disk drive 

A hard drive is a secondary storage device that consists of one or 

more platters to which data is written using a magnetic head, all inside of an 

air-sealed casing. The hard disk drive is the main, and usually largest, data 

storage hardware device in a computer. The operating system, software titles, 

and most other files are stored in the hard disk drive. 

103. What is CD stands for? 

CD stands for Compact Disk 

104. What are types of CDs? 

Types of CDs are CD-ROM, CD-R (recordable) and CD-RW (re-writeable) 

105. What is DVD stands for? 

DVD stands for Digital Versatile Disk or Digital Video Disk 

106. What is BD stands for? 

BD stands for Blu-Ray Disk. 

107. Define the USB Flash Drive 

Flash drive is the solid state storage module that plugs into the 

computer's USB port. Using flash memory chips that hold up to one terabyte 

of data. USB drives are extremely popular for backup as well as data transfer 

from one machine to another.   
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108. Define the software 

Software represents the logical or intangible parts of computer. 

Software is collection of different programs. A program is series of 

instructions that tells the computer what to do and how to do accomplish 

a particular task. Software is developed in a computer programming language. 

109. What are major types of software? 

There are two major software categories the system software and 

application software. 

110. Define the system software 

A program or set of programs that is especially designed to control 

different operations of computer system is called system software. It controls 

the working of different components of the computer. The system also enables 

the other application programs to execute properly.  

111. Write some popular operating systems names 

Windows and DOS by Microsoft, Macintosh by Apple, UNIX and 

Linux, Solaris by Sun Microsystems are some popular operating systems. 

112. Define the application software 

A program or set of programs that are especially designed to solve the 

specific problems of users, are called application software. 

113. What are categories of application software? 

The application software are divided into two main categories 

3. Custom-built software 

4. Packaged software 

114. Define the custom built software 

Software that is developed for a particular customer or organization is 

called custom built software. For example, software developed to maintain the 

records of students of a particular college is category of custom built software. 

115. Define the packaged software 

The software that is developed for sale to the general public is called 

packaged software. Packaged software is used to solve some common 

problems of many people or users.  

116. Define the programming languages 

A language used to write instructions for the computer is called 

programming language. Programming language use vocabulary and set of 

grammatical rules for instructing a computer to perform specific tasks 
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117. What are main types of programming languages? 

There are three main kinds of programming language: 

 Machine language 

 Assembly language 

 High-level language 

118. Define the machine language 

Machine language is a low-level programming language. It is easily 

understood by computers but difficult to read by people. It is written in a 

binary code of 0s and 1s that represent electric impulses or off and on 

electrical states respectively.  

119. Define the assembly language 

An assembly language consists of a set of symbols and letters. A 

translator is required to translate the assembly language to machine language. 

This translator program is called the 'Assembler.' It is use terms 

like MOVE, ADD, SUB and END. 

120. Define the high level language 

A HLL is computer programming language that resembles natural 

language or mathematical notation and is designed to reflect the requirements 

of a problem; examples include Ada, BASIC, C, C++, COBOL, FORTRAN, 

and Pascal etc. 

121. What are advantages of high level languages? 

Advantages of high-level languages are that they are very readable and 

portable. 

122. What are disadvantages of high level languages? 

A disadvantage of high-level languages is that they are less powerful 

than Assembly Languages. Because a single statement in a high-level 

language is translated into many machine languages. A program prepared in 

high level language in slow as compare to a program prepared in low level 

language. 

123. What are the names of translators used in high level languages? 

Compiler and interpreter are used as translator in high level languages  
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124. Write the names of classes in high level languages 

Computer languages are classified into following 

1. Functional languages 

2. Procedural languages 

3. Object oriented programming languages 

4. Logic programming languages 

125. Define the functional language 

In Functional language, a program is divided into function definitions. 

Some of the famous Function languages are Scala, F#, Clojure and Lisp.126. 

Define the procedural languages 

In Procedural Languages, a program is written in a sequence of steps 

that should be followed to produce a result. COBOL, FORTRAN and C are 

some Procedural languages. 

127. Define object oriented programming languages 

In OOP languages, a program is divided into Object that contains data 

as well as methods that operate on the data. Java, C# and C++ are examples 

OOP languages. 

128. Define the logic programming languages 

Logic Languages are used to create programs which are based on the 

use of logical formulas. Logic language and Prolog language are examples of 

logic languages.  

129. Define the language translator 

A Compiler is a computer program that translates code written in a 

high level language to a lower level language, object/machine code. The most 

common reason for translating source code is to create an executable program  

130. What is difference between source code and executable code? 

Programmers write programs in a form called source code. The source 

code consists of instructions in a particular language, like C or FORTRAN. 

Computers, however, can only execute instructions written in a low-level 

language called machine language. Executable code is the code that is 

translated by a translator and directly readable by the machine.  
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LONG QUESTIONS 

Q # 1: Define the computer, draw its block diagram. 

Q # 2: Explain the data and its types 

Q # 3: What is data processing? Differentiate between data and information. 

Q # 4: What is difference between information and information technology? 

Q # 5: What are output devices? Name some of the commonly used output  

             devices. 

Q # 6: Explain the types of computer. 

Q # 7: Classify the high level languages with their names. 

Q # 8: What is software? Illustrate its types. 

Q # 9:  Illustrate the application of computer in various fields of life? 

Q #10: What are the applications of computer in engineering, education and  

             business? 

Q #11: What are the components of computer? Explain the input, output and  

             system unit of computer. 

Q #12: Explain the difference between RAM and ROM 

Q #13: Differentiate between input and output devices also describe any two  

             input and two output devices. 

Q # 14: Explain all the pointing input devices with their use. 

Q # 15: Write a note on following input devices 

             1. Keyboard       2. Scanner      3. Microphone      4. Touch Screen 

Q # 16: What is monitor? Explain different types of monitors. 

Q # 17: Differentiate between impact and non-impact printers. 

Q # 18: Write a note on following: 

             1. LASER Printer 2. Dot Matrix Printer  3. Line Printer 

Q # 19: Write a note on following: 

             1. Inkjet Printer  2. Plotter   3. Speaker 

Q # 20: What is CPU? Explain its parts. 

Q # 21: Explain the RAM and its types. 

Q # 22: What is function of ROM? Explain all types of ROM. 

Q # 23: Explain the difference between Bit and Byte. 

Q # 24: Write a short note on following 

             1. Cache Memory        2. Primary Memory       3. Secondary Memory  

Q # 25: Write a short note on following 

             1. Volatile Memory          2. Non-volatile Memory         3. ROM 
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1. The term computer is derived from the word _________ 

    a. commute               b. compute               c. calculates               d. copter 

2. Computer accepts input in form of ___________ 

    a. data       b. information                  c. input                 d. all of these 

3. Collection of raw _______________ is called data. 

    a. metals                   b. trees                  c. facts & figures                d. grain 

4. Numeric data contains ___________ numbers 

    a. positive                b. negative               c. integer              d. all of these 

5. Alphabetic data contains __________________ 

    a. alphanumeric          b. alphabets            c. numbers         d. none of these 

6. Alphanumeric data contains ____________________ 

    a. numbers               b. alphabets              c. symbols               d. all of these 

7. Graphic data contains _______________ 

a. pictures                 b. drawings              c. charts                 d. all of these 

8. The purpose of data processing is to produce ________________ 

a. data               b. information          c. input                 d. none of these 

9. Information is the ________________ 

a. processed data      b. meaningful data   c. useful data      d. all of these 

10. The use of information is to have ________________ 

a. output                 b. decisions               c. input             d. processing 

11. The speed of computer is measured in ______________ 

a. kilos                       b. meters                     c. bytes                       d. hertz 

12. The storage capacity of computer is measured in _____________ 

a. bytes                      b. cycles                        c. data                        d. hertz 

13. Computers can perform several tasks at a time; this feature is known as  

a. multi-national         b. multi-tasking           c. multi-color                 

d. multi-media 

14. Analog computers are used to process _____________ data. 

a. electronic               b. digital                   c. analog                  d. graphic  

Multiple Choice Questions 
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15. Analog computes can process _______________ 

a. temperature              b. pressure               c. speed              d. all of these 

16. Digital computers process the digits, which are called ____________digits 

a. binary                  b. ternary                   c. unary                d. none of these 

17. The binary digit 1 represents ON and 0 represents ______________ 

a. zero                    b. OFF                    c. digit                      d. none of these 

18. The most commonly used type of computers is ______________ 

a. hybrid                 b. analog                 c. digital                 d. none of these 

19. Most powerful digital computer is ______________ 

a. super                 b. analog                   c. personal                   d. digital 

20. The computer used in large corporations, banks, government agencies, 

research laboratories to manage huge amount of data, is _________ computer. 

a. mainframe                 b. super                  c. laptop                  d. notebook 

21. The complete computer for personal use in home or at office is known as  

a. micro                   b. super                     c. mini                     d. mainframe 

22. Examples of personal computers are ________________ 

a. desktop                  b. laptop                 c. palmtop                d. all of these 

23. A student can use computer for _____________ 

a. research work        b. collecting information   c. solving problems   

     d. all of above 

24. Computers are playing very important role for entertainment like ______. 

a. playing games           b. watching movies           c. listening music            

d. all of these 

25. Engineers and technologists used the computer for ______ of information 

a. collecting                  b. processing                c. storing & receiving              

d. all of these 

26. The major uses of computer technology in engineering is with _________ 

software. 

a. communication         b. CAD                 c. system              d. anti-virus 

27. Computer aided design software is the application of computer technology  
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for ___________. 

a. business  b. entertainment  c. logical designing 

d. home 

28. Computer is used in engineering for ____________. 

a. CAD          b. problem solving             c. automation            d. all of these 

29. Major component of computer are ______________. 

a. hardware              b. software                 c. hardware & software                  

d. none of these 

30. All physical and tangible components of computer are called _________. 

a. hardware               b. software                 c. data               d. none of these 

31. All logical and intangible parts of computer are called ______________ 

a. hardware              b. software             c. hard disk           d. none of these 

32. Software is collection of different computer _______________ 

a. devices            b. programs              c. information            d. none of these 

33. A computer program is set of electronic _____________ that tell the  

computer what to do and how to do a particular task. 

a. devices             b. machines           c. instructions            d. none of these 

34. Major software categories are the ______________. 

a. application & utility software     b. system & business software 

c. system & application software      d. utility software 

35. ______ let you to input data and user command into the computer system. 

a. output devices           b. memory devices           c. storage devices             

d. input devices 

36. __________displays the result of input data or signals after processing it. 

a. input devices             b. output devices             c. processing devices        

d. memory devices 

37. The primary and most important type of input device is ______________. 

a. printer                  b. monitor                  c. keyboard                  d. scanner 

38. Mouse is type of _________________ devices. 

a. pointing input          b. processing              c. output                d. storage  
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39. Click, right click, double click, drag and rotate wheel are some common  

operations done by the _______________. 

a. mouse             b. keyboard                 c. joy stick                  d. light pen 

40. __________ is an input device used to enter voice data into the computer. 

a. keyboard              b. light pen            c. microphone              d. joystick 

41. Touch pad is usually used in ________________ computers. 

a. desktop              b. palmtop                c. laptop               d. none of these 

42. A _______ is a device that scans images from photographic prints,posters  

magazine, pages, and similar sources for computer editing and display. 

a. mouse              b. printer                    c. camera                      d. scanner 

43. A user can interact with computer, smart phones and tablets without a  

mouse or keyboard, using ______________. 

a. touch pad           b. touch screen          c. touch stone         d. none of these 

44. The device used to display the video and graphics information generated  

by the computer through the video card is _______________. 

a. printer                b. speaker                c. monitor               d. none of these 

45. The device used to display soft copy of data and information is ________. 

a. monitor                b. keyboard                  c. printers                   d. plotter 

46. Types of monitors are _____________. 

a. CRT                   b. LCD                    c. LED                       d. all of these 

47. LCD stands for _____________. 

a. liquid crystal display           b. labour control department           

c. least common denominator d. none of these 

48. LED stands for _________________. 

a. low energy demand             b. light emitting diode            

c. light emitting display          d. none of these 

49. CRT stands for _________________. 

a. child right trust                      b. cathode ray tube                       

c. computer remote terminal     d. all of these 

50. Number of pixels on computer screen is known as _________________. 

a. bit            b. picture size           c. screen resolution          d. mega pixels  
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51. A printer is an output device that prints ________________ on paper. 

a. characters             b. symbols            c. graphics              d. all of these 

52. The printed output on papers provided by the computer is called________. 

a. hardcopy               b. hardware               c. softcopy               d. head copy 

53. The printers used pins and hammer that strikes against the paper through  

ribbon are known as_________________. 

a. non-impact printers           b. impact printers           c. ink printers               

d. none of these 

54. The printers used heat, pressure; laser and ink for printing are known as  

_______________. 

a. impact printers             b. non-impact printers             c. wax printer              

d. none of these 

55. _______________ printer is example of impact printers. 

a. Dot Matrix            b. Line              c. daisy wheel             d. all of these 

56. _______________ printer is example of non-impact printers. 

a. LASER              b. Inkjet              c. Thermal Wax              d. all of these 

57. Printing speed of large laser printer is ______________ pages per minute. 

a. 300                     b. 200                       c. 100                       d. 50 

58. In laser printer the refillable ink container is called ________________. 

a. cartridge              b. toner             c. carbon ribbon            d. none of these 

59. In Inkjet printer the refillable ink container is called ________________. 

a. cartridge             b. toner             c. carbon ribbon            d. none of these 

60. DPI stands for ________________. 

a. data processing installation              b. dots per inch                

c. digital printing and imaging            d. none of these 

61. The speed of Dot Matrix printer is measured in _____________ 

a. PPM                   b. CPM                    c. CPS                     d. none of these 

62. In printers CPS stands for _______________. 

a. cycles per second      b. counts per second       

c. cost per second      d. characters per second  
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63. In printers PPM stands for ______________. 

a. pages per minute        b. pay per minute         

c. pulses per minute     d. points per minute 

64. The printers, prints characters and graphics on paper without striking on  

paper are known as__________________. 

a. impact printers           b. digital printers         

 c. non-impact printers        d. analog printers 

65. The printer works like a photo copier machine is known as ______ printer. 

a. Laser                   b. Inkjet                  c. Dot Matrix                    d. Line 

66. A big size printer used to print maps, documents, posters, large size  

drawings and geometric lines, is known as ___________________. 

a. Inkjet printer          b. drawing printer         c. plotter         d. laser printer 

 

67. CPU stands for ________________. 

a. cost per unit          b. cash processing unit         c. central processing unit 

d. none of these 

68. The brain of computer is called _______________. 

a. hard disk                 b. CPU                 c. RAM                  d. mother board 

69. Components of CPU are ________________. 

a. ALU                     b. CU                     c. MU                    d. all of these 

70. ALU stands for ________________. 

a. application layer user                b. automatic loading unit                    

c. arithmetic logic unit                  d. all logic unit 

71. MU stands for _________________. 

a. mobile unit b. multi-user         c. memory unit          d. none of these 

72. CU stands for _________________. 

a. control unit        b. computer unit         c. central unit        d. none of these 

73. The ________________ section of ALU is used to perform arithmetic  

operations like addition, subtraction, multiplication and division. 

a. calculative             b. logic           c. arithmetic             d. none of these  
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74. The ________________ section of ALU is used to perform logic  

operations such as comparing, selecting, matching and merging of data. 

a. calculative             b. logic         c. arithmetic             d. none of these 

75. The actual execution of instructions happens in __________________. 

a. CU                      b. ALU                     c. MU                    d. none of these 

76. The memory unit of CPU contains ____________ to hold (temporarily)  

the data and instructions to be executed. 

a. registers                b. units                 c. houses                 d. blocks 

77. The unit of CPU which controls the operations of all parts of computer is  

known as_______________. 

a. memory unit                   b. control unit                   c. arithmetic unit                   

d. logic unit 

78. The memory which is directly accessible by the CPU is called ________. 

a. secondary memory    b. temporary memory      

c. permanent memory     d. primary memory 

79. The memory which is not directly accessible by the CPU is called _____. 

a. secondary memory       b. temporary memory        

c. primary memory       d. none of these 

80. As compare to secondary memory, the primary memory of computer is  

____________. 

a. slow               b. cheap                    c. fast                     d. large 

81. Example of primary memory is ______________. 

a. RAM               b. Cache Memory              c. ROM               d. all of these 

82. Example of secondary memory is ______________. 

a. Hard disk              b. Floppy disk                c. CD                 d. all of these 

83. RAM stands for ____________. 

a. read access memory                b. remote access memory                

c. random access memory                                  d. real access memory 

84. RAM is ____________ memory of computer. 

a. main               b. permanent              c. secondary             d. none of these  
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85. The feature of RAM is _____________. 

a. temporary             b. volatile              c. read/write              d. all of these 

86. The ____________ RAM is faster. 

a. dynamic                 b. static               c. automatic              d. none of these 

87. ROM stand for ______________. 

a. record only memory         b. run of memory          

c. read only memory         d. none of these 

88. The memory which requires a power source to hold information is called  

_______________memory. 

a. nonvolatile              b. tactile               c. volatile              d. none of these 

89. The memory that does not require a connection to a power source to  

retain information is called _______________ memory. 

a. nonvolatile               b. tactile              c. volatile              d. none of these 

90. Which is example of volatile? 

a. ROM                   b. BIOS                    c. PROM                     d. RAM 

91. The basic input/output system (BIOS) program is stored in the ____ chip. 

a. RAM                 b. cache                  c. ROM                  d. none of these 

92. BIOS is abbreviation of ______________. 

a. Basic Input Output System                            b. Best Input Output System 

c. Basic Input Output Symbol                           d. Base Input Output System 

93. EEPROM stands for ________________. 

a. Electrically Erasable Programmable Read Only Memory 

b. Electronic Erasable Programmable Read Only Memory 

c. Easily Erasable Programmable Read Only Memory 

d. Early Erasable Programmable Read Only Memory 

94. A ___________ is smallest unit of data/information that can be stored in  

a computer. 

a. boot                    b. bite                     c. bit                       d. none of these 

95. A bit can have a binary value of either ______________. 

a. 0 or 2                  b. 0 or 1                   c. 0 or -1                d. none of these  
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96. The base of binary number system is _______________. 

a. 0                          b. 1                           c. 2                           d. 3 

97. A byte is set of _______________ bits. 

a. 1                             b. 2                              c. 4                          d. 8 

98. Bytes are used to measure _______________. 

a. file size                 b. hard disk space                 c. computer memory                 

d. all of these 

99. 1 kilobytes is equal to _______________. 

a. 1000 bytes                    b. 1024 bytes                      c. 1024 bits                      

d. none of these 

100. Which statement is valid? 

a. 1 KB = 8 bytes        b. 1 MB = 8KB          c. 1 KB = 1024 bytes         

d. 1 MB = 1024 bytes 

101. Magnetic tape is ______________ device. 

a. direct access                 b. random access                c. sequential access          

d. fast access 

102. Floppy disk is ______________ storage medium. 

a. removable                b. fixed                c. optical                d. none of these 

103. The 3.5 inches floppy disk can store _______________ data. 

a. 1.24 MB                b. 1.34 MB                 c. 1.44 MB               d. 1.54 MB 

104. Which of the following device can store large amounts of data? 

a. Floppy Disk              b. Hard Disk              c. CDROM            d. Zip Disk 

105. In hard disks a _____________ is used to read/write data. 

a. lens                 b. head                  c. disk reader               d. none of these 

106. When a hard disk undergoes formatting, it is divided into ____________. 

a. tracks                b. sectors                c. both a & b              d. none of these 

107. CD stands for _____________. 

a. control data             b. change directory           c. compact disk            

d. car driver 

108. A CD can hold up to ______________ MB of data. 

a. 900                      b. 700               c. 1024                         d. 1000  
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109. A CD _____________ disc is a compact disc that can be written, erased,  

and written again. 

a. RW                   b. ROM                      c. R                       d. none of these 

110. DVD stands for ______________. 

a. direct video disk         b. digital versatile disk       

c. digital video disk        d. both b & c 

111. A double layer DVD can hold up to ______________ GB of data. 

a. 10                          b. 13                            c. 1024                             d. 17 

112. CD, DVD and BD are the ______________ type of storage media. 

a. magnetic             b. optical              c. electrical              d. none of these 

113. BD stands for ______________. 

a. bio disk            b. blue ray disk             c. binary digit            d. bank draft 

114. USB Flash drive is often referred to as ________________. 

a. jump drive           b. pen drive            c. thumb drive            d. all of these 

115. USB stands for ______________. 

a. united states bank       b. universal serial Bus         

 c. uniform serial bus       d. none of these 

116. The software especially designed to control different operations of  

computer system are called _______________ software. 

a. computer              b. application            c. system             d. none of these 

117. Example of system software is ______________. 

a. operating systems         b. utility programs                c. device drivers            

d. all of these 

118. Example of operating systems is _________________. 

 a. Windows 10       b. MS Word    c. web browser        d. anti-virus 

119. The software especially designed to solve the specific problems of users  

are called______________ software. 

a. operating systems     b. application     c. system             d. none of these 

120. ______________ is the example(s) of application software. 

a. commercial software       b. games         c. multimedia         d. all of these  
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121. The software that is developed for sale to the general public is called  

_______________. 

a. custom built software          b. packaged software       

 c. public software     d. none of these 

122. Software that is specially developed for some specific organization or 

        other user are called_______________ software. 

a. custom built               b. packaged          c. user               d. organization 

123. A language used to write instructions for the computer is called  

_______________. 

a. human language                    b. instruction language                       

c. programming language         d. none of these 

124. Signals can be analog or digital and a computer that processes the both  

        type of signals is known as _______________ computer. 

a. analog                b. digital                 c. hybrid                   d. mainframe 

125. Type(s) of programming languages is/are ________________. 

a. machine language       b. assembly language      

c. high level language        d. all of these 

126. The programming language which is easily understood by the computer  

but difficult to read by people is known as ______________. 

a. machine language       b. assembly language        c. high level language        

      d. none of above 

127. The machine language is also known as _______________. 

a. high level language      b. binary language           c. assembly language        

d. none of these 

128. The machine code contains ______________. 

a. symbols        b. decimal digits           c. binary digits            d. alphabets 

129. Example of machine code is _______________. 

a. cout<< “hello”            b. 01234567                    c. 10011011                     

d. mov   x, counter 

130. Assembly language consists of _______________. 

a. symbols           b. symbols & letters        c. letters                    d. binary code  
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131. The translation software for assembly language is called ____________. 

a. assembler                b. translator                         c. compiler                       

d. interpreter 

132. The computer language that resembles natural human language is known  

as ____________. 

a. low level language       b. high level language        c. mid-level language       

d. none of these 

133. Which of the following is a high level programming language? 

a. MS Word         b. C++             c. Chrome              d. MS Excel 

134. A high level programming language in which a program is divided into  

function definition is ____________________ language. 

a. functional               b. procedural               c. object oriented                

 d. logic programming 

135. A high level programming language in which a program is written in a  

sequence of steps is_______________ language. 

a. functional               b. procedural          c. object oriented                 

d. logic programming 

136. A high level programming language in which a program is divided into  

objects is__________________ language. 

a. functional               b. procedural               c. object oriented                 

d. logic programming 

137. A high level programming language in which is used to create programs  

that enable the computer to reason logically is _____________ language. 

a. functional               b. procedural               c. object oriented                 

d. logic programming 

138. The translator software for high level language is/are _______________. 

a. assembler         b. compiler           c. interpreter              d. both b & c 

139. What is compiler? 

a. A compiler does a conversion line by line as the program is run 

b. A compiler converts the whole of a higher level program code into  

machine code in one step 

c. A compiler is a general purpose language providing efficient execution 

d. None of the above  
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140. What is an interpreter? 

a. An interpreter does the conversion line by line as the program is run 

b. An interpreter is the representation of the system being designed 

c. An interpreter is general purpose language providing efficient execution 

d. None of the above 

Answers Key 
1 b 29 c 57 a 85 d 113 b 

2 a 30 a 58 b 86 b 114 d 

3 c 31 b 59 a 87 c 115 b 

4 d 32 b 60 b 88 c 116 c 

5 b 33 c 61 b 89 a 117 d 

6 d 34 c 62 d 90 d 118 a 

7 d 35 d 63 a 91 c 119 b 

8 b 36 b 64 c 92 a 120 d 

9 d 37 c 65 a 93 a 121 b 

10 b 38 a 66 c 94 c 122 a 

11 d 39 a 67 c 95 b 123 c 

12 a 40 c 68 b 96 c 124 c 

13 b 41 c 69 d 97 d 125 d 

14 c 42 d 70 c 98 d 126 a 

15 d 43 b 71 c 99 b 127 b 

16 a 44 c 72 a 100 c 128 c 

17 b 45 a 73 c 101 c 129 c 

18 c 46 d 74 b 102 a 130 b 

19 a 47 a 75 b 103 c 131 a 

20 a 48 b 76 a 104 b 132 b 

21 a 49 b 77 b 105 b 133 b 

22 d 50 c 78 d 106 c 134 a 

23 d 51 d 79 a 107 c 135 b 

24 d 52 a 80 c 108 b 136 c 

25 d 53 b 81 d 109 a 137 d 

26 b 54 b 82 d 110 d 138 D 

27 c 55 d 83 c 111 d 139 B 

28 d 56 d 84 a 112 b 140 A 
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C H A P T E R  2  

M i c r o s o f t  W i n d o w s  1 0  

 

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of Microsoft Windows 10. 

 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 

 

 

 Explain Introduction to Windows 

 Install windows and drivers? 

 Describe Loading & Shut down process 

 Explain Desktop items (Creation of Icons, Shortcut, Folder & modify 

Taskbar) 

 Explain Desktop properties 

 Describe Use' of Control Panel (add/remove program, time & date, mouse 

and create user account) 

 Explain the method of searching a document 
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2.1 - INTRODUCTION TO WINDOWS 

Windows 10 is a Microsoft operating system for personal computers, 

tablets, embedded devices and internet of things devices. Microsoft released 

Windows 10 in July 2015 as a follow-up to Windows 8. The company has 

said it will update Windows 10 continuously, rather than release a new, full-

fledged operating system as a successor. 

Users can access a Windows 10 upgrade through the Windows Update 

Assistant to manually begin an upgrade or wait for Windows Update to offer 

an upgrade when it is set to run. 

Windows 10 features built-in capabilities that allow corporate IT 

departments to use mobile device management (MDM) software to secure and 

control devices running the operating system. In addition, organizations can 

use traditional desktop management software such as Microsoft System 

Center Configuration Manager. 

Windows 10 Mobile is a version of the operating system Microsoft 

designed specifically for smart phones. 

Windows 10 features 

The familiar Start Menu, which Microsoft replaced with Live Tiles in 

Windows 8, returned in Windows 10. Users can still access Live Tiles and the 

touch-centric Metro interface from a panel on the right side of the Start Menu, 

however.

 

Figure 2.1: Microsoft Windows 10 Desktop Interface 
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Microsoft Windows 10 Continuum allows users to toggle between 

touch screen and keyboard interfaces on devices that offer both. Continuum 

automatically detects the presence of a keyboard and orients the interface to 

match. 

Windows 10's integrated search feature allows users to search all local 

locations, as well as the web simultaneously. 

Windows 10 security 

Microsoft Windows 10 integrated support for multifactor 

authentication technologies, such as smartcards and tokens. In 

addition, Windows Hello brought biometric authentication to Windows 10, 

allowing users to log in with a fingerprint scan, iris scan or facial recognition 

technology. 

Windows 10 system requirements 

Processor: 1 gigahertz (GHz) or faster processor or system-on-a-chip (SoC) 

RAM: 1 gigabyte (GB) for 32-bit or 2 GB for 64-bit 

Hard disk space: 16 GB for 32-bit OS 20 GB for 64-bit OS 

Graphics card: DirectX 9 or later with Windows Display Driver Model 1.0 

Display: 800x600 

 

The minimum Windows 10 Mobile hardware requirements for a smart 

phone are 1 GB RAM, 8 GB flash storage, a Trusted Platform 

Module, Unified Extensible Firmware Interface, 32 bits of color per pixel, and 

720p screen resolution. Smart phones also require a Snapdragon SoC from 

Qualcomm Technologies. 

 

2.2 - HOW TO INSTALL WINDOWS AND DRIVERS 

You can also update drivers for a printer, wireless adapter, monitor, and other 

components using Device Manager. 

Drivers may be updated by following these steps: 

1. Open Start. 

2. Search for Device Manager and click the top result to open the tool. 

3. Double-click the branch with the hardware you want to update. 

4. Right-click the hardware and select the Update driver option. 
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2.2 (a): Device Manager Interface 

5. Click the Search automatically for updated driver software option. 

 

 
2.2 (b): Update Driver Software 
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After you complete the steps, if a newer update is available, Device 

Manager will download and install the package automatically similar to 

Windows Update using the Microsoft servers. 

 

In the case that the driver isn't available through Windows Update, 

because it's too recent or available only in beta, you'll need to download and 

install the package from the manufacturer's support website manually. 

 

When getting an update from a manufacturer support website, you should 

always attempt to follow their instructions first. However, if there are no 

instructions, double-click the ".exe" self-extracting package, or use this 

guide to extract the content of the ".zip" compressed file, and then continue 

with these steps: 

1. Open Start. 

2. Search for Device Manager and click the top result to open the tool. 

3. Double-click the branch with the hardware you want to update. 

4. Right-click the hardware and select the Update driver option. 

 
2.2 (c): Update Device Derivers 

 

https://www.windowscentral.com/how-zip-and-unzip-files-windows-10
https://www.windowscentral.com/how-zip-and-unzip-files-windows-10
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5. Click the Browse my computer for driver software option. 

 

 
Figure 2.2 (d) - Browse computer for Driver Software 

6. Click the Browse button. 

7. Select the main folder with the driver files you have extracted earlier. 

8. Click the OK button. 

9. Check the Include subfolders option to allow the wizard to find the 

correct ".inf" file with the instructions to update the driver. 

10. Click the Next button. 

Once you complete the steps, the wizard will detect and install the new 

driver on your computer to improve the overall experience with fixes, 

new functionalities, or new support depending on the update and device. 

 

2.3 - DESCRIBE LOADING & SHUT DOWN 

PROCESS 

Loading Process 

 

The loading process in windows is also known as the Boot Process. This 

process consists of 5 Phases; 
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1. Phase 1 – Preboot 

In this phase, the PC’s firmware is in charge and initiates a POST and 

loads the firmware settings. Once all this works (hopefully), the system 

identifies a valid system disk and reads the MBR. The system then starts 

the Windows Boot Manager. This is located here: 

%SystemDrive%\bootmgr 

2. Phase 2 – Windows Boot Manager 

It is the job of the Windows Boot Manager to find and start the Windows 

loader (Winload.exe). This is located on the Windows boot partition – 

%System Root%\system32\winload.exe 

3. Phase 3 – Windows Operating System Loader 

In this phase, essential drivers required to start the Windows kernel are 

loaded and the kernel starts to run. The key file here is %System 

Root%\system32\ntoskrnl.exe 

4. Phase 4 – Windows NT OS Kernel 

The kernel loads the system registry hive into memory and loads the 

drivers that are marked as BOOT_START. The kernel then passes control 

to the session manager process (Smss.exe). 

You can identify the phase you are in visually by what your computer is 

displaying and the LEDs that are on the system. I will follow up with 

additional posts on this subject so that you can easily tell what phase you 

are stuck at – and what you can do to fix things. 

5. Phase 5 – Logon Process 
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In this phase the logon screen appears in front of the user where user types 

the username and password to log on to the system.

 
Figure 2.3 (a) - Log On Screen of Microsoft Windows 10 

Shutdown Process 

1. Click Windows Button 

2. Click Power Button 

3. Click Shut Down 

 

 
Figure 2.3 (b) - Shut Down Process in Windows 10 

 

2.4 - INTRODUCTION TO DESKTOP ITEMS 

(CREATION OF ICONS, SHORTCUT, FOLDER & 

MODIFY TASKBAR) 
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Figure 2.4 (a) - Log on to Windows 10 

 

Whether you're using a new computer with Windows 10 or an older machine 

that was recently upgraded, this lesson will show you the basics of using this 

Version of Windows.  

Signing in to Windows 10 

You'll probably be asked to create a Microsoft account the very time you use 

Windows 10 (if you don't have one already). From this point on, whenever 

you turn on the computer you'll need to sign in to that account. To do 

this, type your password into the box and press Enter. 
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Desktop Interface 

 

Figure 2.4 (b) - Desktop Interface 

Navigating the Desktop 

Once you've signed in, the first thing you'll see is the desktop. You can think 

of the desktop as the main workspace for your computer. From here, you can 

view and manage your files, open applications, access the Internet, and much 

more. 

Click the buttons in the interactive below to become more familiar with the 

Windows 10 desktop: 
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Figure 2.4 (c) - Navigating the Desktop 

Opening Applications 

You'll use the Start menu to open programs on your computer, just like with 

previous 

 

Versions of Windows. To do this, click the Start button in the bottom-left 

corner, then choose the desired application. If you don't see the one you want, 

select All apps to see a full list of applications. In the example below, we're 

opening OneNote.

 
Figure 2.4 (d) - Opening Applications 
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Working with Files 

You'll use the File Explorer to manage your files and folders. To open File 

Explorer, click the File Explorer icon on the taskbar or double-click any folder 

on your desktop. 

 

 

Figure 2.4 (e) - Working with Files 

Adjusting your settings 

You'll use the Settings app to change the most important settings on your 

computer, like your network and display options. To open the app, click the 

Start menu, then select Settings. 

 

 

Figure 2.4 (f) - Windows 10 Settings 

You can also use the Control Panel to adjust your settings, just like in earlier 

versions of Windows. However, there are some options that can only be 
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accessed from the Settings app, like adding a new user. Because of this, you'll 

probably use the Settings app more often. 

Shutting Down Your Computer 

When you're done using your computer, it's important to shut it down 

properly. To do this, click the Start button, then choose Power > Shut 

Down. 

 

Figure 2.4 (g) - Shutting Down your Computer 

Add New Icons to the Desktop 

Your desktop icons may be hidden. To view them, right-click the desktop, 

select View, and then select Show desktop icons. To add icons to your 

desktop such as This PC, Recycle Bin and more: 

1. Select the Start button, and then 

select Settings > Personalization > Themes. 

2. Under Themes > Related Settings, select Desktop icon settings. 

3. Choose the icons you would like to have on your desktop, then 

select Apply and OK. 
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Figure 2.4 (h) - Desktop Icons Settings 

Create a Shortcut to an Application 

To do this the easy way, open Windows 10’s Start menu. Look for the 

application you want to use by scrolling through the Apps list at the left side 

of the menu. 

If it’s in the tiles list at the right side of the menu, you can also drag it from 

there. Once you’ve found it, drag and drop the application’s shortcut from 

your Start menu to your desktop. 

You’ll see the word “Link” appear when you’re hovering over the desktop. 

Release the mouse button to create a link to the program, also known as a 

desktop shortcut. 
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Figure 2.4 (i) - Creating Shortcut to an Application 

Note that you can’t search for the application by name in the Start menu. 

Windows 10 won’t let you drag and drop anything from the search results. It 

should, but it doesn’t. 

Create a Shortcut to a File or Folder 

To create a desktop shortcut to a file, first, locate the file somewhere in File 

Explorer. Hold down the Alt key on your keyboard and then drag and drop the 

file or folder to your desktop. The words “Create Link in Desktop” will 

appear. Release the mouse button to create the link. 
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Figure 2.4 (j) - Creating Shortcut to a File 

Holding down Alt is necessary. If you don’t hold down Alt, Windows will 

show the words “Move to Desktop,” and it will move the folder or file to your 

desktop rather than simply creating a link. 

Create New Folder 

Follow the steps show in the figure. 

 

Figure 2.4 (k) - Creating a New Folder 
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Figure 2.4 (l) - Type the name for new Folder 

How to Auto-hide Windows 10 Taskbar 

If you want to auto-hide Windows 10 taskbar when it’s not in use, you can 

easily realize it by following the steps below. 

Step 1. You can right-click on the taskbar and choose Taskbar settings. 

Step 2. Then you can choose to turn on automatically hide the taskbar in 

desktop mode, or automatically hide the taskbar in tablet mode. 

The hidden taskbar can be shown when you move the mouse cursor to the 

bottom edge of the screen or where the Windows 10 taskbar is located. You 

can also press Windows logo key to reveal the taskbar. 

How to Add or Remove Icons on Windows 10 Taskbar 

To pin programs to the taskbar, you can click Start and right-click the 

program, click More -> Pin to taskbar to pin the application to the taskbar. 

To remove a program from taskbar, you can right-click the program and 

click Unpin this program from taskbar. 

If you want to remove default icons from system tray area in the taskbar, you 

can follow the steps below. 

Step 1. You can right-click the taskbar and choose Taskbar settings to open 

Windows 10 taskbar settings window.  
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Step 2. Next you can click Select which icons appear in the 

taskbar under Notification area. 

Step 3. Then you can choose to Always show all icons in the notification 

area, or you can turn off this option and choose to turn on/off some of the 

program icons. 

You can click Turn system icons on or off under Notification area to turn 

on or off some system icons. 

 

Figure 2.4 (m) - Taskbar Settings 

If you turn off an app here, you don’t really remove it, and it still shows up in 

the hidden area. If you turn an app on, it will appear in the main Notification 

Area. 

2.5 - DESKTOP PROPERTIES 

Personalizing Your Desktop 

Windows 10 makes it easy to customize the look and feel of your desktop. To 

access the Personalization settings, right-click anywhere on the desktop, then 

select Personalize from the drop-down menu. The Personalization settings 

will appear. 
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Figure 2.5 (a) - Personalizing the Desktop 

 

 
Figure 2.5 (b) - Desktop Background 

To change the font size: 

If you have difficulty seeing the text on your computer, you can increase 

the font size. Increasing the font size will also increase the size of icons and 

other items on your desktop. 

 

1. Open the Settings app, then select System.

 
Figure 2.5 (c) - Change Font Size 
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2. The Display options will appear. Use the slider to select the 

desired item size. Note that a larger size may interfere with the way 

some items appear on the screen. 

 

Figure 2.5 (d) - Display Options 

3. Click Apply to save your changes. You may then need to restart your 

computer for these changes to take effect. 

2.6 - USE OF CONTROL PANEL (ADD/REMOVE 

PROGRAM, TIME & DATE, MOUSE AND CREATE 

USER ACCOUNT) 

Use of Control Panel: 

The Control Panel is a component of Microsoft Windows that provides the 

ability to view and change system settings. It consists of a set of applets that 

include adding or removing hardware and software, controlling user accounts, 

changing accessibility options, and accessing networking settings. Additional 

applets are provided by third parties, such as audio and video drivers, VPN 

tools, input devices, and networking tools.  



COMP-162 COMPUTER APPLICATIONS 

 

 
85 | P a g e  

 

Add and Remove Program: 

To open Add or Remove Programs in Windows 10 

1. Press the Windows key, type Apps & features or Add or Remove 

Programs, and press Enter. 

2. A window similar to the picture below should appear. 

 

 

Figure 2.6 (a) - Add and Remove Programs 

3. From this window, you'll be able to manage how Windows installs 

programs and also uninstall any programs that were installed. 

Or 

1. Open the Control Panel 

2. Click Programs and Features or under the Programs 

section click Uninstall a program. 

3. From this window, you'll be able to manage how Windows installs 

programs and also uninstall any programs that were installed. 

 

Change Time & Date: 

Computers connected to the internet should automatically adjust for 

daylight savings time. 
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1. Right-click on the time in the bottom-right of the screen and 

select Adjust Date/Time. 

 

 

Figure 2.6 (b) - Adjust Date & Time 

2. A window will open. On the left side of the window select the Date & 

time tab. Then, under "Change date and time" click Change 

 

 

Figure 2.6 (c) - Change Date & Time 

Note: Both Set time automatically and Set time zone automatically 

must be Off to make this change. 

3. Enter the time and press Change 

4. The system time has been updated. 
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Change Mouse Settings: 

Windows 10 gives you a range of customization options for your mouse, so 

you have flexibility in how your cursor behaves. In this guide, we’ll walk you 

through the available settings and the impact they have on your pointer. 

Before we get going, it’s worth mentioning that Windows 10’s mouse settings 

are still split across Control Panel and the Settings app. The Settings app’s 

Mouse page is currently extremely basic and contains only one option you 

won’t find in the Control Panel. 

Primary mouse button and scroll wheel 

We’ll head to Settings first, so open the app (Win+I keyboard shortcut), click 

the “Devices” category and then navigate to the “Mouse” page from the menu. 

 

Figure 2.6 (d) - Change Mouse Settings 

The page lets you customize the scroll wheel’s operation and change 

which mouse button acts as the primary one. The mouse wheel can be made to 

scroll through lines or entire screens (as if you pressed the Page Up/Page 

Down buttons), and you can customize how many lines or screens should be 

scrolled at once. 

The last toggle button on the page, “Scroll inactive windows when I 

hover over them,” is the only mouse setting not available in the Control Panel. 

This feature was new for Windows 10.  
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Per the description, it lets you scroll the contents of any window on 

your desktop by hovering over it and using the mouse wheel. You don’t need 

to switch focus to the window first, addressing a long-standing complaint with 

previous versions of Windows. You’ll probably want to keep it enabled most 

of the time. 

The rest of Windows’ mouse settings are tucked away in the Control 

Panel. You can access them with the “Additional mouse options” link to the 

right of the Mouse settings page. This will bring up the “Mouse Properties” 

popup which hasn’t changed much through generations of the Windows 

operating system. 

 
Figure 2.6 (e) - Mouse Properties 

The first tab of this screen provides three options. The first is duplicated from 

the Settings app and lets you customize your primary mouse button. The 

second lets you change when double-clicks are registered – if you find 

Windows isn’t detecting when you double-click, or is making false positive 

matches, you can use the slider and test area to fine-tune how long a double 

click has to last. 

Click Lock 

The final option on the page controls a little-used accessibility feature called 

Click Lock. When it’s enabled, you don’t need to hold down your mouse 

button when clicking and dragging.
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Instead, you hold the button briefly, which starts the selection. You can then 

release the button, move the mouse to complete your selection and press the 

button again to confirm the operation. It’s intended primarily for people who 

may find it hard to depress the mouse button for an extended period of time. 

 
Figure 2.6 (f) - Mouse Properties 

The second tab of the Mouse Properties dialog enables you to change 

the presentation of your cursor. You can pick and choose from the themes 

installed on your device, or specify your own images to use for different 

cursor states. 

Pointer speed and sensitivity 

The Pointer Options tab is more directly applicable to your mouse’s 

operation. The first set of options are related to the movement of your cursor. 

You can control how fast the cursor moves, enabling you to reduce or increase 

the effective sensitivity of your mouse. 

There’s also an “Enhance pointer precision” checkbox, which 

dynamically adjusts the effective sensitivity relative to how fast you move the 

mouse. When you’re moving slowly to select a small button, Windows will 

adjust the sensitivity on-the-fly to keep the cursor motion precise. If you have 

a gaming or professional mouse, you should note that both the pointer speed 

and precision options may conflict with the DPI and sensitivity settings 

offered by your mouse. 
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Figure 2.6 (g) - Mouse Pointer Options 

The second section of the Pointer Options tab controls “Snap To,” an 

accessibility feature which automatically moves your cursor as new popups 

open on your screen. Your cursor will automatically “snap to” the default 

button in each popup, so you don’t need to move your mouse to press “OK.” 

Finding the cursor 

 

Finally, the “Visibility” section lets you control when the cursor 

should be hidden. You can disable automatic cursor hiding while typing with 

the “Hide pointer while typing” checkbox. 

 

Using the “Display pointer trails” option, it’s possible to display 

pointer trails that track your mouse across the screen if you have difficulty 

following your cursor. A final usability tweak is “Show location of pointer 

when I press the CTRL key” – a self-explanatory checkbox which can come 

in handy for those “lost my mouse” situations. 
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Create User Account: 

How to create a new user on Windows 10 (Easy Way) 

Compared to older Windows builds (XP, Windows 7 or Vista), it’s 

quite easy to create a new user on Win 10. Now, why would someone do that? 

Well, creating one or several users on the same machine isn’t some whim, but 

a very ‘hygienic’ cyber security practice. Even if you’re the one and only 

owner of the PC, it’s still a good idea to use a non-administrative account in 

case you wind up on the wrong side of the Internet. 

Doesn’t matter what kind of malware your computer picks up – 

running your PC on a typical, non-admin account, ensures that the 

‘nastinesses’ can’t gain a foothold in the system and start messing around 

with functions and processes (i.e. boot. ini, 

msdos.sys, autoexec.bat, io.sys, svchost.exe). 

 

ADDING A NEW USER THROUGH ACCOUNTS’ GUI 

Now, the fastest way to create a new user account on Windows 10 is 

through Settings. Here’s what you’ll need to do: 

Step 1. Hit or tap the Start button. 

Step 2. Click or tap on the Settings button (that would be the “gear” icon). 

You can also access Settings by hitting the Windows key on your keyboard 

and writing “Settings” in the search bar. 

Step 3. In Settings, click or tap on Accounts (the icon should be right 

under Network & Internet). 

Step 4. Under Accounts, click or tap on Family & other users. 

Step 5. Look under Other users and click on the “+” (plus sign) next to Add 

someone else to this PC to create a new account on your machine. 

Step 6. Choose how the new user will log in his 

account: Xbox, Office Online, OneDrive, Office, or Skype. Type the address 

in the bar and hit the Next button. 

Step 7. Review the details and press the Finish button to complete the 

registration process.  

That’s it – the new user can log in by typing in his Microsoft username 

and password. Now, you should keep in mind that this method can only be 

used in conjunction with one of the above-mentioned accounts. If you want to 
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create a local account (no online account verification required), follow the 

steps below. 
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How to create a local account with Windows 10 

Step 1. Click or tap on the Start button. 

Step 2. Head to Settings. 

Step 3. Click or tap on Accounts. 

Step 4. Go to Family & other users. 

Step 5. Under Other users, click or tap on Add someone else to this PC. 

Step 6. In the bottom part of the page, click or tap the hyperlink reading I 

don’t have this person’s sign-in information. 

Step 7. Click or tap on the hyperlink reading Add a user without a Microsoft 

account. 

Step 8. In the account registration window, enter the name of the person 

who’s going to use the computer and choose a password (hint: don’t use 

“1234” or “qwerty”, wink-wink). 

Reconfirm your password and set a hint. When you’re done, press 

the Next button to complete the registration process. 

Okay, I have to admit that all of these steps seem basic enough, but the good 

news is that Windows 10’s account-managing platform allows the user (that’s 

you) to ‘mess’ around with privileges. 

Let’s assume that the account you’re about to create is for a family member. 

 

2.7 - EXPLAIN THE METHOD OF SEARCHING A 

DOCUMENT 

 

How to Search for Files in Windows 10? 

1. Search for files using the taskbar 

2. Search for files using File Explorer 

3. Search for files using Everything 

 

There are three methods that can be used to search for files in 

Windows 10. You can select one according to your actual situation. 

Additionally, you can use these three methods to search for files from 

computer hard drives, One Drive, SD cards, memory cards, and more.  
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Method 1: Search for Files Using Taskbar (by Name) 

This method is very simple. You can follow these steps to search for 

files by the name or a keyword. 

1. Press Win + X and select Search from the WinX Menu to open the 

Windows 10 search box. Or, you can directly click Cortana to open it. 

2. Type the name or a keyword of the file you want to find into the 

search box and you will see the search results across your computer 

and OneDrive under Best match. 

You can select the file to open it and check whether it is the file you 

want to find. If you think this method can’t help you find the needed files or 

you need to search for file contents in Windows 10, you can use File Explorer 

instead. 

Method 2: Search for Files Using File Explorer (by Name/File 

Contents/Type) 

A Windows 10 file search with File Explorer is a commonly-used 

method to find your needed files. 

Here is a step-by-step guide: 

Note: If your File Explorer is set to start from Quick Access, when you open 

File Explorer, you will enter Quick Access directly. You should not perform a 

Windows 10 file search in Quick Access. You need to switch to This PC 

before searching. Or, you can refer to this post to make File Explorer start 

from This PC.  

How to Use Windows 10 Quick Access: A Full Introduction. 

1. Go to File Explorer and access the drive that should contain the files 

you want to find. If you are not sure the file location, you can just 

select This PC from the left list to make File Explorer show all drives 

in This PC. 

2. The search box is on the upper right corner of File Explorer. You need 

to input the file name or a keyword. Then the Windows 10 file search 

process will automatically start. 
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Figure 2.7 (a) - Search Files and Folders 

When the search process ends, you can see the search results. It is quite 

possible that you see more than one choice. Then, you need to find the target 

one from the results. 

 

Perform an Advanced Search in File Explorer: 

If there are so many files, you can then perform an advanced search in File 

Explorer. You can click the arrow next to the question mark on the upper right 

corner and then make a further selection like file size, kind, date modified, etc. 

You can use these features according to your actual situations.

 

Figure 2.7 (b) - Search Results 
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Perhaps, you want to find a Word, Excel, or a text file. But, you forget the 

name of the file. Take it easy. You can try to remember some text contents 

that are especially exist in that file and then search files content via File 

Explorer. 

To do this work, you need to do some preparation beforehand: enabling the 

File contents feature of Windows 10 file search in File Explorer. You can 

follow these steps to enable the File contents feature: 

1. Open File Explorer. 

2. Click the Search mark (the magnifying glass mark) on the upper right 

corner. 

3. Click Search on the top toolbar. 

4. Click the Arrow Down button of the Advanced options. 

5. Select File contents from the drop-down menu. 

 

Figure 2.7 (c) -  Advance Searching 

Now, the File contents feature is enabled. You can type the content 

text into the search box to search for your needed files. 

 

Method 3: Search for Files Using Everything (by Name/Type) 

Besides using the Windows snap-in tool to search for files in Windows 

10, you can also use a third-party utility to do the work. Everything is just 

such a tool. 



COMP-162 COMPUTER APPLICATIONS 

 

 
97 | P a g e  

 

Everything is a desktop search utility for Windows. You can use it to 

search for your needed files and folders by name. In addition, this utility can 

also show you all the computer files by type (limited to some certain types). If 

you only remember the type of file you want to find, you can set this tool to 

only show the target file type. 

Search for Files in Windows 10 by Name: 

1. Open Everything. 

2. Input the file name to make the tool show the related items. 

3. Go to find your needed files from the list of the search results. 

 

Figure 2.7 (d) - Search Files by everything 

If there are so many search results, you can click Search from the toolbar and 

select the target file type to narrow down the search range. 
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Figure 2.7 (e) - Search Files by everything 

After finding the needed file, you can click on it to open it immediately. Or 

you can go to File > Open path to access the storage location. 

Search for Files in Windows 10 by Type: 

If you really forget the name of the file, you can use the Search feature of 

everything to select the data type of your needed file. This can shorten the 

search time relatively. 
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EXERCISE 

Multiple Choice Questions 

1. Microsoft launched windows 10 on; 

 (a) July 2013 (b) July 2015 (c) July 2016 (d) March 2017 

2. Windows 10 operating system has been designed for; 

 (a) Desktop computers  (b) Laptops  

 (c) Mobile phones   (d) All these 

3. Windows 10 operating system can run on ; 

 (a) IBM systems   (b) IBM compatible system  

 (c) App Mac systems   (d) Both a & b 

4. Windows 10 operating is a ;  

 (a) GUI    (b) Multitasking   

 (c) Multi user    (d) Both a & b 

5. In windows 10, start button can be used for ;  

 (a) Search the used files  (b) Open the required Apps 

 (c) Shut down or restart the system (d) All these 

6. Cortona feature of windows 10 works as;    

 (a) Personal digital assistant   (b) Operating system  

 (c) Application software  (d) None of these 

7. Which one of the windows users are given free upgrade to windows 10. 

 (a) Windows XP   (b) Windows 8 only  

 (c) Both Windows 7 and 8  (d) All Window users 

8. The windows 10, biometric login feature has been named.  

 (a) Windows Bio    (b) Windows Hello  

 (c) Windows Pad Lock  (d) Windows Instant 

9. This feature re-included in windows 10, it was removed in windows 8; 

 (a) Recycle bin   (b) Start menu  

 (c) Gagets    (d) None of these 

10. Which feature of windows 10 allows to adopt to different device types. 

 (a) Hub  (b) Flex (c) Continuum  (d) Unity  
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11. New built in browser of windows 10 is ; 

 (a) Cortona   (b) Edge (c) Internet Explorer (d) Opera 

12. The cortana is named after a character of this video game. 

 (a) Destiny (b) Halo (c) Final Fantasy (d) Fable 

13. Windows 10 belongs to this window family. 

(a) Windows 7X    (b) Windows Ap  

(c) Windows NET    (d) Windows NT 

14. These buttons are used to take screen short of display screen; 

 (a) Alt + PrtScn   (b) Shift + PrnScn  

 (c) Ctrl + PrtScn   (d) Windows key + PrtScn 

15. Which shortcut keys can be used in windows 10 to open programs pinned 

in taskbar. 

 (a) Shift + [1],[2],[3]...  (b) Windows + [1],[2],[3]...  

 (c) Alt + [1],[2],[3]...   (d) None of these 

16. These keys can be used to lock the windows 10 desktop. 

 (a) Shift + L    (b) Ctrl + L  

 (c) Windows + L   (d) Any of these 

17. Shortcut keys to open Action Center. 

 (a) Windows + A   (b) Windows + C 

 (c) Windows + P   (d) Windows + Spacebar 

18. Shortcut keys to open windows setting. 

 (a) Windows + I   (b) Windows + A  

 (c) Windows + S   (d) Windows + H 

19. Shortcut keys to show windows 10 desktop. 

 (a) Windows + D   (b) Windows + B  

 (c) Windows + T   (d) Windows + K 

20. This is a Windows 10 feature. 

 (a) Action Center  (b) Multiple desktop  

 (c) Cortana   (d) All these 

21. The name of online data storage facility of windows 10 is ; 

 (a) Sky drive    (b) One drive  

(c) Ten drive    (d) Soft drive  
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22. Due to this feature of windows 10, icons looks transparent like a glass 

 (a) Aero feature   (b) Dyno feature  

 (c) Trans feature   (d) None of these 

23. Windows 10 support this ; 

 (a) DVD    (b) Blu Ray Disk  

 (c) Internet Digital TV  (d) All these 

24. You can use cortana of windows for ; 

 (a) Here any song  (b) Ask any question, about your files

 (c) Ask the weather condition (d) All these 

25. This is a virtual assistant in widows 10. 

 (a) Action center   (b) Cortana   

 (c) MS Edge    (d) Windows store 

26. Data that can be store free of cost in One drive of Windows 10 is; 

 (a) Upto 2GB    (b) Upto 10 GB  

 (c) Upto 25GB   (d) Upto 500GB 

27. Horizontal strip on bottom side of windows 10 is called ; 

 (a) Task bar (b) Status bar (c) Title bar (d) All these 

28. Time, date, internet connection and battery meter show on this part of 

taskbar; 

 (a) Time area   (b) Date area  

 (c) Notification area  (d) Both a and b 

29. Taskbar of windows 10 holds ; 

 (a) Search box   (b) Pinned programs  

 (c) Notification area  (d) All these 

30. In windows 10, this modification can be made on task bar. 

 (a) Change the location of task bar  

 (b) Task bar can be hide  

 (c) Icon size on task bar can be changed (d) All these 

31. System tray contains icon of this item. 

 (a) Wi-fi     (b) Blue tooth   

 (c) Volume & clock    (d) All these  
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32. A folder may contain ; 

 (a) Files     (b) Sub folders 

(c) Data     (d) Both a & b 

33. Screen savers are basically used for this monitor; 

 (a) LCD (b) LED backlight (c) Plasma (d) CRT 

34. This task can be performed through control panel. 

 (a) Adding hardware   (b) Add/Remove programs  

 (c) Clock Setting   (d) All these 

35. Delete files and folders in windows 10 goes in ; 

 (a) Hard disk    (b) Recycle bin  

 (c) Dust bin    (d) None of these 

36. Number of horizontal and vertical pixels on monitor screen is called; 

 (a) Screen saver   (b) Screen resolution 

 (c) Screen pixels   (d) Wallpaper 

37. Small pictures on desktop, representing some programs are called; 

 (a) Folder    (b) Icon  

 (c) Program    (d) Desktop picture 

38. This icon appear automatically on desktop screen. 

 (a) This PC    (b) Recycle bin  

 (c) My documents   (d) Both a & b 

39. This is used to control and manage computer hardware & software. 

 (a) Web browser   (b) Control panel  

 (c) Control master   (d) Start button 

40. Windows 10 O/S is a ; 

 (a) Multi user   (b) Multi-tasking  

 (c) Multidimensional  (d) All these 

41. By deleting a shortcut of a file ; 

 (a) Data of the file remain save (b) Data of the file will be lost

 (c) Data of the file will be changed (d) All these 

42. Microsoft corporation produce; 

(a) Computer software  (b) Hardware  

 (c) Both hardware and software (d) None of these  
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43. The tray which is display on left side of task bar is called; 

 (a) Icon's tray    (b) Windows tray  

 (c) System tray   (d) Non system tray 

44. First screen that appears after log in is called ; 

 (a) Primary screen   (b) Desktop screen  

 (c) Interface    (d) Program screen 

45. To shut down the computer, this button is clicked first. 

 (a) Shut down button   (b) Start button 

 (c) Power button   (d) Any of these 

46. This is an option of control panel of windows 10. 

 (a) Hardware & sound  (b) User accounts  

 (c) Network and internet (d) All these 

ANSWERS KEY 

 

SHORT ANSWER TYPE QUESTIONS 

1. Define Windows operating system. 

2. What is GUI. 

3. Write short introduction of Windows 10. 

4. Write names of some new features of windows 10. 

5. What is folder? 

6. What is an icon? 

7. For which purpose, recycle bin is used. 

8. For which purpose, file explorer is used in windows 10. 

9. For which purpose, control panel is used. 

10. How file can be searched in windows 10. 

11. What is meant by shortcut. 

12. What is cortana. 

13. Write short introduction of "Edge" browser. 

14. Which facility is available in windows 10 store. 
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15. What is available in windows 10 task bar. 

16. What is aero graphical user interface in windows 10. 

17. What is "Windows hellow". 

18. What is minimum capacity of system for windows 10 installation. 

19. What is desktop screen. 

20. Introduce windows 10 taskbar & its items. 

21. What is notification area, what is displays. 

22. What is meant by system loading. 

23. What is meant by "Login". 

24. Write method of creating new folder in Windows 10. 

25. Write method of adding/deleting items in system tray of windows 10. 

26. Write method of creating new user's account in windows 10. 

27. How anything saved in computer can be searched in windows 10. 

28. Define screen resolution. 

29. How a file of a specific program is identified. 

30. Why screen saver is used. 

 

 LONG QUESTIONS 

 

1. Write 8 features of windows 10. 

2. Write the names of parts of windows 10 interface and their location. 

3. Write method of installation of windows 10. 

4.  Write in detail components of taskbar in windows 10. 

5. Write important features of MS Windows 10. Write method of setting 

background, screen saver and resolution in windows 10. 

6. Write method of creating new user account in windows 10. 

7. Write method to create desktop shortcut and folder in windows 10. 

8. Write method of changing taskbar settings in windows 10. 

9. Write all methods of searching file in windows 10. 

10. Write names of components of control panel of windows 10. 

11. Write method to uninstall a program in windows 10.  

12. What is user account, write its types.  
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C H A P T E R  3  

 

M i c r o s o f t  w o r d  

 

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of Microsoft Word. 

 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 

 

 Define working of MS-Office  

 Describe MS-Word & different parts of its screen.  

 Create a new document. 

 Apply Editing & formatting on text. 

 Save a document & Open an existing document. 

 Work on Page setup (Set the Margins & Paper)  

 Use the Spelling& Grammar Check  

 Set Paragraph Alignment  

 Insert Page numbers, Symbols, Text box & Picture in the document  

 Use the different Format menu drop down commands (Drop Cap, 

Change Case, Bullet & Numbering and Border & Shading)  

 Insert the 'Table and it's Editing  

 Print the document  

 Save a document file as PDF format  
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3.1 - INTRODUCTION TO MICROSOFT OFFICE 

MS. Office is one of the most popular application software. It is a 

complete office suite with various software programs like MS Word, MS 

Excel, MS. Power Point etc.  It is developed by Microsoft Corporation. In 

latest MS. Office versions, new user interface is introduced which has 

replaced the old menus and toolbars of office 2003 and old versions. In new 

versions Ribbons and Office button is introduced. Word processing is the 

process of creating text documents. It is used to create, edit, format text and 

also used to add graphics in the document. In order to perform word 

processing, a software is required which is known as word processor.  A word 

processor is software which is used to create, edit and print documents. Word 

processor provides facility to write text, store it, modify it by using various 

commands and print the document as well. There is a number of word 

processing software available in market. Some of them are MS Word, Open 

Office writer, Word Perfect and Google Drive document. But most commonly 

used word processing software is Microsoft Word.  

3.2 - INTRODUCTION TO MS WORD & ITS 

SCREEN 

MS WORD 

Microsoft Word is one of the most popular software programs in the 

world, used by millions of the people around the world. There are various 

features to create, read and edit documents. Most of the features are not used 

by users because all of them are not necessary for every user. We will use 

some basic features of MS Word. It has many features, some of them are 

discussed under: 

 Easy Typing and easy to use 

 Adding, removing and Copying text 

 Text formatting 

 Bullets and numbering 

 Header and footer 

 Spelling and grammar check 

 Inserting pictures 

 Preview facility.  

 Creating tables and many more features.  
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SCREEN INTRODUCTION OF MS WORD 

Microsoft introduces a new look screen environment in MS Word that 

offers a more efficient and straight forward approach. What’s new in Word is 

shown in figure 3.2 and outlined below. 

 

 
Figure 3.2- MS Word Screen Layout 

1. File Menu: Provides access to menu commands in Word. All commonly 

used features such as New, Open, Save, Print and Recent Documents are 

available under this button.  

2. Ribbon: The Ribbon replaces the menus and toolbars in previous 

versions. The Ribbon exposes most of the features that were hidden in 

File menus. The Ribbon makes it easier to see and find commands to 

format your document.  

3. Quick Access Toolbar: A customizable toolbar at the top of an active 

document. By default, the Quick Access Toolbar displays the Save, 

Undo, and Repeat buttons and is used for easy access to frequently used 

commands. To customize this toolbar, click on the dropdown arrow and 

select the commands you want to add. 
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4. Title Bar: A horizontal bar at the top of an active document. This bar 

displays the name of the document and application.  

5. Command Tabs: An area on the Ribbon that contains buttons that are 

organized in groups. The default tabs are Home, Insert, Page Layout, 

Reference, Mailings, Review and View. 

6. Window controls: are used to change the size of a window, or to close it. 

7. Groups: A Group of buttons on a tab that is exposed and easily 

accessible. These buttons were formally embedded in menus on the Menu 

Bar. 

8. Dialog Box Launcher: A button that launches a dialog box containing 

options for refining a command. 

9. Status Bar: A horizontal bar at the bottom of an active window that 

gives details about the active document. 

10. View Toolbar: A toolbar that enables, adjusts, and displays different 

views of a document’s content. 

11. Zoom Slider: A button that magnifies or reduces the contents in the 

document window. 

12. Document Area: The white space framed between rulers and the 

scroll bars looking like a blank sheet of paper. This is the area where you 

type the text of the document. 

13. The Cursor: The blinking vertical line in the document area is called 

cursor or insertion point. The typed characters appear at its location. 

14. Ruler: The ruler is a measurement tool used with MS Word that 

allows the program's user to align graphics, text, tables, or other elements 

on a page. When enabled the horizontal ruler appears at the top of the 

document, and the vertical ruler is on the left-side of the document.  

15. Help Button: Click the help button to open the help window for the 

MS Word program. 

16. Scroll Bar: Scrollbar is used to display different portions of a 

document in the document windows. There are two types of scrollbar, 

horizontal scrollbar appears on bottom of the document window and 

vertical scrollbar appears in the left side of the document window.   
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3.3 – CREATION OF NEW DOCUMENT 

You can create new documents by using the menu option with 

keyboard or mouse and by using shortcut key. 

CREATING A NEW DOCUMENT USING KEYBOARD 

Just follows these steps to create new document using keyboard 

 Press Alt + F to open File Menu. From the menu select New command 

and press Enter. The New Document dialog box will appear (Figure 

3.3).  

 Select Blank document under the Blank and recent section. It will be 

highlighted by default. 

 Press Enter to create new document. 

OR 

Another method is as under: 

 Press Ctrl + N keys from keyboard to create new blank document 

rapidly. 

 
Figure 3.3 – New Document Creation Options 

CREATING A NEW DOCUMENT USING MOUSE 

 Click the File Menu to open the menu. Click New command the New 

Document dialog box will appear. 

 Click to select the Blank document under the Blank and recent section 

then click on Create button to create new document. 

OR 
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 Click the New tool on Quick Access Toolbar. The new blank document 

will create instantly. 

3.4 - EDITING & FORMATTING OF TEXT 

3.4.1 - EDITING OF TEXT 

The great feature of word processors is that you can go back and edit your 

document as much as you like, before printing it out. 

To edit your document, you need to be able to do two things. 

 First, you need to identify and select the text you want to change.  

 Second, you need to make your change. Broadly, there are four kinds of 

change you can make to a document 

1. Add text 

2. Remove text 

3. Copy text  

4. Move text 

3.4.2 TEXT SELECTION METHODS FOR EDITING 

Text selection makes sure to change the specific part of text. There are 

two ways to select your text either by using keyboard and mouse. 

TEXT SELECTION USING KEYBOARD 

1. Press [Shift] + [Arrow keys] to select text toward left, right, up or 

down. 

2. Press [Shift] + [Home/End] to select the beginning/end of the current 

line. 

3. Press [Ctrl] + [Shift] + [Home/End] to select the beginning/end of the 

document. 

4. Press [Ctrl] + [A] to select whole document. 

TEXT SELECTION USING MOUSE 

1. Click where you want to start selecting text, press the left mouse 

button, and Drag across the text, then release the mouse button where 

you want to end. 

2. Once to put the cursor next to a letter; Twice (double-click) to select 

the word; Three times (triple-click) to select the paragraph. 

3. To select a single line, move your mouse over to the left margin of 

your text and click  
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4. To Select Whole Document Go to Home ribbons, click the down 

arrow next to the word Select, and then click Select All (figure 3.4.2) 

 

Figure 3.4.2 – Select All Text 

3.4.3 PROCEDURE TO ADD & REMOVE TEXT  

Adding Text: 

One of the best things about word processing is that it’s so easy to add 

something to your text. 

1. Click the point to bring cursor where you’d like to add to your text. 

2. Type the new text. 

3. The line breaks will automatically adjust themselves to accommodate 

the addition to your text. 
Removing Text: 

In Word there are two ways that you can delete your text, character by 

character or delete selected text. 

1. Use [BACKSPACE] key to delete characters to the left of the cursor. 

2. Use [DEL] key to delete characters ahead of the cursor. 
3. OR select the text that you want to delete and press [DEL] key  

3.4.4 PROCEDURE TO USE THE CLIPBOARD 

Cutting, copying, and pasting are some of the most practical features 

of a word processor, here are examples to use clipboard. Figure 3.4.4 shows 

the clipboard ribbon. 

CUTTING AND PASTING PROCEDURE 

1. Select the relevant text. 

2. Use [Ctrl] + [X] shortcut key or click the 

Cut button in the Home ribbon (clipboard 

group) – its icon is a pair of scissors. 
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3. Where did the selected text go? It’s been moved to the Clipboard, an 

(invisible) storage area. 

4. Place the cursor at the point where you’d like 

to add the text. 

5. Now use [Ctrl] + [V] or click the Paste button in Clipboard group. 

COPYING AND PASTING PROCEDURE: 

1. Select the relevant text. 

2. Use [Ctrl] + [C] shortcut key or click the Copy button in the Home 

ribbon  

3. The text been copied to clipboard.  

4. Place the cursor at the point where you’d like to copy the text. 

5. Now use [Ctrl] + [V] or click the Paste button in Clipboard group. 

3.4.5 PROCEDURE FOR UNDO, REDO & REPEAT 

(A)  THE UNDO COMMAND 

This command undoes previous actions allowing you to recover from 

mistakes as though they never happened.  Follow these actions: 

Procedure: 

1. Click the Undo button on the Quick Access Toolbar  

OR 

2. Press [Ctrl] + [Z] keyboard shortcut 

(B)  TO REDO COMMAND: 

The Redo command will redo a previously undone action. 

Procedure: 

1. Click the Redo button on the Quick Access Toolbar  

OR 

2. Press [Ctrl] + [Y] keyboard shortcut 

(C)  REPEAT AN ACTION 

The Repeat command will repeat the last action you carried out. This 

can greatly speed up the completion of certain tasks. 

Procedure: 

1. Click the Repeat button on the Quick Access Toolbar  

OR 

2. Press [F4] keyboard shortcut  

Figure 3.4.4 - Clipboard 
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3.4.6 - FORMATTING OF TEXT 

In Microsoft Word formatting can be applied to make the document 

more presentable and interesting. Format means the way a document looks or 

appears. When we format the text its means we actually change the default 

formatting into our desired formatting. 

We can change the font, font style, font color and font size of the text. 

We can also define the format of paragraphs in a document. We can make lists 

by using bullets and numbering. Microsoft Word has various formatting 

options. Before we apply any format to the text, we need to select first the 

section or part of text that we wish to change. 

FORMATTING USING FONT  

1. Select the text by keyboard or mouse 

2. Select the Home tab 

3. From the Font panel, select the font, font style, and font size and font 

color according to your requirement. The screenshot below displays 

the different font formatting options.  

 

Figure 3.4.6 – Formatting Using Font Panel 
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Different font tools are described below in table  

Formatting 

Options 

Description 

Font Changes the font  of the selected text to the font 

name specified as Times New Roman, Arial, Calibri 

etc 

Font Size Changes the font size of the selected text to the size 

specified.  

Bold Makes the selected text Bold.  

Italics Applies Italic formatting to the selected text. 

Underline Underlines the selected text. 

Font Color Formats the selected text with the color chosen. 

Table 3.4.6 – Formatting Using Font Panel 

USING KEYBOARD SHORTCUTS 

1. Ctrl + B  for bold              Example 

2. Ctrl + I  for Italic                                   Example 

3. Ctrl + [       to decrease the font size         Example 

4. Ctrl + ]       to increase the font size         Example 

5. Ctrl + U     for underline                          Example 

3.5 - SAVING AND OPENING A DOCUMENT 

3.5.1 SAVING FILE 

WHY SAVING FILES? 

 Files are necessary to save permanently on secondary storage device 

for future use. You can save files to the hard disk located inside your 

computer, a floppy disk, an external hard drive, a net-work storage drive, or a 

portable storage disk, such as a USB flash drive. 

FILE SAVING METHODS: 

SAVING A DOCUMENT USING KEYBOARD  

 Press [Ctrl] + [S] keyboard shortcut  

OR  

 Press Alt + F to open File menu then select Save or Save As 

command and press ENTER 

Note:  

 Use Save to save a document for the first time or to save changes.  
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 Use Save As to also save a document for the first time or to save a 

previously saved document with different name and in a different 

location. 

Saving a Document: Mouse Option 

 Click the File Menu   Save or Save As   OR 

 Click the File icon on the Quick Access Toolbar  

If you are saving the file for the first time, the Save As pane will 

appear in backstage view. 

Now choose where to save the file and give it a file name. 

Click Browse to select a location on your computer. Alternatively, you 

can click One Drive to save the file to your One Drive. 

 
Figure 3.5.1 (a)– File Saving 

By doing above actions the Save As dialog box will appear as shown in figure 

3.5.1 (b)

 
Figure 3.5.1 (b) – File Saving Dialog Box 
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Save As Dialog Box Entries 

 From the Save in pull-down list, select the appropriate location (drive 

and folder name) where you want to save your file for future use. My 

Documents is the default folder to manage user’s documents.  

 In the File name text box, type a meaningful file-name like “Computer 

application” 

 From the Save as type pull-down menu, select the type of file but this 

is optional 

 Press Enter or Click on SAVE button. Your document will be saved. 

3.5.2 OPENING AN EXISTING DOCUMENT 

Once you have created and saved a document, you may need to 

retrieve it from your storage medium. For example, you might want to revise 

the document or reprint it. To grab your word file from secondary storage 

media, do following. 

OPENING A DOCUMENT BY KEYBOARD 

 Press [Ctrl] + [O]  keyboard shortcut to get OPEN dialog box  

OR 

 Press Alt + F to open File menu then select Open command and press 

ENTER 

OPENING A DOCUMENT BY MOUSE 

 Click the File Menu and then click Open Command            (OR) 

 Click the Open icon on the Quick Access Toolbar 

 Navigate to Backstage view, then click Open. 

By doing above actions the Open dialog box appears as shown in  

figure 3.5.2. 

 
Figure 3.5.2 – File Opening Dialog Box 
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As the dialog box appears, provide location (destination drive and folder) of 

your file, file name which you want to open and press ENTER or click the 

Open button to open your desired file.  

3.6 - PAGE SETUP (SET THE MARGINS & PAPER 

SIZE) 

You can use the Page Setup group of commands on the Page Layout 

tab, shown in Figure 3.6 , to change how you setup a document’s pages. Open 

the Page Setup dialog box for access to more options by clicking on small 

arrow. 

 

Figure 3.6 – Page Setup Options 

3.6.1 – SETTING MARGINS 

Margins are the white space that borders the text on the edges of a 

page. MS Word sets default margins for new documents, but you can change 

them to fit your document requirements. 

To set the page margins do following 

1. On the Page Layout tab, in the Page Setup group, click Margins.  

2. Click the margin type that you want. For the most common margin width, 

click Normal. 

3. When you click the margin type that you want, your entire document 

automatically changes to the margin type that you have selected. 

4. You can also specify your own margin settings. Click Margins, 

click Custom Margins, and then in the Top, Bottom, Left, 

and Right boxes, enter new values for the margins.  
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3.6.2 – PAPER SETTING 

Paper size is important aspect to consider when you work on your 

documents, designs and brochures etc. The defualt paper size is Letter 8.5 × 

11 inches. If you will be printing on a different size paper, the Paper size 

button in the Page Setup group makes it convenient to change the settings.  

To set or select the paper size do following 

1. On the Page Layout tab, in the Page Setup group, click Size. 

2. For the most common paper size, click Letter. 

Click on More Paper Sizes to set custom paper size. 

3.7 – SPELLING AND GRAMMAR CHECK 

MS Word automatically checks spellings and grammar as you type. It 

is done by comparing each word to Word’s built in dictionary and grammar 

rules. Word flags words that might be misspelled with a wavy red underline 

and wavy green underline for grammatical error. 

CORRECTION PROCEDURE 

You can also right-click a word that has red or green wavy line and see 

a shortcut menu with suggestions for correction as shown in figure 3.7 (a) 

below: 

 

Figure 3.7 (a) – Spelling and Grammar Check Facility 

You can check all spellings and grammar in a document with a single 

action using the Spellings & Grammar button in the Proofing group on the 

Review tab or by pressing keyboard shortcut F7.  
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When a possible error is detected, Word displays the Spelling and 

Grammar on Task Pan to show you error and suggest a correction. Use the 

Change button in the Spellings and Grammar dialog box to correct an error, 

or use the Change All button to correct all instances of the same error. You 

can ignore the action on any errored word by using Ignore or Ignore All 

options. By clicking the Add button, you can add your word to dictionary.  

 
Figure 3.7 (b) – Spelling and Grammar Check 

3.8 - PARAGRAPH ALIGNMENT 

Text alignment is a word processing software feature that allows users 

to horizontally align text on a document. Paragraphs are aligned relative to the 

left and right margins in a document. 

It enables the composition of a text document using different text 

positioning on the whole or selected part of a page. By default, text is left-

aligned. Different alignments can be used by alignment buttons in the 

Paragraph group. You can right-align, center-align and justify a paragraph 

as well. 

The paragraph alignment commands can be accessed by selecting the 

Paragraph Group in Home Tab as shown below in figure 3.8. 

 
Figure 3.8 – Paragraph Alignment 
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Different paragraph alignment tools with their shortcut keys are 

described below in table.  

Alignment Option Shortcut Key Description 

Align Left Ctrl + L 
The default margin placement for 

normal text that is aligned on the left. 

Align Right Ctrl + R 

Text is aligned at the right margin 

and text lines show a ragged left 

edge. 

Center Ctrl + E 

The text is centered between the left 

and right margins of the page (with 

both margins having irregular edges). 

Justify Ctrl + J 

The text is paced irregularly across 

each line so both the left and the 

right margins are straight edged and 

uniform  

3.9 - INSERTING PAGE NUMBERS, SYMBOLS, 

TEXT BOX & PICTURE IN THE DOCUMENT 

3.9.1 - ADDING PAGE NUMBERS 

 On the Insert tab, in the Header & Footer group, click Page 

Number(figure 3.9.1) 

 
Figure 3.9.1 – Inserting Page Numbers 

 Click Top of Page, Bottom of Page, or Page Margins, depending on 

where you want page numbers to appear in your document 

 Choose a page number design from the gallery of designs. 

3.9.2 – ADDING SYMBOLS 

1. Click where you want to insert the symbol. 
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2. On the Insert tab, in the Symbols group, click Symbol. 

3. Do one of the following: 

o Click the symbol that you want in the drop-down list. 

o If the symbol that you want to insert is not in the list, click More 

Symbols. In the Font box, click the font that you want, click the 

symbol that you want to insert, and then click Insert. 

3.9.3 – ADDING TEXT BOX 

Text boxes are block of text in your 

document that can place anywhere in the document. To insert text box, follow 

these steps: 

1. Click on the Insert tab, in the Text group, click Text Box then 

click Draw Text Box.  

2. Click in the document, and then drag to draw the text box the size that 

you want. 

3. To add text to a text box, click inside the text box and then type or paste 

text. 

NOTE: 

 To position the text box, click it, and then when the pointer becomes 

a , drag the text box to a new location.

 
Figure 3.9.3 – Inserting Textbox 

3.9.4 – ADDING PICTURE 

 You can make Word documents more colorful and readable by adding 

pictures within text. It’s great fun to add life to your pages when you add 

Figure 3.9.2 – Inserting 

Symbols 
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different graphics by using pictures, clip art, drawings, and more. To insert 

pictures, do following 

1. Click the Insert tab, and then click the Picture tool in the Illustrations 

group. 

 

Figure 3.9.4 (a) – Inserting Picture 

2. The Insert Picture Window (below) appears. Now locate a saved picture 

on a device or in your file space. Select the picture you require by 

clicking on it and then click on Insert. 

 

Figure 3.9.4 (b) – Insert Picture Dialog Box  
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3.10 - USE THE DIFFERENT FORMATTING 

COMMANDS 

3.10.1 - DROP CAP 

A drop cap refers to an initial letter in a paragraph that has been 

formatted with large font size. Word also places the letter inside its own 

frame, which enables the letter to display either in the top left corner of the 

paragraph or in the margin. 

To apply the drop cap, follow these steps: 

1. Click inside the paragraph where you want the drop cap to display 

2. Select the Insert Tab then select Drop Cap command from Text 

Group as shown in Figure 3.10.1. 

3. Click the small arrow to open Drop Cap options (None, Dropped and 

In Margin)  

4. Click to apply either Dropped or In Margin 

 

Figure 3.10.1 – Drop Cap  

3.10.2 – CHANGE CASE 

Change Case are used to change text case from upper to lower, lower 

to upper, and everything in between. For example, you want a sentence you 

just typed in your Word document to be a title with every word capitalized.  
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Follow these steps: 

1. Select the sentence. 

2. Under the Home tab, click the Change 

Case command in the Font group.  

3. Select Capitalize Each Word. 

4. Click the small arrow of Change Case Tool 

to select from different categories 

   OR 

1. Select the sentence or text 

2. Press SHIFT + F3 shortcut key (Every time you will use this shortcut 

key, replaces your text in different case) 

3.10.3 – BULLETS & NUMBERING 

Bullets and Numbering are used to make lists. Numbered lists are 

used to show a sequence of information. A bulleted list might be better if 

there is no priority or sequence among the list items. Lists can be single-level 

or multilevel. 

Create a Bulleted List 

1. Click where you want to create a bulleted list. 

2. Click the Home tab. 

3. Click the Bullets button arrow, and then select a bullet style. 

4. Type the first item in your list, and then press Enter. 

5. Type the next item in your list, and then press Enter. 

6. Click the Bullets button, or press Enter again to end the list. 

Create a Numbered List 

1. Click where you want to create a numbered list. 

2. Click the Home tab. 

3. Click the Numbering button arrow, and then select a numbering style. 

4. Type the first item in your list, and then press Enter. 

5. Type the next item in your list, and then press Enter. 

6. Click the Numbering button, or press Enter again to end the list. 

3.10.4 – BORDER & SHADING 

Borders are lines that you can add to the top, bottom, left, or right of 

paragraph. Borders make paragraphs stand out and are great for emphasizing 

headings. Using Shading, selected text’s background can be filled with 

different color and patterns.  

Figure 3.10.2 - Change Case 
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Follow these steps to apply borders and shading 

1. From the Ribbon, select the Home tab, within the Paragraph section, 

the Shading and Border options are available as shown in Figure. 

2. Select the paragraph(s) to which you want to add shading and/or border. 

3. To add border, click BORDERS  then select the desired border 

option from list. 

4. To add shading, click SHADING  then select the desired shading 

option from list. 

 

Figure 3.10.4 – Border & Shading 

3.11 - TABLE INSERTING AND ITSEDITING 

3.11.1 – PROCEDURE TO CREATE TABLE 

A table is a means of arranging data 

in rows and columns. The intersection of 

rows and columns forms cells. A cell is the 

unit of table to enter data. It’s often easier 

to read or present information in table 

format than in paragraph format. Using MS 

Word’s table, you can insert text and 

pictures etc. into the table’s cells. 

There are two procedures to insert 

table, by selecting rows and columns and 

using Insert Table dialog box.  
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1. Rows and Columns Selection Method 

1. On the Insert ribbon, Click the Table button. 

2. Drag your mouse across the white boxes. 

3. They will highlight across and down. 

4. The top bar will tell you how many rows and columns you are 

creating. 

5. Click the mouse when you have reached your desired size. 

2. Using Dialog Box Method 

1. On the Insert ribbon, Click the Table button 

2. Select Insert Table option, Insert Table dialog will open 

3. Provide Number of Columns and Number of Rows in dialog box. 

4. You can set AutoFit behavior of table by selecting one choice 

(optional) 

5. Click on OK button to create your desired table 

3.11.2 – PROCEDURE TO MODIFY A TABLE 

To Insert a Row: 

1. Position the cursor in the table where you want to insert a row 

2. Select the Layout tab on the Ribbon 

3. Click either the Insert Row Above or the Insert Row Below button in 

the Rows & Columns group 

 

To Insert a Column 

1. Position the cursor in the table where you want to insert a column 

2. Select the Layout tab on the Ribbon 

3. Click either the Insert Columns to Left button or the Insert Columns 

to Right button in the Rows & Columns group 

To Delete a Row 

1. Position your cursor in the row that you would like to delete 

2. Select the Layout tab on the Ribbon 

3. Click the Delete button in the Rows & Column group 

4. Select Delete Rows 

To Delete a Column 

1. Position your cursor in the column that you would like to delete 

2. Select the Layout tab on the Ribbon 

3. Click the Delete button in the Rows & Column group 
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4. Select Delete Columns  
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3.12 - PRINTING THE DOCUMENT 

After completion, a document can be printed as well. For printing a 

document following method is used. 

1. Click the File Menu and select 

the Print command from menu 

OR Press Ctrl + P keyboard 

shortcut. The Print dialog box 

will appear as shown in figure. 

2. Click the Name field to select 

your preferred printer (if more 

than 1 printer). 

3. In Page Range area, select 

one of following options 

 All: to print all pages in 

document 

 Current Page: to print 

only what you see on 

current screen. 

 Pages: to print part of 

document. For example, 

type 3-6 to print only pages 3 through 6 OR to print non-sequential 

pages like 2, 5, 9, 14 etc.  

 Selection: to print only highlighted text or graphics. 

4. Enter the required number of copies in the Number of Copies field. 

5. If you want to print more than one page per sheet, then select the 

required number in the Pages per Sheet field. 

6. Click OK to get printouts or hardcopies.   

Figure 3.12 – Print Dialog Box 
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3.13 - SAVING A DOCUMENT FILE AS PDF 

FORMAT 

The Portable Document Format (PDF) is a file format used to present 

documents in a manner independent of application software, hardware, and 

operating systems.  

NOTE: The PDF add-in does not come as standard. You have to download 

and install it from Microsoft website.  

To save your file as PDF format, follow these steps: 

1. Click the File Menu then click on Save As, and then click PDF or 

XPS. The dialog box Publish as PDF and XPS will open as shown in 

Figure 3.13. 

 
Figure 3.13 – Publish as PDF or XPS Dialog Box 

2. Follow all the normal processes to select a save location, file name and 

file type. 

3. Select whether you are publishing to print or web.  

4. You can select page range, document content, non-printing 

information and PDF options by clicking Options. Click Ok to accept 

changes. 
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5. Click Save to complete. This will take some moments. 

EXERCISE 

Short Questions 

1. Define the Microsoft Office. 

MS. Office is one of the most popular application software. It is a 

complete office suite with various software programs like MS Word, MS 

Excel, MS Power Point etc. It provides different functions which are normally 

used in Office working. 

2. Enlist some MS office applications  

1. Microsoft Word 

2. Microsoft Access 

3. Microsoft Excel 

4. Microsoft PowerPoint 

5. Microsoft OneNote 

6. Microsoft Outlook 

3. Define the Word processor. 

A word processor is application software that performs various tasks 

like formatting text, printing text, page setup, composing document etc.  

4. Enlist some well-liked word processors. 

1. Microsoft Word 

2. Word Pro 

3. Word Perfect 

4. Word Star  

5. Define the Microsoft Word. 

Microsoft Word is one of the most popular software programs in the 

world, used by millions of the people around the world. There are various 

features to create, read and edit documents. 

6. What is the File Menu?  

 The File Menu contained commonly known commands related to file 

such as New, Open, Save, Close, Print and Recent Documents. 

7. Define the Ribbon of MS Word? 

The Ribbon replaces the menus and toolbars in previous versions. The 

Ribbon shows most of the features that were hidden in File menus. The 

Ribbon makes it easier to see and find commands to format your document.   
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8. Define the Quick Access Toolbar of MS Word? 

A customizable toolbar at the top of an active document. By default, 

the Quick Access Toolbar displays the Save, Undo, and Repeat commands.  

9. Define the Title bar? 

The title bar is horizontal bar at the top of an active document. This 

bar displays the name of the document and application. 

10. Define the document area. 

The white space framed between rulers and the scroll bars looking like 

a blank sheet of paper. This is the area where you type the text of the 

document. 

11. Define the cursor. 

The blinking vertical line in the document area is called cursor or 

insertion point. The typed characters appear at its location. 

12. Define the ruler. 

The ruler is a measurement tool used with MS Word that allows the 

program's user to align graphics, text, tables, or other elements on a page. 

13. Define the scroll bar. 

Scrollbar is used to display different portions of a document in the 

document windows. There are two types of scrollbar, horizontal and vertical. 

14. Define the window control buttons. 

These three control buttons provide quick and basic functions for 

manipulating each Window currently visible. The first "dash" button will 

minimize the window. The middle button will cause the window maximize or 

will return the window to its original size. The last "X" button will close the 

window. 

15. Define the zoom slider. 

The buttons that magnifies or reduces the contents in the document 

window 

16. What is shortcut key to access File Menu? 

 Alt + F is the keyboard shortcut to access the File Menu. 

17. What command is used to create new file in MS Word? 

 Click on File Menu >> NEW, used to create new file in MS word.  

18. What is keyboard shortcut to create new file? 

 Ctrl + N is keyboard shortcut to create new file.  
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19. Which file template is mostly used when new word file is created? 

 The Blank Document template is mostly used when new word file is 

created. 

20. Why documents are necessary to save? 

 If you want to use documents in future, it is necessary to save them.     

21. Which command is used to save a word file? 

 The SAVE command is used to save a file in MS word. 

22. What is difference between SAVE and SAVE As command? 

 The Save command is normally used to save a document for the first 

time or to save changes. On the other hand, Save As command is used to save 

a previously saved document with different name. 

23. What is procedure to save file in MS Word? 

To save a document follow one of these methods: 

Press Ctrl + S from keyboard.  

OR  

Press Alt + F to open File menu then select Save or Save As 

command. 

OR 

Click the Save icon on the Quick Access Toolbar.  

  

A dialog box appears, in which select location where you want to save, 

then type name of document and Click on SAVE button.  

24. Which command is used to open an existing word file? 

 The OPEN command is used to open an existing word file. 

25. Why already saved files opened? 

 Already saved files can be opened to read, edit or reprint them. 

26. What is the procedure to open your word files? 

 To open already existing document, follow one of these methods: 

Press Ctrl + O from keyboard.  

OR  

Press Alt + F to open File menu then select OPEN command. 

OR 

Click the OPEN icon on the Quick Access Toolbar.  

 A dialog box appears, in which select location where your document 

exists, then select name of document and Click on OPEN button.   
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27. What is text editing? 

Text editing is the ability to change text by adding, deleting and 

rearranging letters, words, sentences and paragraphs. 

28. When text selection is needed? 

Text selection is normally used for text formatting. 

29. What is shortcut to select whole document? 

 Ctrl + A is the shortcut to select whole document. 

30. What is the method to select text? 

By pressing SHIFT and ARROW keys from keyboard you can select 

text. By dragging the mouse text can be selected by mouse.  

31. Which keys are used to erase text character by character? 

 The BACKSPACE and DELETE keys are used to erase text character 

by character. 

32. Define the clipboard. 

A clipboard is a temporary storage for data that the user wants to copy 

from one place to another. For example, you might want to cut text from one 

part of a document and paste it in another part or somewhere else. When you 

will select the text and then cut or copy that text, it stores in clipboard for 

further use. 

33. What is the shortcut key for Cut, copy and paste command? 

 CTRL + X is the keyboard shortcut for cut command. 

 CTRL + C is the keyboard shortcut for copy command. 

 CTRL + V is the keyboard shortcut for paste command. 

34. What is the shortcut key for Undo and Redo command? 

 CTRL + Z is the keyboard shortcut for copy command. 

 CTRL + Y is the keyboard shortcut for redo command.  

35. What is difference between CUT and COPY command? 

 When we use Cut command, selected data removes from original 

location. On the other hand, in Copy command data remains present in its 

actual location.   
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36. Define the Undo command. 

This command undoes previous actions allowing you to recover from 

mistakes as though they never happened. 

37. Define the Redo command. 

Redo command is used to revert the effects of the undo command. 

38. Define the Repeat command. 

The Repeat command is highly versatile, labor-saving feature which 

repeats the most recent action taken, not including selecting text, scrolling, or 

repositioning the insertion point. We usually use it to repeat typing or 

formatting. 

39. What is keyboard shortcut for Repeat command? 

 F4 is keyboard shortcut for Repeat command. 

40. Define the text formatting in MS Word? 

In Microsoft Word formatting can be applied to make the document 

more presentable and interesting. Format means the way a document looks or 

appears. When we format the text its means we actually change the default 

formatting into our desired formatting. 

41. What are keyboard shortcuts for bold, italic and underline? 

  Bold   CTRL + B 

 Italic   CTRL + I 

            Underline  CTRL + U  

42. What are keyboard shortcuts for font size to increase and decrease? 

CTRL + [      to decrease the font size       

CTRL + ]      to increase the font size 

43. What kind of working can be done during text formatting? 

During the text formatting, you can change font, font style, font color, 

font size of the text, text highlighting using bold, italic and underline etc.  

44. What kind of paragraph alignment can be applied? 

There are four types of paragraph alignment 

1. Left Align   3. Center Align 

2. Right Align   4. Justify  
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45. What are keyboard shortcuts for paragraph alignments? 

1. Align Left  CTRL + L 

2. Align Right  CTRL + R 

3. Centered   CTRL + E 

4. Justify    CTRL + J 

46. Define the Drop Cap. 

A drop cap is a large capital letter used as a decorative element at the 

beginning of a paragraph or section. The size of drop cap is usually two or 

more lines of regular text. It is used to add an artistic touch in word 

documents, such as stories and articles.  

47. How the drop cap can be inserted? 

To apply the drop cap follow these steps 

1. Click inside the paragraph where you want the drop cap to display. 

2. Select the Insert Tab then select Drop Cap command from Text Group. 

3. Click the small arrow to open Drop Cap options (None, Dropped and 

In Margin)  

4. Click to apply either Dropped or In Margin  

48. What is the purpose of Change Case? 

Change Case are used to change text case from upper to lower, lower 

to upper, and everything in between. 

49. What are change case choices in MS Word? 

There are five change case choices as following 

1. Sentence Case 

2. Lower Case 

3. Upper Case 

4. Capitalize Each Word 

5. Toggle Case 

50. Why bullets & numbering are used? 

Bullets and Numbering are used to make lists, the numbered lists and 

the bulleted lists.  



COMP-162 COMPUTER APPLICATIONS 

 

 
137 | P a g e  

 

51. What is difference between numbered and bulleted lists? 

Numbered lists are used to show a sequence of information. A bulleted 

list might be better if there is no priority or sequence among the list items. 

52. Define the Borders & Shading toolbar. 

The Borders and Shading toolbar allows you to customize the border. 

This includes the type, style, color, weight, shading, and background color. 

Using Shading, background of selected text can be filled with different color 

and patterns. 

53. Define the Spelling and Grammar check feature of MS Word. 

Spelling and Grammar check is a decent feature which is used to find 

spelling and grammar mistakes, and also provide facility to correct them.  

54. How the Spellings and Grammar check feature works?  

MS Word automatically identifies misspelled words. It also finds 

grammar errors and underlines them as follows. 

 A red underline below spelling errors. 

 A green underline below grammar errors. 

 A blue line under correctly spelled but misused words. 

55. What is shortcut key to access Spelling and Grammar feature? 

F7 is the keyboard shortcut to access the Spelling and Grammar 

feature. 

56. Differentiate between Header & Footer. 

 The header is a section (blank space) that appears in the top margin, 

while the footer is a section (blank space) that appears in the bottom margin.  

57. What is the purpose of using Header & Footer? 

 Header & Footer generally contains important information such as 

page numbers, date, time, author name, publisher name, chapter name, book 

name, and document name etc. 

58. How to insert a table? 

Following steps are used to insert a table: 

 Click on Insert Tab, then click the Table button  

 Drag your mouse across the white boxes. 

 They will highlight across and down. 

 The top bar will tell you how many rows and columns you are creating. 

 Click the mouse when you have reached your desired size.  
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59. How to insert page numbers in a document?  

Procedure: 

 On the Insert tab, in the Header & Footer group, click Page Number. 

 Click Top of Page, Bottom of Page, or Page Margins, depending on 

where you want page numbers to appear in your document. 

 Choose a page number design from the gallery of designs. 

60. How to add symbols in a document? 

To add symbols do following: 

 Click in document area where you want to insert the symbol. 

 On the Insert tab, in the Symbols group, click Symbol. 

 Click the symbol that you want in the drop-down list. 

61. Define the text box. 

Text boxes are block of text in your document that can place anywhere 

in the document. 

62. How to insert text box? 

Procedure: 

 On the Insert tab, in the Text group, click Text Box then click Draw 

Text Box. 

 Click in the document, and then drag to draw the text box. 

 To add text to a text box, click inside the text box and then type the text. 

63. Define the page setup.  

Page setup is used to set the size and layout of the page. It includes 

everything from the size, margins, page orientation, and quality of print. 

64. What are the margins in page setup? 

Margins are the white space that borders the text on the edges of a 

page. MS Word sets default margins for new documents, but you can change 

them to fit your document requirements. 

65. What is page orientation? 

 Page orientation is the direction in which a document is displayed or 

printed. There are two types of orientation. These are portrait and landscape.  

66. Define the Print Preview. 

 Print preview is a function provided for displaying a page, document 

or any other material before it is sent to a printer. Print preview is a useful 

function to users as it helps them to see how the final printed material will 

appear.  
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67. What is keyboard shortcut for print command? 

CTRL + P is the keyboard shortcut for print command. 

68. Shortly describe the Page Range options of Print dialog box. 

Here is Page Range options with short description 

 All: To print all pages in document 

 Current Page: To print only what you see on current screen. 

 Pages: To print part of document. For example, type 3-6 to print only 

pages 3 through 6. 

 Selection: To print only highlighted text or graphics. 

69. Why we choose the printer name in Print dialog box? 

If more than one printers are attached with the computer or network 

then Name of preferred printer must be selected. 

70. Define the PDF.  

The Portable Document Format (PDF) is a file format used to present 

documents in a manner independent of application software, hardware, & OS. 

71. Write the procedure to make PDF file in MS Word 

 Click the File Menu    Save As   PDF or XPS  the dialog box 

appears  

In the dialog box provide following information: 

 File name 

 Location to save 

 File Type (as PDF) 

 Click Publish  
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E X E R C I S E 

M u l t i p l e  C h o i c e s   

Q u e s t i o n s  

 

1. Microsoft Office is an office _______________ of business applications.  

    a. suite  b. building c. component  d. none of these 

2. Microsoft Word is a _______________ Program. 

    a. Spreadsheet b. Word Processing c. Presentation               d. 

database 

3. What is included in Microsoft Office? 

    a. Word                    b. Excel c. PowerPoint    d. all of these   

4. Example of Word Processor program ________________. 

    a. MS Word  b. Word Pro c. Word Perfect  d. all of above 

5. Microsoft Word software is type of _______________ software. 

    a. system              b. application              c. firmware            d. none of these  

6. Microsoft Word is used to ______________ the text in a document. 

    a. write/type                   b. edit                   c. format                  d. all of these 

7. The Ribbon in MS Word contains _______________. 

    a. scattered commands                                   b. groups of commands          

    c. toolbars                                                       d. none of these 

8. The bar at the top of MS Word screen which shows software name and file  

    name is _______________. 

    a. Title bar               b. Status bar               c. Ruler                     d. Scroll bar 

9. The toolbar at the top that contains frequently used commands such as  

    Save, Undo, Redo etc is _________________. 

    a. Title bar            b. Quick Access Toolbar                       

    c. Status bar                d. Scroll bar  

10. The horizontal bar at the bottom that provides page numbers, total written  

       words etc about the active document is ________________.  

       a. Quick Access Toolbar                   b. Menu bar                      

       c. Status bar                       d. toolbar   

11. A button that magnifies or reduces the contents in the document window is   

      ____________. 

      a. zoom slider                              b. magnifier                             
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      c. view bar                           d. none of above 

12. The document can be zoomed maximum up to ________________. 

      a. 100 %                    b. 200 %                     c. 400 %                     d. 500 %       

13. The white space framed between rulers and scroll bars looks like a blank  

      sheet is ______________. 

      a. White space                     b. document area                      

      c. application area                d. page area 

14. The blinking vertical line in the document area, where the typed character  

       appears is called  _______________. 

      a. line                        b. I beam                      

      c. cursor                           d. pointer  

15. The _____________ is a measurement tool for the page in MS Word and  

       allows the user to align graphics, text, tables.    

      a. Insertion point                        b. Ruler bar                         c. Scroll bar                       

      d. none of above 

16. The _____________ is used to display different portions of a document. 

      a. Scroll bar                             b. Ruler bar                             c. Status bar                  

      d. none of above 

17. The keyboard shortcut to open the help window for MS Word program  

      ________________. 

      a. F1                           b. F2                            c. F7                            d. F5 

18. A toolbar that displays, and enables different views of a document’s  

      content.  

      a. Quick Access Toolbar                                          b. View Toolbar                          

      c. Window control bar                                             d. none of these  

19. The _______________ key is used to open File menu. 

      a. Ctrl + F                              b. window                             c. Alt + F                      

      d. Shift + F 

20. Which option in Office menu is used to close a file in MS Word? 

      a. New                      b. Quit                      c. Close                      d. Exit 

21. The ______________ shortcut key is used to create new file in MS Word. 

      a. Ctrl + O              b. Ctrl + N                 c. Ctrl + S                  d. Ctrl + M 

22. The ______________ shortcut key is used to save a file in MS Word. 

      a. Ctrl + O                b. Ctrl + N                c. Ctrl + S                  d. Ctrl + M  
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23. To save previously saved document with different name, different location  

      and different type the ______________ command is used.  

      a. Save As                b. Save                   c. Save To                  d. Save With 

24. The default extension for saving of MS Word file is _____________.   

      a. docx                  b. txt                       c. word                     d. none of these  

25. We specify the save details of our file in the ____________ dialog box. 

      a. Save               b. Save As                     c. Save To                     d. Save In  

26. The __________________ shortcut key is used to open an existing file in  

       MS Word. 

      a. Ctrl + O                    b. Ctrl + P                  

      c. Ctrl + S                    d. Ctrl + M 

27.  Editing of text in a document means ________________. 

      a. adding text                   b. removing text               

      c. copying & moving text              d. all of these 

28. Selecting text means, selecting? 

      a. A word                          b. A sentence                         c. Whole document                     

      d. all of these 

29. To select a portion of text in a document by keyboard the______________  

      keys used.  

      a. Shift + S                         b. Shift + Arrow                        c. Ctrl + Arrow                        

      d. Ctrl + A 

30. To select the whole Word document the ______________ shortcut is used. 

      a. Ctrl + A                              b. Shift + A                             c. Ctrl + End                         

      d. Ctrl + Home 

31. The most widely used way to select the text using mouse is ___________. 

      a. Click                              b. Double Click                              c. Dragging                         

      d. none of above 

32. The __________ key is used to remove characters to the left of the cursor. 

      a. Delete                           b. Backspace                           c. Ctrl + Delete                        

      d. none of above  
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33. The _________ key is used to remove characters to the right of the cursor. 

      a. Delete                           b. Backspace                            c. Ctrl + Delete                      

      d. none of these 

34. A ______________ is a temporary storage area for data that the user        

wants to cut or copy from one place to another. 

      a. clipboard                        b. master board                        c. mother board                     

      d. circuit board 

35. The keyboard shortcut for Cut command is _________________.  

      a. Ctrl + C                         b. Ctrl + V    c. Ctrl + X                          

      d. Ctrl + P 

36. The keyboard shortcut for Copy command is _________________.  

      a. Ctrl + C                  b. Ctrl + V   c. Ctrl + X 

      d. Ctrl + O 

37. The keyboard shortcut for Paste command is _________________.  

      a. Ctrl + C                b. Ctrl + V                  c. Ctrl + X                 d. Ctrl + P 

38. Which operation you will perform if you need to move a block of text? 

      a. Copy & Paste                b. Cut & Paste                 c. Move & Paste                 

      d. None of above 

39. The keyboard shortcut for Undo command is _________________.  

      a. Ctrl + C                b. Ctrl + V                c. Ctrl + X                   d. Ctrl + Z 

40. The keyboard shortcut for Redo command is _________________.  

      a. Ctrl + C                 b. Ctrl + Y                 c. Ctrl + X                 d. Ctrl + Z 

41. The keyboard shortcut for Repeat command is _________________.  

      a. F4                         b. Ctrl + Y                          c. F8                           d. F5 

42. ____________ means the appearance of text in MS Word.  

      a. editing                 b. formatting               

      c. selecting               d. none of these 

43. What is the default font used in MS Word document? 

      a. Times New Roman              b. Arial                c. Calibri                   d. txt 

44. The keyboard shortcut for Bold command is _________________.  

      a. Ctrl + B                 b. Ctrl + Y                 c. Ctrl + O                  d. Ctrl + I  
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45. The keyboard shortcut to make text Italic is _________________.  

      a. Ctrl + B                  b. Ctrl + Y                  c. Ctrl + O                d. Ctrl + I 

46. The keyboard shortcut to make text Underline is _________________.  

      a. Ctrl + B                b. Ctrl + U                   c. Ctrl + O                d. Ctrl + I 

47. The keyboard shortcut for increasing the font size is _________________.  

      a. Ctrl + ]                 b. Ctrl + )                   c. Ctrl + {                    d. Ctrl + [ 

48. The keyboard shortcut for decreasing the font size is _________________.  

      a. Ctrl + ]                   b. Ctrl + )                   c. Ctrl + {                  d. Ctrl + [ 

49. What is the smallest and largest font size available in Font Size tool? 

      a. 8 and 72                   b. 10 and 72                

      c. 8 and 48                 d. 12 and 92 

50. Ctrl + B shortcut is used to _______________ the text. 

      a. bold                       b. select                       c. Italic                       d. border 

51. In MS-Word header & footer will display by default.  

      a. on first page                       b. every page                         c. even page           

      d. none of above 

52. Ctrl + L shortcut is used for _________________. 

      a. Right Align                         b. Left Align                         c. Center Align                

      d. Justify 

53. Ctrl + R shortcut is used for _________________. 

      a. Right Align                       b. Left Align                        c. Center Align                

      d. Justify 

54. Ctrl + E shortcut is used for _________________. 

      a. Right Align                         b. Left Align                          c. Center Align                

      d. Justify 

55. Ctrl + J shortcut is used for _________________. 

      a. Right Align                         b. Left Align                          c. Center Align                

      d. Justify 

56. By default text is _____________ aligned. 

      a. right                       b. left                      c. justify                      d. centered    
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57. Which items are places at the end of a document?  

      a. Footer                     b. End Note 

      c. Foot Note    d. Header  

58. The page number can be inserted at _______________. 

      a. Header                             b. Footer                              c. Both a and b             

      d. None of above 

59. To make the lists the ______________ are used. 

      a. Bullets                             b. Numbers                             c. Both a and b                 

      d. None of these 

60. Bullets contain the ______________. 

      a. digits                      b. symbols                        c. text                     d. None 

61. An initial letter in a paragraph that has been formatted with large font size  

      is ____________. 

      a. Upper Cap            b. Drop Cap             c. Fall Cap               d. Smart Cap 

62. What is the default number of lines to drop for drop cap? 

      a. 3                           b. 10                            c. 15                              d. 20   

63. What is the maximum number of lines you can set for a drop cap? 

      a. 3                             b. 10                              c. 15                             d. 20 

64. The shortcut key for single line space is _______________. 

      a. Ctrl + 1                             b. Ctrl + 2                             c. Ctrl + 3                    

      d. Ctrl + 5 

65. The shortcut key for double line space is _______________. 

      a. Ctrl + 1                              b. Ctrl + 2                            c. Ctrl + 3                        

      d. Ctrl + 5 

66. The shortcut key for 1.5 line space is _________________. 

      a. Ctrl + 1                               b. Ctrl + 2                            c. Ctrl + 3                        

      d. Ctrl + 5 

67. _______________ are used to make lists. 

      a. Borders & Shading          b. Bullets & Numbering          c. Copy & Paste         

      d. Find & Replace    
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68. _______________ lists are used to show a sequence of information.  

      a. Numbered                          b. Sequential                          c. Bulleted                     

      d. Random  

69. ______________ lists are used to show information when there is no  

      priority among the list items.  

      a. Numbered                         b. Sequential                          c. Bulleted                     

      d. Random  

70. Borders can be applied to _______________. 

      a. words                                   b. sentences                         c. paragraphs                     

      d. all of above 

71. MS Word underline the words that might be misspelled with a ________ 

underline. 

      a. yellow                     b. orange                       c. red                       d. green 

72. MS Word underline the words with a wavy _____________ underline for  

      grammatical error.  

      a. yellow                      b. orange                      c. red                        d. green 

73. Which shortcut key is used to spell check in MS Word? 

      a. F1                         b. F5                          c. F7                          d. F9 

74. In a table data is arranged in ________________. 

      a. rows              b. columns              c. both a & b              d. none of above 

75. A ______________ is unit of table to enter data. 

      a. cell                    b. row                    c. column                   d. none of these 

76. The minimum number of rows and columns a word table can have is ____ 

      a. zero                                                  b. 2 rows and 1 column           

      c. 2 rows and 2 column                       d. 1 row and 1 column 

77. ______________ is an on-screen rectangular frame into which you type  

      text and place it anywhere in the word document. 

      a. picture box              b. text box                c. table              d. none of these 

78. ______________ are the white space that borders the text on the edges of  

      a page. 

      a. margins             b. orientaion             c. page size             d. none of these  
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79. Which of the following is not a type of page margin? 

      a. right                        b. center                         c. left                           d. top 

80. Portrait and Landscape are ____________________. 

     a. Paper size                         b. Page Orientation                       

     c. Page Layout                    d. page margins 

81. Default page orientation of MS Word is _________________. 

      a. portrait                    b. landscape                  

      c. wide                     d. all of these 

82. Print preview feature is used ______________ printing. 

        a. after                                    b. behind                                  c. before                                 

        d. none of these 

83. The shortcut key for print command is ________________. 

        a. Ctrl + T                 b. Ctrl + P                 c. Ctrl + Z                d. Ctrl + Q 

84. PDF stands for _________________. 

        a. Program Data File                          b. Portable document Format                 

        c. Personal Data File                          d. None of above 

85. The ____________is a file format used to present documents in a manner  

         independent of application software, hardware, and operating systems. 

        a. PDF                     b. DWG                     c. JPG                         d. DOCX  

86. Which of the following shortcut key is used to display the help about MS  

        Word? 

         a. F1                           b. F2                         c. F5                            d. F7 

 

A N S W E R S K E Y  

1 a 23 a 45 d 67 b 

2 b 24 a 46 b 68 a 

3 d 25 b 47 a 69 c 

4 d 26 a 48 d 70 d 

5 b 27 d 49 a 71 c 

6 d 28 d 50 a 72 d 

7 b 29 b 51 b 73 c 

  



COMP-162 COMPUTER APPLICATIONS 

 

 
148 | P a g e  

 

8 a 30 a 52 b 74 c 

9 b 31 c 53 a 75 a 

10 c 32 b 54 c 76 d 

11 a 33 a 55 d 77 b 

12 d 34 a 56 b 78 a 

13 b 35 c 57 b 79 b 

14 c 36 a 58 c 80 b 

15 b 37 b 59 c 81 a 

16 a 38 b 60 b 82 c 

17 A 39 d 61 b 83 b 

18 b 40 b 62 a 84 b 

19 c 41 a 63 b 85 a 

20 c 42 b 64 a 86 a 

21 b 43 c 65 b   

22 c 44 a 66 d   

 

L o n g  Q u e s t i o n s  

 1: Write a brief note on user interface of MS Word. 

 2: Write the method to create, save, open and close a document in MS Word. 

 3: How to select text in MS Word by using keyboard and mouse? 

 4: Explain the editing of text in MS Word. 

 5: What is the method to add and remove text from MS Word? 

 6: Differentiate between: 

1. Save & Save As                   

2. Cut & Paste                    

3. Copy & Paste 

4. Undo & Redo 

 7: Illustrate the formatting of text in MS Word. 

 8: Write method to format text using Font group for following 

1. Font 

2. Font Size 

3. Font Style (Bold, Italic, Underline) 

4. Font Color 

 9: Explain all Change Case options used in MS Word. 

 10: Explain paragraph formatting including alignment and spacing? 
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 11: Write a short note on following: 

1. Drop Cap 

2. Border & Shading 

3. Change Case 

 12: How to make different lists in MS Word using Bullets & Numbering? 

 13: How you can review your word document using spellings & grammar 

check? 

 14: How you can insert and modify table in MS Word? 

 15: Write a short note on following: 

i. Adding Page Numbers 

ii. Adding Symbols 

iii. Adding Text Box 

iv. Adding Pictures 

 16: Write the procedure to setup your document page for printing  

             (Settings of margins and page size) 

 17: Explain the method to print a word document. 

 18: Illustrate the Print dialog box. 

 19: What is difference between text editing and formatting? 

 20: What is the procedure to save a document in PDF format? 
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C H A P T E R  4  

M i c r o s o f t  E x c e l  

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of Microsoft Excel. 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 

 Learn about MS-Excel & its Screen 

  Enter data & apply formulas in worksheet 

 Edit & Format the Cells, Row & Colum 

 Insert Graphs in sheet 

 Work on Page setup, Print Preview & Printing 

 Work on different types & Categories of Charts 

  



COMP-162 COMPUTER APPLICATIONS 

 

 
151 | P a g e  

 

4.1 - INTRODUCTION TO MS-EXCEL & ITS 

SCREEN 

4.1.1 - INTRODUCTION TO MS EXCEL 

Spreadsheet is application software that contains rows and columns. 

Usually it is used to record and compare numerical and financial data. 

Spreadsheet can be used in any field that works with numbers.  

MS Excel is one of the most popular spreadsheet software used to 

organize, calculate, and analyze data. Collections of worksheets are available 

in workbooks which are used to enter and manipulate data by using formulas and 

functions. Each worksheet is named Sheet1, Sheet2, and Sheet3 respectively, 

but custom names can also be given to the work sheets. An Excel worksheet 

consists of a grid of columns and rows forming cells.  

There are some very important features which are discussed here. 

Rows and Columns: 

 Spreadsheet is collection of rows and columns. Rows are identified by 

numbers like 1 , 2  , 3 and columns are identified  by letters such as A, B, C 

and so on. The cell name is combination of a letter and a number. Such as A4 

is fourth cell in first column. Cell name is also called cell address. 

Formula and functions: 

 Formulas are used to calculate data. In order to create a formula, start a 

calculation with = sign. Simply type the calculation into the cell or formula 

bar and when you press  Enter the answer will be displayed on that Cell.  

 Functions are used to evaluate values and to perform different kinds of 

operations.  

Text manipulation: 

 Excel also provides commands for text manipulations.  

Printing Options: 

 To get hard copy of prepared sheet, we can use printing features.  

Formatting: 

Traditional text & numeric formatting can be done easily in Excel.  
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Auto fills: 

Cells can be automatically filled with text or numeric series. 

Sorting: 

Data can be arranged in particular order through sorting. 

Filter: 

Required data based on some criteria can be displayed. 

Charts: 

Data can be shown graphically using charts. 

 

PROCEDURE FOR STARTING / EXITING MS EXCEL 

Starting Excel 

If you have an icon on the desktop for Excel, then double-click it to 

open Excel. 

OR 

Click Start  (All) Programs  Microsoft Office Excel (Figure 4.1) 

 
Figure 4.1.1 – Starting MS Excel 

 

Exiting Excel 

1. Close Excel by clicking the X on the far right of the title bar.     OR 

2. Click File Menu  Click Exit Excel in command list.     OR 

3. Press [Alt] + [F4] from keyboard to directly exit from Microsoft 

Excel.  
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4.1.2 – UNDERSTANDING THE MS EXCEL SCREEN  

When a Excel starts, the window that is displayed on the compuer 

screen is called interface of the program. Figure 4.1.2 shows interface of 

Excel with different parts.  

 

 
                                       Figure 4.1.2(a) – Screen Elements of Excel 

File Menu 

By clicking File Menu, you will see many commonly used options like 

New, Open, Save, Print, etc. You can open this menu by clicking it or by 

pressing (ALT + F). 

Quick Access Toolbar (QAT)  

The Quick Access Toolbar is a toolbar that provides quick access to 

the commands represented by the buttons you put on it. If you use an Excel 

command frequently, you can add it to the Quick Access Toolbar. 

You can even add commands to the Quick Access Toolbar that are not 

in the ribbon. By default, the Quick Access Toolbar contains the Save, Undo 

and Redo buttons. 

 
  Figure 4.1.2(b)  – Quick Access Toolbar 
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The Ribbon 

The Ribbon consists of tabs, groups, and command. Each tab contains 

a collection of groups, and each group contains related commnads. Each tab of 

the Ribbon contains a different set of controls that are linked together.  

 
  Figure 4.1.2 (c) – Ribbon 

Title Bar 

Next to the Quick Access toolbar is the Title bar as shown below. On 

the Title bar, Microsoft Excel displays the name of the workbook you are 

currently using. At the top of the Excel window, you should see "Microsoft 

Excel - Book1" or a similar name. 

 
  Figure 4.1.2 (d) – Title Bar 

Name Box  

The Name Box as shown in figure below is the box to the left of the 

formula bar that displays the cell name that is currently selected in the 

spreadsheet. Usually a cell name is combination of column name and row 

number. 

 
  Figure 4.1.2 (e) – Name Box 

The Formula Bar 

The formula bar is a section in Microsoft Excel that shows the contents 

of the current cell and allows you to create and view formulas. The Figure 

below is example of what the formula bar looks like in Microsoft Excel. To 

start creating a formula, click the mouse cursor in the formula bar and enter an 

equal sign (=). In the below example, we're using the =SUM, which is telling 

Excel to add cells from A2 to A5. 

 
Figure 4.1.2 (f) – Formula Bar  

http://www.computerhope.com/jargon/c/cell.htm
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Row Headings and Column Headings 

The row headings are the numbers at the left side of the screen that 

identify each row by number. The column heading are the letters across the 

top of the worksheet grid that identify each column by one or more letters.  

 

Figure 4.1.2 (g) – Row and Column Heading 

The Cells 

The main working area of Microsoft Excel consists of cells. A cell is 

the intersection of a column and a row. A cell is identified by its name and 

every cell has a unique name in a worksheet.  

Active Cell 

The active cell is the cell in which text and numbers appear when you 

type. It has heavy or colored  border. 

Worksheet Tabs 

Each worksheet has a tab at the bottom that you can click to display 

the worksheet. The tabs in each new worksheet have standard names (Sheet1, 

Sheet2, and so on), but you can give the tabs descriptive names to help you 

easily identify your worksheets.  

 

Figure 4.1.2 (h) – Worksheet Tabs  
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New Worksheet Insertion Button 

To quickly insert a new worksheet at the end of the existing 

worksheets, click the Insert Worksheet tab at the bottom of the screen. 

Scroll Bars 

On the right side of the cells area, there is a vertical scroll bar that 

allows you to scroll up and down in case your document cannot display 

everything at a time. 

In the lower right section of the main window, there is a horizontal 

scroll bar that allows you to scroll left and right if your worksheet has more 

items than can be displayed all at once. 

Sheet View 

Click a button to change sheet view. You can change the sheet view 

into Normal view, Page layout view, and Page breakpreview view.  

Zoom Slider 

The readout at the left end of the zoom controls shows the current 

zoom percentage. You can zoom by dragging the slider or by clicking the - 

(minus) and + (plus) buttons. 

Status Bar 

The Status bar is at the bottom of the Excel spreadsheet and provides 

useful information from the Excel software. 

4.2 - ENTERING DATA & APPLYING FORMULAS 

IN WORKSHEET 

4.2.1 - DATA ENTERING IN WORKSHEET 

In MS Excel data can be entered in different manners.You can enter 

data in one cell, in several cells at the same time, or on more than one 

worksheet at once. 

The data that you enter can be numbers, text, dates, or times. 

You can format the data in a variety of ways. And, there are several 

settings to make data entry easier for the user.   
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ENTERING TEXT  

Entering text in worksheet can make your financial, statistical or 

scientific spreadsheet more meaningful, useful and easier to follow. Excel 

automatically left-aligns the alphabetic data. You can enter either values 

(numbers and dates) or labels (text) into any cell within the worksheet. 

To enter the text into cells, follow these steps. 

1. Move the cell pointer to the required cell and then type the data. While 

you type the data you will notice that it appears both in the worksheet 

(in the example below, the text appears in cell A2) and in the Formula 

Bar.  

2. Type text into the cell and press Enter to move to next cell.  

 

Figure 4.2.1 (a) – Entering Text into a Cell 

3. To enter data on a new line within a cell, enter a line break by pressing 

Alt + Enter. 

4. You can enter text by selecting many cells to merge them into single 

cell. This can be done by using “merge cells” option. 

ENTERING NUMBERS 

Numbers are mostly used for calculations and functions. A numeric cell may 

contain numbers, a decimal point (.), plus (+) or minus (-) signs, and currency 

symbol like ($). Excel automatically right-aligns the number values.  
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To enter number value, do following 

1. Click to select the cell where you want to enter numbers.  

2. Enter Units and Rate in the Cells A2 and B2 respectively.  

 

Figure 4.2.1 (b) – Entering Numeric values 

3. To accept the information, press Enter or an Arrow Key or Tab or 

you can also click the check mark on the formula bar. 

ENTERING DATES AND TIME IN A CELL 

When you enter a date or a time in a cell, it appears either in the default date 

or time format for your computer or in the format that was applied to the cell 

before you entered the date or time. The default date or time format is based 

on the date and time settings in the Regional and Language Options dialog 

box (Control Panel).  

To enter date or time, follow these steps. 

1. Click a cell in the worksheet where you want to enter date.  

2. Use a slash mark or a hyphen sign to separate the parts of a date; for 

example, type 05/09/2020 or 05-Sep-2020. 

TIP: To enter the current date and time, press CTRL+SHIFT+; 

(semicolon). 

3. If you want to get current date whenever you open the worksheet, 

there are two functions that can be used for this purpose. These 

are TODAY and NOW functions as follow in below example. 
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Figure 4.2.1 (c) – Entering Current date 

4.2.2 – APPLYING FORMULAS IN WORKSHEET 

An Excel Formula is an expression which calculates the value of a 

cell. A formula starts with an equal sign (=). 

For example, the following formula multiplies 2 by 3 and then adds 5 

to the result. 

= 5 + 2 * 3 

Formula can range from basic mathematical operations, such as 

addition, subtraction etc. to complex engineering and statistical calculations. 

A formula can also contain any or all of the following: functions, 

references, operators, and constants. 

Different mathematical operators can be used in a formula: 

+ (plus sign)   for addition 

- (minus sign or hyphen)  for subtraction 

* (asterisk)    for multiplication 

/ (slash)    for division 

^ (caret)    for raising a number to an exponential power  
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ARITHMETIC OPREATIONS USING CONSTANTS 

Example formula What it does 

= 7  + 3 Adds 7 and 3 

= 8  -  2 Subtracts 2 from 8 

= 6  /  4 Divides 6 by 4 

= 3 *  2 Multiplies 3 times 2 

= 9 ^  2 Raises 9 to the 2nd power 

 
Figure 4.2.2 – Use of operators (a) 

ARITHMETIC OPREATIONS USING CELL REFERENCE 

Example formula What it does 

  =A2+B2 Adds the values in cells A2 and B2 

  =A3-B3 Subtracts the value in cell A3 from the value in B3 

  =A4/B4 Divides the value in cell A4 by the value in B4 

  =A5*B5 Multiplies the value in cell A5 times the value in B5 

  =A6^B6 Raises the value in cell A6 to the exponential value 

specified in B6 

Table 4.2.2 – Inserting formulas 

APPLYING FUNCTIONS  

Function is a predefined formula. It carries out specific calculations in 

the cell. Functions can be a more efficient way of performing mathematical 

operations than formulas. Specifically, in many cases, a function will simplify 

formulas that you can type in manually, such as average or sum. 

EXAMPLE: If you wanted to add the values of cells A1 through A5, you 

could type the formula ’=A1+A2+A3+A4+A5’, or a shorter way would be to 

use the SUM function and simply type ’=SUM (A1:A5)’. 

You can also insert formulas by using Formula tab 
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Figure 4. 2.2 (b)– Inserting functions 

The following table contains the definitions and examples of several 

most frequently used functions: 

Function Example Description 

SUM  =SUM(A1:A15) Finds the sum of cells A1 through A15. 

AVERAGE  
=AVERAGE(A1:G1) Finds the average of the cells A1 through 

G1 

PI =PI( ) Returns the value of pi (3.1415…) 

SIN 
=SIN(60)         or 

=SIN(B2) 

Returns the sine of given angle 

COS 
=COS(30)        or  

=COS(C2) 

Returns the cosine of the given angle 

TAN 
=TAN(number) or 

=TAN(D2) 

Returns the tangent of the given angle 

MAX   
=MAX(A1:A20) Returns the highest number from cells A1 

through A20 

MIN   
=MIN(B1:B20) Returns the lowest number from cells B1 

through B20. 

SQRT  =SQRT(A5) Finds the square root of the value in A5. 

POWER 
=POWER(B3, 2) Returns the result of a number (B3) raised 

to  power 2 

COUNT 
=COUNT(A1:C10) Counts the number of cells A1 through C10 

that contain numbers  

FACT 

=FACT(number)       or 

=FACT(A3) 

Returns the factorial of a number. The 

factorial of a number is equal to 1*2*3*...* 

number. 

Table 4.2.2: Some important functions  
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4.3 - EDITING & FORMATTING OF CELLS, ROWS 

& COLUMNS 

4.3.1- CELL EDITING 

When Excel is in Edit mode, the word Edit appears 

in the lower-left corner of the Excel program 

window, as shown in the figure. 

To start working in Edit mode, do one of the 

following: 

1. Double-click the cell that contains the data 

that you want to edit. 

2. Click the cell that contains the data that you want to edit, and then 

press F2. 

This starts Edit mode and positions the cursor at the end of the cell contents. 

Now you can apply different editing oprations as shown in table below. 

Editing 

Operation 

Description 

Insert characters Click in the cell where you want to insert them, and 

then type the new characters. 

Delete characters Click in the cell, and then press BACKSPACE, or 

select the characters and then press DELETE. 

Cancel edits Press ESC to cancel any edits that you made to the 

cell contents. 

Toggle between 

insert and overtype 

modes 

Press ENTER to toggle between insert and overtype 

modes. 

Undoing the last 

cell entry 

After you press ENTER or TAB, you can undo your 

edits clicking the UNDO tool on Quick Access 

Toolbar or press Ctrl + Z. 

Redoing the 

previous action 

To redo the previous action click REDO tool on 

Quick Access Toolbar or press Ctrl + Y 

Table: 4.3.1 – Cell Editing  

Figure 4.3.1 – Cell Editing 
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4.3.2 - CELL FORMATTING 

 The Format Cells dialog box provides access to all the formatting 

options avialable in the Ribbon, as well as some additional formatting options. 

To open the Format Cells dialog box, you can click the Dialog Box Launcher 

in the Font, Alignment, or Number group on the Home tab of the Ribbon as 

shown in figures below.  

 
Figure 4.3.2 (a) – Formatting Cells Dialog Box 

 
Figure 4.3.2 (b) – Formatting Cells Dialog Box 
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Figure 4.3.2 (c) – Formatting Cells Dialog Box 

 

                                Figure 4.3.2 (d) – Formatting Options for Cells 
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You can use above tabs of format cells dialog box to change the 

number format, position of data, font options, borders, and cell background 

color as you have done so far. 

The Number Tab: By using this tab, we can change the number in decimals, 

provide the desired format in terms of numbers, numbers with currency 

symbol & dates, convert into a percentage, fractions, etc. 

The Alignment Tab: You can position text and numbers, change the 

orientation, and specify text control in cells by using the settings on 

the Alignment tab. Under Textalignment, you control the horizontal 

alignment, the vertical alignment, and the indention of the text in a cell. 

The Font Tab: By using this tab, you can change the font, font color, font 

style, and font size. You can underline the text, can change the font effects. 

The Border Tab: By using this tab, you can create a colorful borderline in 

different types of styles. If you don’t need the border outline or inside, you 

can leave it blank. 

The Fill Tab: Use the settings on the Fill tab to set the background color of 

the selected cells. You can also use the Pattern Color and the Pattern 

Style lists to apply two-color patterns or shading for the background of the 

cell. Fill Effects lets you apply a gradient fill to the background of the cell. 

4.3.3 - EDITING OF ROWS AND COLUMNS 

Editing of rows and columns includes the insertion and deletion 

operations as follows. 

INSERT ROWS 

Method 1 

1. Select a cell in the row above which you want to insert a new row. 

2. On the Home Tab, find the Cells group and click Insert followed by 

Insert Sheet Rows. 

3. A new row will be inserted above the current row 

Method 2 

1. Select a row above which you want to insert a new row. 

2. Right Click on the selected row, a menu appears from which select 

Insert.  

3. A new row will be inserted above the current row. 

NOTE: When you insert a row, the new row will be positioned above the row 

containing the active cell. 
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TO DELETE A ROW 

Method 1 

1. Select a cell in the row that you want to delete. 

2. On the Home Tab, find the Cells group 

3. Click Delete followed by Delete Sheet Rows. 

4. The row containing the active cell will be deleted. 

5. All the rows below it will move up. 

Method 2 

1. Select the row that you want to delete. 

2. Right Click on the selected row, a menu appears from which select 

Delete.  

3. The selected row will be deleted. All the rows below it will move up. 

TO INSERT COLUMNS 

Method 1 

1. Select a cell in the column to the left of which you want to insert a new 

column. 

2. On the Home Tab, find the Cells group and click Insert followed by 

Insert Sheet Columns. 

3. A new column will be inserted to the left of the current column. 

NOTE: When you insert a column, the new column will be positioned on the 

left of the column containing the active cell. 

Method 2 

1. Select a column to which you want to insert a new column. 

2. Right Click on the selected column, a menu appears from which select 

Insert. 

3. A new column will be inserted.  

TO DELETE A COLUMN 

Method 1 

1. Select a cell in the column that you want to delete. 

2. On the Home Tab, find the Cells group and click Delete followed by 

Delete Sheet Columns. 

3. The column containing the active cell will be deleted. All the columns 

on its right will move left by one.  
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Method 2 

1. Select the column that you want to delete. 

2. Right Click on the selected column, a menu appears from which select 

Delete.  

3. The selected column will be deleted.  

4.3.4 - FORMATTING OF ROWS AND COLUMNS 

In most worksheets there may be 

requirement to change some columns from their 

standard widths. Similarly, you may need to 

change row height. 

To set an exact column width, and row 

height, choose Home TabFormatColumn 

width or Row height as shown in figure 4.3.4.  

You can enter width in characters in the 

Column Width dialog box. You can use any 

value from 0 to 255 characters. Similarly, you can set row height to any value 

between 0 and 409 points. 

The fastest and most effective way to 

change the width of a columns or the hieght of a row is by using AutoFit 

feautre. AutoFit resizes a column to just wider than its widest entry and 

resizes a row to just high enough for its tallest character or object.  

Note: To apply the AutoFit Row Height or AutoFit Column Width, double 

click the right border bar of a column header or the bottom border bar of a row 

header or goto HOME  Format  AutoFit Column Width or AutoFit Row 

Height.  

4.4 - INSERT GRAPHS IN WORK SHEET 

To give worksheets more visual impact, or simply to make them more 

comprehensible, you’ll often need to add pictures, shapes, diagram, charts, or 

other graphical objects. 

Here is description and methods to add different graphs.  

Figure 4.3.4– Rows & Columns 

Formatting options 



COMP-162 COMPUTER APPLICATIONS 

 

 
168 | P a g e  

 

4.4.1 AUTO SHAPES 

There are a lot of shapes available in MS Excel. These shapes range 

from basic shapes to complex shapes. To add auto shapes to a worksheet: 

Choose Insert tab  Illustrations  Shapes to display the Shapes panel.  

(Figure 4.4.1) 

Click the shape you want. Excel changes the mouse pointer to a 

crosshair. Click in the worksheet to position one corner of the shape and drag 

to the size you want the shape to be.  

 

Figure 4.4.1 – Inserting Auto Shapes  

4.4.2  PICTURES 

During working on worksheet sometimes we need to insert a picture, 

such as photograph, or screen capture etc. To add pictures to a worksheet, 

follow these steps. 

1. Select the cell. 

2. Click Insert Tab  Illustrations  Picture, Insert Picture dialog box 

appears. 

3. Navigate to the picture you want to add, and then select it. 

4. Click the Insert button.  

5. Set the corners of your picture 
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Figure 4.4.2 – Inserting Picture 

4.4.3 TEXT BOX 

Text box is a very important formatting tool which is very useful in 

putting text where ever we want on the document. By using text box, text can 

be inserted anywhere in the document.  

 To create a text box, follow these steps: 

1. Choose Insert tab  Text  Text Box. Excel change the mouse pointer 

to a downward pointing arrow.  

2. Click in the worksheet where you want to place one corner of the text 

box, and then drag diagonally to create a text box of the size you want.  

3. Type the text for the text box. 

4. Format the text as you want it. 

 

Figure 4.4.3 – Inserting Text Box 

4.5 - PAGE SETUP, PRINT PREVIEW & PRINTING 

4.5.1 - PAGE SETUP 

Before printing the worksheet or chart we can set page in different 

ways. There are number of page settings available that help to make 

worksheet much better. These options include; Paper Size, Page Orientation, 

and Margin Settings. Here is detailed description to apply these settings.  
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PAGE MARGINS 

Page margins are the blank space around the edges of the page. In 

general, you insert data and graphics in the printable area between the 

margins. However, you can position some items in the margins for example, 

headers, footers, and page numbers. 

To set margin click on Page Layout tab  Page Setup group  

Margins as shown in figure 4.5.1. You will find three types of margins i.e. 

Normal, Wide and Narrow. But you can also set margins yourself by clicking 

on Custom Margins option.  

 

Figure 4.5.1(a) – Setting Margins of Page 

PAGE ORIENTATION 

You can choose either portrait (vertical) or landscape (horizontal) 

orientation for all or part of your Excel sheet. To apply page orientation 

 Click the Page Layout tab 

 Click Orientation in the Page Setup group 

 Select Portrait or Landscape.   
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PAGE SIZE 

Paper or sheet size is the size of the paper used for printing. Standard 

home printers print on A4 size paper, although you may have other options 

with your college or workplace computer to print on larger paper. To apply 

the page size  

 Click the Page Layout tab 

 Click on the Size in the Page setup group 

 Select one of the preset paper sizes or use it to set a custom size as 

shown in figure 4.5.1 (b). 

 
Figure 4.5.1 (b) – Page Size 

4.5.2 - PRINT PREVIEW  

Print Preview displays a worksheet exactly as it will be printed. To use 

Print Preview, follow these steps: 

1. Choose File Menu>> select Print command, it displays print menu.  

OR 

 Click Print Preview and Print icon on Quick Access Toolbar. 

2. The Print Preview displays.  

Excel displays the first page of your printed output. You can view 

subsequent pages by clicking Previous Page and Next Page 
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You can also use zoom option to toggle between full page and close up 

view of your sheet. Click Back button to close print preview window. 

4.5.3 - PRINTING A WORKSHEET 

When you need to get hardcopy of your worksheet follow these steps: 

1. Click the File Menu and select the Print command OR press [Ctrl] + [P] 

from your keyboard. 

 This will open Printing options as shown below in figure 4.5.3  

 

Figure 4.5.3 (a)– Print Options 
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2. If you have more than one printer to choose from, they will be available 

in the Printer area. Click the drop-down arrow next to the Name field to 

select your preferred printer. 

3. To print selected pages only, find the Print Range Area, and type the 

page numbers that you want to print in the Pages field. 

4. To print the entire workbook, you can specify this by clicking the 

dropdown as shown in the figure.   

 

Figure 4.5.3 (b)– Printing Entire Workbook  

5. There is also option to get more than one copies of the worksheet. To do 

this, simply enter the required number of copies in the Copies field. 

After completing the setting Click Print. The specified worksheet pages will 

be sent to the printer. 

4.6 –  CHARTS, ITS TYPES & CATEGORIES 

4.6.1 - CHART 

A chart is a powerful tool that allows you to visually display data in a 

variety of different chart formats such as Bar, Column, Pie, Line etc. Excel 

provides an easy way to create chart. 
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Figure 4.6.1- Chart with Elements 

ELEMENTS OF A CHART 

Chart Title: 

A chart title is a heading that appears above the main chart. It is 

usually used to describe or explain what the chart contains. 

Walls: 

Walls define the area of the chart and help to place it in space. 2D 

charts have one wall (the back). 3D charts have three walls (the back, the 

floor, and the side. 

Grid lines: 

Grid lines help show the scale of the data. You generally have one set 

of grid lines for each axis. 

Category Names: 

The horizontal axis is called the category axis (X-Axis). Each set of 

values within your data is referred to as category names of data.  

Bars: 

Bars are used to represent the data values.  

Labels: 

Labels help us highlight important data points.  
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Chart area: 

Chart area is the rectangular box containing the chart and all of the 

other chart elements.  

Axis: 

Each axis shows the values for the data. 2D charts have two axis:  

 X for horizontal 

 Y for Vertical.  

 3D charts add a Z axis which shows the depth of the data. 

4.6.2 - INSERTING CHART 

To insert chart in your worksheet, do following 

1. Insert and select the data source with the range of data you want to make 

chart as shown below in figure 4.6.2. 

 

Figure 4.6.2 (a)– Datasheet for Chart 

2. In the Charts group on the Insert tab, click a chart type, and then click a 

chart subtype in the Chart gallery as shown below in figure 4.6.2 (b).  

 

Figure 4.6.2 (b) - Inserting Chart with Type 

3. The clustered column chart will be created according to above data as 

shown in figure 4.6.2 (c). 
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Figure 4.6.2 (c) – The Clustered Column Chart 

4.6.3 - CHART TYPES & CATEGORIES 

In Microsoft Office Excel there are many types of charts to display 

data in different ways. When you create a chart or change the type of an 

existing chart, you can select one of the following chart types. 

COLUMN CHARTS 

Column charts are one of the most common chart types. A column 

chart displays each data point as a vertical column, the height of which 

corresponds to the value.  

 The columns chart includes 2-D Column, 3-D Column, Cylinder, 

Cone, and Pyramid chart types. Here is an example of students obtained marks 

in four subjects using column chart in figure 4.6.3 (a)  

 

 

Figure 4.6.3 (a) – Column Chart for Students Four Subjects Marks   
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BAR CHARTS 

In a Bar Chart, the categories are organized along the vertical axis and 

the values are organized along the horizontal axis. To create a Bar Chart, 

arrange the data in columns or rows on the Worksheet. 

A bar chart is used when you have categories of data like types of 

computers, mobiles phones, movies etc. It is also a good choice when you 

want to compare things between different groups. Here is an example using 

bar chart in figure 4.6.3 (b) 

 

Figure 4.6.3 (b) – Example of Bar Chart 

LINE CHART 

Line charts displays values as equally spaced points connected with a 

line.It is often used to plot continous data and are useful for identifying trends 

over time. For example, plotting daily sales of gold and silver as a line chart 

may help you to identify sales fluctuations over time as shown in figure 4.6.3 

(c). 

 

Figure 4.6.3 (c) – Line Chart for Sales Trend over Month  
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PIE CHART 

A pie chart is a circular chart divided into sectors, each sector shows 

the relative size of each value. A pie chart is suitable for a dataset that has 

only one series of information. Both types of pie charts includes 2-D Pie and 

3-D Pie. Example of pie chart is shown in figure 4.6.3 (d). 

 
Figure 4.6.3 (d) – Pie Chart  

AREA CHART 

Area charts are similar to line charts exceps that the area underneath 

the line filled with color. Area charts inlcudes 2-D area and 3-D area charts 

types. Example of area chart is shown below in figure 4.6.3 (e). 

 
Figure 4.6.3 (e) – Area Chart for Mobile Sale 
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EXERCISE 

Short Questions 

1. Define the Spreadsheet program. 

A spreadsheet is a software application that enables a user to enter, 

save, calculate, analyze, sort and manage data in arranged form of rows and 

columns. 

2. Define the Microsoft Excel 

Microsoft Excel is general-purpose electronic spreadsheet software 

used to organize, sort calculate, and analyze data. 

3. What is use of Microsoft Excel? 

The task you can complete with Excel ranges from preparing a simple 

family budget, preparing a purchase order, checking account information, 

budgets, transactions, billing invoices, create an elaborate 3-D chart, or 

managing a complex accounting ledger for a medium size business. 

4. What is a workbook? 

 The workbook is the entire book containing a number of worksheets. 

Worksheet is a single page within that book. A workbook can contain at least 

one worksheet. 

5. Define the Worksheet. 

An Excel worksheet is a single spreadsheet that contains cells organized by 

rows and columns. A worksheet begins with row number one and column A. 

Each cell can contain a number, text or formula. 

6. Define the Name box in MS Excel. 

The Name Box is the box to the left of the formula bar that displays 

the cell name that is currently selected in the spreadsheet. Usually a cell name 

is combination of column name and row number. For example, C2 is the cell 

in Column C and Row 2.  

7. What is Cell Reference? 

 A Cell reference means the cell to which another cell refers. For 

example, if in cell A1 you have “ = A2 ”, it means A1 refers to A2. Cells in 

the spread sheet are referred by rows and columns.   
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8. Define the Formula Bar. 

 The formula bar is used to create and view formulas. It shows the 

contents of the active cell.  

9. Define the Row Headings and Column Headings in MS Excel. 

The row headings are the numbers at the left side of the screen that 

identify each row by number. The column heading are the letters across the 

top of the worksheet grid that identify each column by one or more letters. 

10. Define the Cell in MS Excel. 

The main working area of Microsoft Excel consists of cells. A cell is 

the intersection of a column and a row. 

A cell is identified by its name and every cell has a unique name in a 

worksheet. 

11. Define the Active Cell. 

The active cell is the cell in which text and numbers appear when you 

type. It is a rectangular box highlighting the cell in the sheet. Only one cell 

can be an active cell at a time.  

12. Define the Worksheet Tabs. 

Each worksheet has a tab at the bottom that you can click to display 

the worksheet. The tabs in each new worksheet have standard names (Sheet1, 

Sheet2, and so on), but you can give your own defined names.   

13. How the data can be entered in MS Excel worksheet? 

Data can be entered in a worksheet by two ways 

1. Manual: entered by user 

2. Automatic:  where data is imported from some other systems or 

sources, like from Access, SQL Server or from web etc. 

14. What type of data can be entered in MS Excel worksheet? 

The numbers, text, dates, or times can be entered in a worksheet.  

15. How to enter data on a new line within a cell? 

To enter data on a new line within a cell, enter a line break by pressing 

[Alt] + [Enter].  
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16. Define the formulas in MS Excel Sheets. 

Formula is an expression which calculates the value of a cell.  A 

formula always starts with an equal sign (=). 

For example, the following formula multiplies 4 by 3 and then adds 6 

to the result. 

= 6 + 4 * 3 

17. Define the functions. 

Functions are predefined formulas that can be a more efficient way of 

performing mathematical operations than formulas. 

Specifically, in many cases, a function will simplify formulas that you can 

type in manually, such as average or sum. 

18. What are the categories of functions in MS Excel? 

There are many categories of functions, some of them are: 

 Financial 

 Logical 

 Text 

 Date & Time 

 Math & Trigonometric 

 Miscellaneous 

19. What is the difference between formula and function? 

A function is predefined formula that cannot be changed and on the other 

hand formula is user defined expression that has flexibility to be changed.  

20. What are arithmetic operators used in MS Excel? 

      Following are the arithmetic operators  

 + (plus sign) for addition 

 - (minus sign or hyphen) for subtraction 

 * (asterisk) for multiplication 

 / (slash) for division 

 ^ (caret) for raising a number to an exponential power  
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21. Give an example of arithmetic operations using constants 

   Example formula What it does? 

 =7 + 3  Adds 7 and 3 

 =8 - 2  Subtracts 2 from 8 

 =6 / 4  Divides 6 by 4 

 =3 * 2  Multiplies 3 times 2 

 =9 ^ 2  Raises 9 to the 2nd power 

22. Give an example of arithmetic operations using cell reference. 

      Example formula what it does? 

             =A2 + B2 Adds the values in cells A2 and B2 

             =A3 - B3 Subtracts the value in cell A3 from the value in B3 

             =A4 / B4 Divides the value in cell A4 by the value in B4 

             =A5 * B5 Multiplies the value in cell A5 times the value in B5 

             =A6 ^ B6 Raises the value in cell A6 to the exponential value  

 Specified in B 

23. Define the cell range. 

In a spreadsheet a cell range is a collection of selected cells. A cell 

range can be referred to in a formula. In a spreadsheet, a cell range is defined 

by the reference of the upper left cell (minimum value) of the range and the 

reference of the lower right cell (maximum value) of the range. 

24. How a cell entry can be edited? 

You can edit cell entry by doing one of the following 

1. Double-click the cell that contains the data that you want to edit. 

2. Click the cell that contains the data that you want to edit, and then press 

F2. 

25. Define the cell formatting.  

 Formatting of cells in Excel means, you can change the appearance of 

text in a cell without changing the text itself. We can apply a number format 

(0.8, $0.80, 80%, etc) or other formatting (alignment, font, border, etc). 

26. What is the right way to enter date in MS Excel? 

To enter a date, use a slash mark or a hyphen to separate the parts of a 

date; for example, type 08/10/2008 or 05-Sep-2011 etc.  
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27. What is the keyboard shortcut to enter current date in MS Excel cell? 

To enter the current date and time, press CTRL+; (semi colon)  

28. What is the keyboard shortcut to enter current time in MS Excel cell? 

To enter the current date and time, press CTRL+SHIFT+;  

29. What is data alignment? How can we change it in a cell? 

 Data alignment means adjusting the data position in a cell. For this 

purpose we can use alignment setting in Home tab. You can set horizontal and 

vertical alignment.  

30. Where the new inserted column is positioned? 

When you insert a column, the new column will be positioned on the 

left of the column containing the active cell. 

31. What is the use of clipboard? 

 A clipboard is a temporary storage for data that the user wants to copy 

from one place to another. For example, you might want to cut text from one 

part of a sheet and paste it in another part of the sheet or somewhere else. 

When you will select the text and then cut or copy that text, it stores in 

clipboard for further use.   

32. What is use of Text Box in MS Excel? 

Text box is a very important formatting tool which is very useful in 

putting text where ever you want on the sheet. By using text box, text can be 

inserted anywhere in the document.  

33. What is chart? 

A chart is a powerful tool that allows you to visually display data in a 

variety of different chart formats such as Bar, Column, Pie, Line etc. Excel 

provides an easy way to create chart. 

34. What are the elements of a chart? 

Following are the elements of a chart 

 Chart Title 

 Walls 

 Grid lines 

 Category Names 

 Bars 

 Chart area 

 Axis  
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35. What are types of charts in MS Excel? 

Following are the types of charts used in MS Excel 

 Column Charts 

 Bar Charts 

 Line Charts 

 Pie Charts 

 Area Charts 

 Scatter Charts 

 Other Charts 

36. Define the Column Charts. 

Column charts are one of the most common chart types. A column 

chart displays each data point as a vertical column, the height of which 

corresponds to the value. The columns chart includes 2-D Column, 3-D 

Column, Cylinder, Cone, and Pyramid chart types. 

37. Define the Bar Charts. 

A bar chart is essentially a column chart that has been rotated 90 

degrees clockwise. One distinct advantage to use a bar chart is that the 

category labels may be easier to read. 

38. Define the Line Charts. 

Line charts displays values as equally spaced points connected with a 

line.It is often used to plot continous data and are useful for identifying trends 

over time. For example, plotting daily sales of gold and silver as a line chart 

may help you to identify sales fluctuations over time. 

39. Define the Pie Chart. 

A pie chart is a circular chart divided into sectors, each sector shows 

the relative size of each value. A pie chart is suitable for a dataset that has 

only one series of information. 

40. Define the Area Charts. 

Area charts are similar to line charts exceps that the area underneath 

the line filled with color. 

41. What is keyboard shortcut to get hard copy of worksheet? 

Ctrl + P is the keyboard shortcut to get hard copy of worksheet.  
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Multiple Choice Questions 

1. Spreadsheet is an electronic document in which data is arranged in the  

    ________________. 

    a. Rows b. Columns               c. Both a & b             d. None of these 

2. Example of Spreadsheet program is _______________. 

    a. MS Excel                        b. MS Calculation                     c. MS Word 

    d. None of these 

3. MS Excel is type of _______________ software. 

    a. application  b. counting                  c. system              d. firmware 

4. MS Excel is _______________software. 

    a. word processor  b. spreadsheet   c. database                           

    d. graphic 

5. The box where the cell name displays is called __________________. 

    a. Cell Box    b. Name Box   c. Row Box                          

    d. Column Box 

6. The ____________is the bar where the users can create and view formulas. 

    a. Formula Bar                     b. Function Bar                      c. Expression Bar                 

    d. Method Bar 

7. In Excel every formula is starts with _______________ symbol. 

a. #                           b. @   c.=  d. %    

8. In Excel sheet every column heading at the top is identified by _________. 

    a. numbers                b. symbols  c. letters d. None of these 

9. In Excel sheet every row heading at the left is identified by ____________.  

    a. numbers                b. symbols  c. letters d. None of these 

10. In Excel, Columns are labeled as ______________. 

      a. A, B, C, etc.                      b. 1, 2, 3, etc.                      c. A1, A2, A3, etc.             

      d. $A$1, $A$2, etc.  

11. In Excel, Rows are labeled as ______________. 

      a. A, B, C, etc.                      b. 1, 2, 3, etc.                      c. A1, A2, A3, etc.            

      d. $A$1, $A$2, etc.   
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12. How many sheets are there, by default, when you create a new Excel file? 

    a. 1                            b. 5                            c. 3  d. 8 

13. An Excel file is generally called a ________________. 

      a. spreadsheet              b. workbook               c. sheet               d. worksheet  

14. The intersection of row and column on a worksheet is called __________. 

      a. column                     b. row                      c. worksheet                     d. cell 

15. The cell in which text and numbers appear when you type. 

_____________. 

      a. Bold Cell                         b. Colored Cell                          c. Active Cell                      

      d. Inactive Cell 

16. You can activate a cell by _______________. 

      a. pressing the tab key                                              b. clicking the cell                      

      c. pressing an arrow key                                           d. all of above 

17. What type of data can be entered in MS Excel? 

      a. numbers                b. text                c. date & time                d. all of these 

18. Which key is used to accept the cell entry? 

      a. Enter key b. Arrow key  c. Tab key              d. all of these 

19. The default alignment of text in Excel is _______________. 

      a. centered  b. left   c. right         d. justify 

20. The default alignment of numbers in Excel is ______________. 

      a. centered  b. left   c. right         d. justify  

21. To enter data on a new line within a cell, the _____________ shortcut key  

      is used. 

      a. Alt + Enter                          b. Ctrl + Enter                        c. Shift + Enter                    

      d. None of above 

22. To enter the current date and time in a cell the _______________ function  

      is used. 

      a. Now                 b. Today                   c. Date                    d. None of these  

23. Example of Arithmetic operators is _________________. 

      a. >< =                                    b. + - * / ^                               c. And Or Not                          

      d. None of above  
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24. Example of Relational operators is _________________. 

      a. >< =                                b. + - * / ^                              c. And Or Not                          

      d. None of these 

25. Example of Logical operators is _________________. 

      a. >< =                                b. + - * / ^                              c. And Or Not                          

      d. None of these 

26. Identify the symbol for exponential power. 

      a. *                       b. /                           c. ^                         d. = 

27. Identify the symbol for multiplication. 

      a. *                      b. /                            c. ^                         d. = 

28. Identify the symbol for division. 

      a. *                     b. /                             c. ^                         d. \ 

29. The correct example for addition is _________________. 

      a. A2 + B2                         b. =add(A2,B2)                       c. SUM(A2,B2)                   

      d. =A2 + B2 

30. The correct example of a cell address 

      a. 11 22                    b. 911                      c. 15A                       d. A15  

31. When you accidentally erased a record in a sheet, the ______________  

      command is used to restore. 

      a. Insert                    b. Copy                      c. Undo                     d. Replace 

32. The example of formula is _________________. 

      a. =A1 + A2                        b. =add(A1:A2)                          c. A1+A2                      

      d. SUM(A1:A2) 

33. The example of function is _________________. 

      a. =A1 + A2                        b. =SUM(A1:A2)                        c. A1+A2                     

      d. =add(A1:A2) 

34. Which of the following option is correct? 

      a. = Average(2,3,4)                              b. =Average(A2:F2)                     

      c. =Average(A1, B1, C1)                     d. All of these 

35. Which of the following is correct? 

      a. =Power(2^3)                    b. =Power(2,3)                     c. =Power(2#3)                   

      d. =Power(2*3)  
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36. The shortcut key to edit a cell entry is ______________. 

      a. F1  b. F2   c. F3   d. F4 

37. The keyboard shortcut to open Format Cells dialogue box is __________. 

      a. Ctrl + 1  b. Ctrl + 2  c. Ctrl + 3  d. Ctrl + 4 

38. Which types of charts can excel produce? 

      a. Line graphs and pie charts only           b. Bar charts and line graphs only  

      c. Bar charts, line graphs and pie charts              d. Only line graphs 

39. Which symbol is used in cells range? 

      a.  ;                       b.  :                          c.  “                         d.  ? 

40. Correct example of cells range from A1 to F10 is _______________. 

      a. A1-F10                 b. A1; F10                  c. A1: F10                 d. A1.F10 

41. You can copy cell formats from one cell to another by using the _______. 

      a. Backspace key                      b. Default                       c. Format painter                  

      d. Formatting toolbar 

42. A value used in a formula that does not change is called ______________. 

      a. Cell address                           b. Constant                          c. Function                    

      d. Range  

43. Which formula can add all the numeric values in a range of cells? 

      a. Count                       b. Average                     c. Sum                        d. If 

44. To insert two columns between column C and D you would ___________. 

      a. select column C                           b. select column D                        

      c. select column C, D, E                 d. select column D, E, F 

45. The default extension of MS Excel file is ______________.  

      a. xlsx                          b. xlw                            c. xcl                            d. exl 

46. A diagram or graph that shows information in a simple way. 

      a. picture                     b. graph                      c. chart                       d. clipart 

47. Which function in Excel tells how many numeric entries are there? 

      a. Num                      b. Count                        c. Sum                         d. PI 

48. What type of chart will you use to compare performance of two cricket  

      team in a match? 

      a. Line Chart                          b. Pie Chart                        c. Column Chart                   

      d. Dot Chart  
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49. The process of arranging the items of a column in some sequence is        

      known as ______________. 

      a. arranging                b. sorting                  c. filtering                  d. auto fill 

50. The __________ feature of MS Excel quickly completes a series of data. 

      a. Auto Fill                        b. Auto Complete                         c. Sorting                              

      d. Filtering 

51. What type of chart will you use to compare performance of sales of four  

       products? 

      a. Column Chart                         b. Line Chart                         c. Pie Chart                          

      d. Bubble Chart 

52. The keyboard shortcut to get printout of an Excel sheet is _____________. 

      a. Ctrl + E                 b. Ctrl + P                  c. Ctrl + R                 d. Ctrl + T 

53. If you require more than one hard copies of the worksheet, then enter it  

      in_______________ field. 

      a. Number of Copies                            b. Copies                           c. Copy                      

      d. none of above  

54. You can print ________________.  

      a. Selection                                                          b. An entire workbook                  

      c. A single worksheet                                          d. All of these 

55. To exit from MS Excel program the ________________ shortcut is used. 

      a. Alt + F4                        b. Ctrl + F4                         c. Shift + F4                 

      d. Alt + Ctrl + F4 

56. A ______________ is a temporary storage area for data that the user        

wants to cut or copy from one place to another. 

      a. clipboard                        b. master board                        c. mother board                     

      d. circuit board 

57. A ____________ is more efficient than formulas. 

      a. Chart          b. Sorting                   c. Function                  

     d. None of these  
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ANSWERS KEY 

 

1 c 13 b 25 c 37 a 49 b 

2 d 14 d 26 c 38 c 50 a 

3 a 15 c 27 a 39 b 51 a 

4 b 16 d 28 b 40 c 52 b 

5 b 17 d 29 d 41 c 53 a 

6 a 18 d 30 d 42 b 54 d 

7 c 19 b 31 c 43 c 55 a 

8 c 20 c 32 a 44 b 56 a 

9 a 21 a 33 B 45 a 57 c 

10 a 22 a 34 d 46 c   

11 b 23 b 35 b 47 b   

12 a 24 A 36 b 48 a   

 

LONG QUESTIONS 

1. Write the procedure for starting and exiting the MS Excel program 

2. Write a note on components of MS Excel main. 

3. Write a short note on following: 

 Quick Access Toolbar 

 Name Box 

 Formula Bar 

 Status Bar 

4. How to enter text, numbers, date & time in MS Excel sheet? 

5. What are the parts of formula in Excel? How a formula can be applied in 

worksheet? 

6. What are arithmetic operators? Give examples of applying arithmetic     

operator in worksheet. 

7. Explain the difference between formula and function by examples. 

8. Explain the following functions by providing examples 

           i. Sum                   ii. Average                    iii. SIN                      iv. COS 

9. Explain the editing operations in worksheet by examples. 

10. Explain the all cell formatting options.  



COMP-162 COMPUTER APPLICATIONS 

 

 
191 | P a g e  

 

11. How to insert and delete rows, columns in a worksheet? 

12. What is chart? How to insert a chart in worksheet? 

13. What are the elements of chart? How to change the type of chart? 

14. Write a brief note on important chart types in MS Excel. 

15. What is meant by page setup. Write method of selecting page size and its 

 margin.  

16. How to get different printouts of a worksheet? 

17. Write method of changing font style, font size, font color and making it 

bold. 

18.    a) What is meant by " Wrap text ", write its method to apply in MS 

Excel?  

 b) What is meant by “Merge Cells " in MS Excel program. Write its 

method.  

19. Write method of entering pictures and drawing shapes in MS Excel. 
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C H A P T E R  5  

M i c r o s o f t  P o w e r P o i n t  

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of Microsoft PowerPoint. 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 
 Describe Introduction to MS-PowerPoint 

 Explain creating a presentation 

 Describe Editing & formatting a text box 

 Explain Adding pictures & colors to a slide 

 Describe Making slide shows 

 Explain Slide Transitions 
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5.1 - INTRODUCTION TO MS-POWER POINT 

PowerPoint is a presentation program that allows you to create 

dynamic slide presentations. These presentations can include animation, 

narration, images, videos, and much more. In this lesson, you'll learn your 

way around the PowerPoint environment, including the Ribbon, Quick 

Access Toolbar, and Backstage view. 

Getting to know PowerPoint 

PowerPoint 2016 is similar to PowerPoint 2013 and PowerPoint 2010. 

If you've previously used these versions, PowerPoint 2016 should feel 

familiar. But if you are new to PowerPoint or have more experience with older 

versions, you should first take some time to become familiar with 

the PowerPoint 2016 interface. 

The PowerPoint interface 

When you open PowerPoint for the first time, the Start Screen will 

appear. From here, you'll be able to create a new presentation, choose 

a template, and access your recently edited presentations. From the Start 

Screen, locate and select Blank Presentation to access the PowerPoint 

interface. 

 

 

Figure 5.1 (a) - Microsoft Power Point Interface 
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Click the buttons in the interactive below to become familiar with the 

PowerPoint interface. 

 

 
Figure 5.1 (b) - Working with PowerPoint Interface 

 

The Ribbon and Quick Access Toolbar are where you will find the 

commands to perform common tasks in PowerPoint. Backstage view gives 

you various options for saving, opening a file, printing, and sharing your 

document. 

The Ribbon 

PowerPoint uses a tabbed Ribbon system instead of traditional menus. The 

Ribbon contains multiple tabs, each with several groups of commands. For 

example, the Font group on the Home tab contains commands for formatting 

text in your document. 

 

 
Figure 5.1 (c) – Ribbon and Font Group 
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Some groups also have a small arrow in the bottom-right corner that you can 

click for even more options. 

 
Figure 5.1 (d) –Showing and hiding Ribbon 

 

The Ribbon is designed to respond to your current task, but you can choose 

to minimize it if you find that it takes up too much screen space. Click 

the Ribbon Display Options arrow in the upper-right corner of the Ribbon to 

display the drop-down menu. 

 

Figure 5.1 (d) - Ribbon Display Options 

 

o Auto-hide Ribbon: Auto-hide displays your workbook in full-screen 

mode and completely hides the Ribbon. To show the Ribbon, click 

the Expand Ribbon command at the top of screen. 

o Show Tabs: This option hides all command groups when they're not 

in use, but tabs will remain visible. To show the Ribbon, simply click 

a tab. 
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o Show Tabs and Commands: This option maximizes the Ribbon. All 

of the tabs and commands will be visible. This option is selected by 

default when you open PowerPoint for the first time. 

 

The Quick Access Toolbar 

Located just above the Ribbon, the Quick Access Toolbar lets you access 

common commands no matter which tab is selected. By default, it includes 

the Save, Undo, Redo, and Start From Beginning commands. You can add 

other commands depending on your preference. 

 

The Ruler, Guides, And Gridlines 

PowerPoint includes several tools to help organize and arrange content on 

your slides, including the Ruler, guides, and gridlines. These tools make it 

easier to align objects on your slides. Simply click the check boxes in 

the Show group on the View tab to show and hide these tools. 

 

 

 

Figure 5.1 (e) - Microsoft PowerPoint View Tab 

 

Zoom and other View Options 

PowerPoint has a variety of viewing options that change how your 

presentation is displayed. You can choose to view your presentation 

in Normal view, Slide Sorter view, Reading view, or Slide Show view. You 

can also zoom in and out to make your presentation easier to read. 

 Switching slide views 
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Switching between different slide views is easy. Just locate and select the 

desired slide view command in the bottom-right corner of the PowerPoint 

window. 

 

 

Figure 5.1 (f) – Zoom options 

 Zooming in and out 

To zoom in or out, click and drag the zoom control slider in the bottom-right 

corner of the PowerPoint window. You can also select the + or -

 commands to zoom in or out by smaller increments. The number next to the 

slider displays the current zoom percentage, also called the zoom level. 

 

 

Figure 5.1 (g) – Zoom options 

 

5.2 CREATING A PRESENTATION 

PowerPoint files are called presentations. Whenever you start a new 

project in PowerPoint, you'll need to create a new presentation, which can 

either be blank or from a template. You'll also need to know how to open an 

existing presentation. 

 

Create A New Presentation 

When beginning a new project in PowerPoint, you'll often want to start 

with a new blank presentation.  
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1. Click File tab Select New on the left side of the windowClick Blank 

Presentation. 

 

 

Figure 5.2 (a) - Creating a Blank Presentation 

A new presentation will appear. 

To create a new presentation from a template: 

 

1. Click the File tab  Click NewSelect a Template to review it. 

(A preview of the template will appear, along with additional 

information on how the template can be used.) 

2. Click Create to use the selected template. 

A new presentation will appear with the selected template. 

It's important to note that not all templates are created by Microsoft. 

Many are created by third-party providers and even individual users, so some 

templates may work better than others. 

Compatibility Mode 

Sometimes you may need to work with presentations that were created 

in earlier versions of PowerPoint, like PowerPoint 2003 or PowerPoint 2000. 

When you open these types of presentations, they will appear 

in Compatibility  

Mode. 

Compatibility Mode disables certain features, so you'll only be able to 

access commands found in the program that was used to create the 

presentation.   
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For example, if you open a presentation created in PowerPoint, you 

can only use tabs and commands found in PowerPoint. 

Save Presentation: 

It's important to save your presentation whenever you start a new 

project or make changes to an existing one. Saving early and often can prevent 

your work from being lost. You'll also need to pay close attention to where 

you save the presentation so it will be easy to find later. 

Locate and select the Save command on the Quick Access Toolbar. 

 

Figure 5.2 (b): Saving presentation 

1. If you're saving the file for the first time, the Save As pane will appear 

in Backstage view. 

2. You'll then need to choose where to save the file and give it a file 

name. Click Browse to select a location on your computer. 

Alternatively, you can click OneDrive to save the file to your 

OneDrive. 

3. The Save As dialog box will appear. Select the location where you 

want to save the presentation. 

4. Enter a file name for the presentation, then click Save. 

5. The presentation will be saved. You can click the Save command 

again to save your changes as you modify the presentation.  
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You can also access the Save command by pressing Ctrl+S on your keyboard. 

Using Save As to make a copy 

Understanding Slides and Slide Layouts 

When you insert a new slide, it will usually have placeholders to show you 

where content will be placed. Placeholders can contain different types of 

content, including text, images, and videos. Slides have different layouts for 

placeholders. Whenever you create a new slide, you'll need to choose a slide 

layout that fits your content. 

 
Figure 5.2 (c) - Slide Layouts 

Insert a new slide: 

Whenever you start a new presentation, it will contain one slide with the Title 

Slide layout. You can insert as many slides as you need from a variety of 

layouts. 

1. From the Home tab, click the bottom half of the New Slide command. 

 

 
Figure 5.2 (d): Selecting a New Slide Layout 
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2. Choose the desired slide layout from the menu that appears. 

3. Click any placeholder and begin typing to add text. 

Organizing slides 

PowerPoint presentations can contain as many slides as you need. The Slide 

Navigation pane on the left side of the screen makes it easy to organize your 

slides. From there, you can duplicate, rearrange, and delete slides in your 

presentation. 

 

 

Figure 5.2 (e) - Slide Editing View 

Working with slides 

 Duplicate slides: If you want to copy and paste a slide quickly, you 

can duplicate it. To duplicate slides, select the slide you want 

to duplicate, right-click the mouse, and choose Duplicate Slide from 

the menu that appears. You can also duplicate multiple slides at once 

by selecting them first. 

 Move slides: It's easy to change the order of your slides. Just click 

and drag the desired slide in the Slide Navigation pane to the desired 

position. 

 Delete slides: If you want to remove a slide from your presentation, 

you can delete it. Simply select the slide you want to delete, then press 

the Delete or Backspace key on your keyboard.  
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To Copy And Paste Slides: 

1. Select the slide you want to copy  press Ctrl+C. 

2. Click in between the slide list where you want to paste the slide 

3. Click the Paste command on the Home tab. OR press Ctrl+V. 

4. The slide will appear in the selected location. 

Apply Slide Designs: 

A theme is a predefined combination of colors, fonts, and effects that can 

quickly change the look and feel of your entire slide show. Select 

the Design tab on the Ribbon, then click the More drop-down arrow to see all 

of the available designs. 

 

Figure 5.2 (f): Applying slide designs. 

1. Select the desired design. 

2. The theme will be applied to your entire presentation. 

5.3 - EDITING & FORMATTING A TEXT BOX 

To select format text within a Text Box: 

Before you can move or arrange text, you'll need to select it. 

1. Click next to the text you want to select, drag the mouse over the text, then 

release your mouse. The text will be selected. 
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Figure 5.3 (a) - Text Editing within the Text Box 

2. Select the text and edit as desired 

 

Figure 5.3 (b) - Text Selection and Editing 

Copying and Moving Text 

PowerPoint allows you to copy text that is already on a slide and paste it 

elsewhere, which can save you time. If you want to move text, you can cut 

and paste or drag and drop the text.  
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To copy and paste text: 

1. Select the text you want to copy, then click the Copy command on 

the Home tab. 

 
Figure 5.3 (c) - Using COPY Tool 

2. Place the insertion point where you want the text to appear. 

3. Click the Paste command on the Home tab. 

 
Figure 5.3 (d) - Using PASTE Tool 

4. The copied text will appear. 

 

To cut and paste text: 

1. Select the text you want to move, then click the Cut command. 

 
Figure 5.3 (e) - Using CUT Tool 

2. Place the insertion point where you want the text to appear, then click 

the Paste command. 

3. The text will appear in the new location. 
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You can access the cut, copy, and paste commands by using keyboard 

shortcuts. Press Ctrl+X to cut, Ctrl+C to copy, and Ctrl+V to paste. 

To drag and drop text: 

1. Select the text you want to move, then click and drag the text to 

the desired location. 

2. The text will appear in the new location. 

Align Text 

You can use these commands to align your text at the top, middle, 

or bottom of a placeholder or text box. 

5.4 - ADDING PICTURES & COLORS TO A SLIDE 

Adding pictures can make your presentations more interesting and engaging. 

You can insert a picture from a file on your computer onto any slide. 

PowerPoint even includes tools for finding online pictures and 

adding screenshots to your presentation. 

1. Select the Insert tab, then click the Pictures command in 

the Images group. 

 

Figure 5.4 (a) - Using Insert Tab to insert a picture 

2. A dialog box will appear. Locate and select the desired image file, then 

click Insert. 

3. The picture will appear on the currently selected slide.  
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Inserting Screen Clipping 

To insert a screen clipping: 

1. Select the Insert tab Screenshot command Screen Clipping. 

 

Figure 5.4 (b) - Using Screen Clipping Tool 

2. A view of other open windows will appear. Click and drag to select the 

area you want to capture as a screen clipping. 

3. The screen clipping will appear on the currently selected slide. 

Changing Slide Color 

By default, all slides in your presentation use a white background. 

Backgrounds can have a solid, gradient, pattern, or picture fill. 

1. Select the Design tab, then click the Format Background command. 

 

Figure 5.4 (c) - Changing Slide Background Colors 

2. Select the desired fill options. Let’s use a Solid fill with a light gold color. 
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Figure 5.4 (d) - Using Color Plate to change slide color 

3. If you want, you can click Apply to All to apply the same background 

style to all slides in your presentation. 

5.5 - MAKING SLIDE SHOWS 

Once your slide show is complete, you'll need to learn how to present 

it to an audience. PowerPoint offers several tools and features to help make 

your presentation smooth, engaging, and professional. 

Presenting A Slide Show 

 To start a slide show: 

There are several ways you can begin your presentation: 

 Click the Start From Beginning command on the Quick Access 

Toolbar, or press the F5 key at the top of your keyboard. The 

presentation will appear in full-screen mode. 
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Figure 5.5 (a) - Running a slide Show using Slide show Tool 

 Select the Slide Show view command at the bottom of the PowerPoint 

window to begin a presentation from the current slide. 

 

Figure 5.5 (b) - Running a Slide Show Using from PowerPoint window 

 Go to the Slide Show tab on the Ribbon to access even more options. 

From here, you can start the presentation from the current slide and 

access advanced presentation options. 

 

Figure 5.5 (c) - Running Slide Show Using Slide Show Menu 

To advance and reverse slides: 

You can advance to the next slide by clicking your mouse or pressing 

the spacebar on your keyboard. Alternatively, you can use or arrow keys on 

your keyboard to move forward or backward through the presentation. 

You can also hover your mouse over the bottom-left and click the arrows to 

move forward or backward. 

 

 

Figure 5.5 (d) - Move Slides Forward or Backward during a slide show  
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To stop a slide show: 

You can exit presentation mode by pressing the Esc key on your keyboard. 

Alternatively, you can click the Slide Show Options button in the bottom-left 

and select End Show. 

 

Figure 5.5 (e) - Ending a Slide Show 

The presentation will also end after the last slide. You can click the mouse or 

press the spacebar to return to Normal view. 

 

Figure 5.5 (f) - Ending of a slide show after last slide  

Presentation tools and features 

PowerPoint provides convenient tools you can use while presenting your slide 

show. For example, you can change your mouse pointer to 

a pen or highlighter to draw attention to items in your slides. In addition, you 

can jump around to slides in your presentation or access other programs from 

your taskbar if needed. 

5.6 - SLIDE TRANSITIONS 

If you've ever seen a PowerPoint presentation that had special effects 

between each slide, you've seen slide transitions. A transition can be as 

simple as fading to the next slide or as flashy as an eye-catching effect. 

PowerPoint makes it easy to apply transitions to some or all of your slides, 

giving your presentation a polished, professional look.  
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About Transitions 

There are three categories of unique transitions to choose from, all of 

which can be found on the Transitions tab. 

 Subtle: These are the most basic types of transitions. They use simple 

animations to move between slides. 

 Exciting: These use more complex animations to transition between 

slides. While they're more visually interesting than Subtle transitions, 

adding too many can make your presentation look less professional. 

However, when used in moderation they can add a nice touch between 

important slides. 

 Dynamic Content: If you're transitioning between two slides that use 

similar slide layouts, dynamic transitions will move only 

the placeholders, not the slides themselves. When used correctly, 

dynamic transitions can help unify your slides and add a further level of 

polish to your presentation. 

 

 
Figure 5.6 (a) - Types of Slide Transitions 

To apply a transition: 

1. Select the desired slide from the Slide Navigation pane. This is the slide 

that will appear after the transition. 

2. Click the Transitions tab, then locate the Transition to This Slide group. 

By default, None is applied to each slide. 

3. Click the More drop-down arrow to display all transitions. 
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Figure 5.6 (b) - Transition Menu 

4. Click a transition to apply it to the selected slide. This will automatically 

preview the transition. 

 

You can use the Apply To All command in the Timing group to apply the 

same transition to all slides in your presentation. Keep in mind that this will 

modify any other transitions you've applied. 

 

 
Figure 5.6 (c) - Applying Selected Transition 

To preview a transition: 

You can preview the transition for a selected slide at any time using either of 

these two methods: 

 Click the Preview command on the Transitions tab. 

 
Figure 5.6 (d) - Transition Preview 

 Click the Play Animations command in the Slide Navigation pane. 

Modifying transitions 

To modify the transition effect: 

You can quickly customize the look of a transition by changing its direction. 

 

1. Select the slide with the transition you want to modify. 

2. Click the Effect Options command and choose the desired option. These 

options will vary depending on the selected transition. 
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Figure 5.6 (e) - Modifying applied transitions 

3. The transition will be modified, and a preview of the transition will 

appear. 

Some transitions do not allow you to modify the direction. 

To modify the transition duration: 

1. Select the slide with the transition you want to modify. 

2. In the Duration field in the Timing group, enter the desired time for 

the transition. In this example, we'll decrease the time to half a 

second—or 00.50—to make the transition faster. 

 

Figure 5.6 (f) - Transition Duration Settings 

To add sound: 

1. Select the slide with the transition you want to modify. 

2. Click the Sound drop-down menu in the Timing group. 

3. Click a sound to apply it to the selected slide, then preview the 

transition to hear the sound. 
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Figure 5.6 (g) - Applying Sounds within Transitions 

Sounds are best used in moderation. Applying a sound between every slide 

could become overwhelming or even annoying to an audience when 

presenting your slide show. 

To remove a transition: 

1. Select the slide with the transition you want to remove. 

2. Choose None from the Transition to This Slide group. The transition 

will be removed. 

 

Figure 5.6 (h) – Transition of slides 

To remove transitions from all slides, apply the None transition to a slide, 

then click the Apply to All command. 

Advancing slides 

Normally, in Slide Show view you would advance to the next slide by clicking 

your mouse or by pressing the spacebar or arrow keys on your keyboard. 

The Advance Slides setting in the Timing group allows the presentation to 

advance on its own and display each slide for a specific amount of time. This 

feature is especially useful for unattended presentations, such as those at a 

trade show booth.  
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To advance slides automatically: 

1. Select the slide you want to modify. 

2. Locate the Timing group on the Transitions tab. Under Advance 

Slide, uncheck the box next to On Mouse Click. 

3. In the After field, enter the amount of time you want to display the 

slide. In this example, we will advance the slide automatically after 1 

minute and 15 seconds, or 01:15:00. 

 
Figure 5.6 (i) - Advancing Slides Automatically 

4. Select another slide and repeat the process until all slides have the 

desired timing. You can also click the Apply to All command to apply 

the same timing to all slides. 

If you need to advance to the next slide before an automatic transition, you 

can always click the mouse or press the spacebar to advance the slides as 

normal. 

 

EXERCISE 

Multiple Choice Questions 

1. Extension of MS Power Point 2016 file is; 

 (a) .ppt  (b) .pwt  (c) .pptx (d) .docx 

2. A user can present his ideas in effective way using this program. 

 (a) MS Word   (b) MS Publisher 

 (c) MS Power Point  (d) None of these 

3. MS Power Point 2016 is a software of this type. 

 (a) Application   (b) Language translator 

 (c) Utility Program  (d) System 

4. This software is used to make presentation; 

 (a) Google slides  (b) Prezi 

 (c) MS Power Point  (d) All these 

5. The MS Power Point program has been developed specially for; 

 (a) Documentation  (b) Presentation 
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 (c) Graphic design  (d) Engineering drawing 

6. MS Power Point program can be open with........ ways.  

 (a) 1  (b) 2  (c) 4  (d) 5 

7. Horizontal strip under series of tabs in MS Power Point screen is 

called; 

 (a) Status bar   (b) Slide Pane 

 (c) Ribbon    (d) Scroll bar 

8. The area where slides appear in smaller size in MS PowerPoint is 

called; 

 (a) Ribbon   (b) Vertical scroll bar 

 (c) Slide pane   (d) Status bar 

9. Comments pane in MS Power Point screen is available on this bar. 

 (a) Title bar   (b) Status bar 

 (c) Scroll bar   (d) Slide pane 

10. Slide counter pane is displayed in MS Power Point screen. 

 (a) Below the slide pane  (b) Above the slide pane 

 (c) In slide show group  (d) None of these 

11. Slide of MS Power Point program can be zoomed up ......... %.  

 (a) 150%  (b) 200 % (c) 400% (d) 300% 

12. A new power point file may be of this type; 

 (a) Blank presentation   (b) Design template 

 (c) Either a or b   (d) None of these 

13. Shortcut key to insert new slide in MS Power Point presentation is; 

 (a) Ctrl + P (b) Ctrl + N (c) Ctrl + M (d) Shift + N 

14. Shortcut key to start slide show from first slide is; 

 (a) Ctrl + F5 (b) F5  (c) Shift + F5 (d) Alt + F5 

15. Shortcut key to start slide show from current slide is; 

 (a) F5  (b) Alt + F5 (c) Shift + F5 (d) Ctrl + F4 

16. This key is used to go to the previous slide. 

 (a) Page up    (b) Backspace 

 (c) Up arrow and left arrow  (d) Any of these 

17. This key from keyboard is used to go to the next slide. 

 (a) Page down    (b) Enter 

 (c) Right or down arrow  (d) Any of these 

18. The process to run the presentation is called; 
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 (a) Slide run    (b) Slide show 

 (c) Animation    (d) Transition  
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19. The dotted box in which user insert text, graphics or pictures is called 

 (a) Slide box    (b) Place holder 

 (c) Presentation box   (d) Any of a or c 

20. One page of MS Power Point file is called; 

 (a) Page  (b) Slide (c) File  (d) Slide show 

21. The slide that is used as a heading of a presentation is called; 

 (a) Heading slide   (b) Title slide 

 (c) Starting slide   (d) Initial slide 

22. The process of moving one slide to another slide is called; 

 (a) Animation (b) Shift (c) Transition (d) Drift 

23. " Slide show view” displays the slides in this sequence. 

 (a) Ascending slide number  (b) Descending slide number 

 (c) Even slide number   (d) Randomly 

24. To exit the slide show, this key is pressed from keyboard. 

 (a) End  (b) Home (c) Esc  (d) Enter 

25. Specific visual or audio effect that appears during slide transitions is 

called; 

 (a) Slide animation   (b) Slide transition 

 (c) Both a & b    (d) None of these 

 

ANSWERS KEY 

 

 

Short Questions 

1. What is Power point? 

2. What is a presentation? 

3. Write two names of programs used for making presentations other than 

MS Power Point. 

4. What is the use of hand out options of MS Power Point? 

5. What is quick print in MS Power Point? 
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6. What is a slide? 

7. What is slide pane? 

8. What is the location and purpose of comment pane in MS Power 

Point? 

9. What is notes area of MS Power Point and for which purpose it is 

used. 

10. What is meant by slide layout? 

11. What is place holder in Power Point? 

12. What is meant by title slide? 

13. Write short cut key to start slide show from 1st slide and current active 

slide. 

14. What is meant by slide transition? 

15. What is meant by slide animation? 

16. Write method of deleting a slide. 

17. What is meant by theme in power point? 

18. How a new slide can be inserted in a presentation? 

19. What is meant by slide show in power point? 

20. Which keys of keyboard are used to run the slide show from start 

toward end? 

21. Which keys are used go on previous slide during slide show. 

22. For which purpose, the slide sorter option is used in power point. 

23. How a slide show is terminated? 

24. What is meant by template in power point? 

25. Write names of view buttons of MS Power Point 2016. 

26. Write names of contents of title bar of MS Power Point 2016. 

 

Long Questions 

1. Write introduction of components of MS Power Point 2016 screen. 

2. Write method of creating new presentation and saving it in MS Power 

Point 2016. 

3. What is meant by place holder in MS PowerPoint? Write method of 

changing its place. 

4. Write method of filling color and changing boarder line color of text 

box in MS Power Point 2016.  
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5. What is meant by a theme? Write method of applying different themes 

on slides of MS Power Point 2016. 

6. Define slide transition. Write method of applying different transitions 

on slides in MS Power Point 2016. 

7. Write method of starting slide show in MS Power Point 2016. 

8. What is meant by slide layout? Write its different types. 
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C H A P T E R  6  

 

Programming Language 

 

G e n e r a l  O b j e c t i v e :  

Understand basic concepts of C++ programming language. 

 

 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to:  

       

 Define program, programming, programmer, and programming 

languages.  

 Classify computer programming languages.  

 Describe briefly computer languages. 

 Describe C++ programming language and its advantages. 

 Explain arithmetic operations (addition, multiplication, subtraction, 

division etc.) 

 Explain logical operations (AND, OR, NOT, Equal to, etc.) 

 Explain the basics of loops for repetitive operations. 

 Explain the components of Flow-Charts for simple computer program.  
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PROGRAM, PROGRAMMING, PROGRAMMER, 

AND PROGRAMMING LANGUAGES 

6.1 PROGRAM 

A computer program is a collection of instructions that is written in 

any computer to perform a specific task. 

Example: 

A program written in C - Language. 

Define programming, programmer? 

Define Programming: 

The process of developing and constructing various sets of instructions to 

enable a computer to do a specific task is called computer programming. 

Define Programmer: 

A programmer is mostly a person, an individual that writes/creates computer program 

or computer in specific computer language. 

6.2 Classify computer programming languages. 

Computer programming Language are classified in two level 

1. Low-level language 

2. High-level language 

1) Low – level Language are further divided in two levels 

1. Machine Language 

2.  Assembly language 

Machine Language 

The machine-level language is a language that consists of a set of instructions 

that are in the binary form 0 or 1 and it was developed to interact with first 

generation of computer. Computers can understand only machine instructions, 

which are in binary digits, i.e., 0 and 1, so the instructions given to the 

computer can be only in binary codes. Creating a program in a machine-level 

language is a very difficult task as it is not easy for the programmers to write 

the program in machine instructions. 

Assembly Language 

This is the second generation programming language. It is a development on the 

machine language, where instead of using only numbers, we use English words, 

names, and symbols. It is the most basic computer language necessary for any 

processor. 

https://en.wikipedia.org/wiki/Instruction_set
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2] High Level Language 

When we talk about high level languages, these are programming languages. 

There are so many types of computer programming language, some examples 

are PASCAL, FORTRAN, C++ etc. 

The important feature about such high level languages is that they allow the 

programmer to write programs for all types of computers and systems. Every 

instruction in high level language is converted to machine language by language 

translators that are compiler or interpreters. High level languages are further 

divided into three type: 

1. Scripting Languages 

2. Object-Oriented Languages 

3. Procedural Programming Language 

Scripting Languages 

Scripting languages are constructed in such way that they allows execute one 

command at a time. Scripting languages are easier to learn and execute than 

compiled languages. Some examples are AppleScript, JavaScript and Pearl etc. 

Object-Oriented Languages 

These are high level languages that focus on the ‘objects’ rather than the 

‘actions’. To accomplish this, the focus will be on data than logic. The reasoning 

behind is that the programmers really cares about the object they wish to 

manipulate rather than the logic needed to manipulate them. Some examples 

include Java, C+, C++, Python and Swift etc. 

Procedural Programming Language 

This is a type of programming language that has well-structured steps and 

complex procedures within its programming to compose a complete program. It 

has a systematic order functions and commands to complete a task or a program. 

FORTRAN, ALGOL, BASIC, COBOL is some examples. 

6.3 Describe briefly computer languages.  

6.3.1 Human Language 

To understand language is to understand the world. We use language as a 

means of communicating ideas of the world to each other and to ourselves. To 

convey our message to others or to receive other message we need to know a 

language.   
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Human language are different than computer languages. For a computer 

system to truly understand what we want, it’ll need to experience the same 

events we do. It needs to understand emotion, it needs to know what it’s like to 

have our senses, and it needs to learn to speak and communicate organically 

the way we do. To understand more about computer language we read a brief 

discussion about computer language too. 

6.3.2 Computer Language 

In computer science, computer languages are used to communication 

with a computer. Simply we can say Computer Languages are used to perform 

some task from computer. All computer language have their own rules, their 

own way to construct a program, coding is different in different language . 

Just as many human-based languages exist, there are as many computer 

programming languages. Computer language are human friendly. If we want 

to talk someone whose language is English, Spanish or German we need to 

learn their language first. Same is case with computer language. The portion 

of the language that a computer can understand is called “Object code” which 

is written in “binary code” .Translating programming language into human 

understandable form is known as is known as source program. Each language, 

from C Language to Python, has its own distinct features, we must know these 

language. Though they have common feature too. Here we discuss some most 

common languages. 

6.3.2.1 C Language 

C Language is a structure-oriented, middle-level programming 

language mostly used to develop low-level applications C Language is used to 

develop systems applications that are integrated into operating systems such 

as Windows, UNIX and Linux. Applications include graphics packages, word 

processors, spreadsheets, operating system development, database systems, 

compilers and assemblers, network drivers and interpreters. 

6.3.2.2 C + + Language 

C++ is a general purpose, object-oriented, middle-level programming 

language and is an extension of C language, which makes it possible to code 

C++ in a “C style. The C++ language is used to create computer programs and 

packaged software, such as games, office applications, graphics and video 

editors and operating systems. 
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6.3.2.3 HTML 

HTML is the standard markup language used to create web pages; it 

ensures proper formatting of text and images (using tags like <HTML>) so 

that Internet browsers can display them in the ways they were intended to 

look. 

6.3.2.4 Java 

Java is a general-purpose, object-oriented, high-level programming language with 

several featur7es that make it ideal for web-based development 

6.3.2.5 OOP languages 

 OOP Languages (Object-Oriented Languages) provide us with clear 

modular structure for the programs which makes it good for defining abstract 

data types. 

6.3.2.6 Pascal Language 

  Pascal is a teaching language, there are few industrial programs that 

are written in Pascal, It tends to use the keywords instead of C-style braces 

and the symbols, so, it is easier for the beginners to understand than 

languages like C++. 

6.3.2.7 PHP is designed for a rapid website development. It is easy to link to 

the databases, generate HTTP headers. It contains a simple set of basic 

components that allow the programmer to quickly get up to speed. 

6.3.2.8 FORTRAN 

FORTRAN stands for Formula Translator and it is still used by the scientists 

as it allows the variables of any size up to the memory limit of the machine. 

6.3.2.9 Go 

GO is a general purpose, flexible language that facilitates the creation 

of applications. 

6.3.2.10 Ruby on Rails 

Ruby on Rails allows you to design web applications quickly. 

6.3.2.11 Python 

Python is used in a wide variety of contexts and on the web has 

technical advantages.  
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6.3.2.12 JavaScript 

Java Script s used on the client’s side and can be extended to the server 

for different functions. 

6.4 Describe C++ programming language and its advantages. 

C++ is an object-oriented programming language and includes concepts like 

classes, inheritance, polymorphism, data abstraction, and encapsulation which 

allow code reusability and makes programs very maintainable. C++ use multi-

paradigm programming. The Paradigm means the style of programming. 

Some features and advantages of C++ is given below 

6.4.1 Advantages of C++ are: 

1. Object-oriented 

One of the biggest advantages of C++ is the feature of object-oriented 

programming which includes concepts like classes, inheritance, 

polymorphism, data abstraction, and encapsulation that allow code reusability 

and makes a program even more reliable. 

Not only this, it helps us deal with real-world problems by treating data as an 

object. C lacked this feature and hence it was created, proving to be of great 

significance. 

 2. Multi-paradigm 

C++ is a multi-paradigm programming language. The term “Paradigm” refers 

to the style of programming. It includes logic, structure, and procedure of the 

program. Generic, imperative, and object-oriented are three paradigms of 

C++. 

Low-level Manipulation 

Since C++ is closely associated with C, which is a procedural language 

closely related to the machine language, C++ allows low-level manipulation 

of data at a certain level. Embedded systems and compiler are created with the 

help of C++. 

3. Memory Management 

C++ gives the programmer the provision of total control over memory 

management. This can be considered both as an asset and a liability as this 

increases the responsibility of the user to manage memory rather than it being 

managed by the Garbage collector. This concept is implemented with the help 

of DMA (Dynamic memory allocation) using pointers. 
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4. Large Community Support 

C++ has a large community that supports it by providing online courses and 

lectures, both paid and unpaid. Statistically speaking, C++ is the 6th most 

used and followed tag on Stack Overflow and GitHub. 

5. Compatibility with C 

C++ is pretty much compatible with C. Virtually; every error-free C program 

is a valid C++ program. Depending on the compiler used, every program of 

C++ can run on a file with .cpp extension. 

6.5 Arithmetic operations (addition, multiplication, 

subtraction, division etc. 

Arithmetic Operators  

`Arithmetic operators area symbol that performs mathematical operation on 

data .C language provides many arithmetic operators. Following is a list of all 

arithmetic operators used in C language. 

Arithmetic operators used in “C” language. 

 

Operation Symbol Description 

Addition + Adds two numbers 

Subtraction - Subtract one value from another value 

Multiplication * Multiplies two values 

Division / Divides one value by another value 

Modulus % 
Gives the remainder of division of two 

integers 

 

In C language these arithmetic operators are necessary to perform arithmetic 

calculation like addition, subtraction, multiplication and these are explained 

here with the help of C language program 

Program 1: (Addition) 

Write a program that inputs two integer 

numbers and calculates sum of two 

numbers. 

Procedure: 

#include<stdio.h> 

Output of the Program: 

Enter Num1=15 

Enter Num2=20 

Sum=35 



COMP-162 COMPUTER APPLICATIONS 

 

 
227 | P a g e  

 

Output of the program: 

Enter Num1=15 

Enter Num2=20 

Division=1.3333 

#include<conio.h> 

void main () 

{ 

int num1, num2,sum; 

printf(“Enter Num1="); 

Scanf(“%d”,&num1) 

printf(“/n Enter Num2=");   ///n use for new line 

Scanf(“%d”,&num2) 

sum=num1+num2; 

printf("/n sum=",sum); 

getch(); 

 } 

 

Program 2 (subtraction) 

 

Write a program that inputs two integer numbers from the user and calculates 

the Subtraction of numbers. 

Procedure: 

#include<stdio.h> 

#include<conio.h> 

void main () 

{ 

int num1, num2,sub; 

printf(“Enter Num1="); 

Scanf(“%d”,&num1) 

printf(“/n Enter Num2=");   ///n use for new line 

Scanf(“%d”,&num2) 

sub=num2-num1; 

printf("/n Subtract=", sub); 

getch(); 

} 

Program 3 (Division) 

Write a program that inputs two integer 

numbers from user and calculates the 

Division of the numbers.  

Output of the Program: 

Enter Num1=15 

Enter Num2=20 

Subtract=5 
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Output of the 

program: 

a+b=15 

a-b=5 

a*b=50 

a/b=2 

a%b= 0 

 

Procedure: 

#include<stdio.h> 

#include<conio.h> 

void main () 

{ 

float num1, num2,Div; 

printf(“Enter Num1="); 

Scanf(“%d”,&num1) 

printf(“/n Enter Num2=");   ///n use for new line 

Scanf(“%d”,&num2) 

Div=num2/num1; 

printf("/n Division=", Div); 

getch(); 

} 

Program 4 (Product of the numbers.) 

Write a program that inputs two numbers from user and calculates the Product 

of the numbers. 

Procedure: 

#include<stdio.h> 

#include<conio.h> 

void main () 

{ 

int num1, num2,p; 

printf(“Enter Num1="); 

Scanf(“%d”,&num1) 

printf(“/n Enter Num2=");   ///n use for new line 

Scanf(“%d”,&num2) 

p=num1*num2; 

printf("/n Product =", p); 

getch(); 

} 

Program 5 

(mathematical operations on two 

variables) 

Write a program that performs all mathematical operations on two variables. 

Output of the 

program: 

Enter Num1=15 

Enter Num2=20 

Product=300 
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Procedure: 

#include<stdio.h> 

#include<conio.h> 

void main () 

{ 

int  a, b; 

a=10; 

b=5; 

clrscer( ); 

printf(“a+b=%d \n”, a+b); 

printf(“a-b=%d \n”, a-b); 

printf(“a*b=%d \n”, a*b); 

printf(“a/b=%d \n”, a/b); 

printf(“a%b=%d \n”, a%b); 

getch( ); 

} 

Program 6 Write aprogram  to calculate sum, average, and product of all 

numbers 

Write a program that inputs 4 numbers and calculate the sum, average, and 

product of all the numbers. 

Procedure: 

#include<stdio.h> 

#include<conio.h> 

void main () 

{ 

inta,b,c,d,sum,product; 

Float avg; 

clrscer ( ); 

printf(“Enter 4 numbers:”); 

scanf(“%d %d %d %d”,&a,&b,&c,&d);  

Output of the program: 

Enter 4 numbers: 1 2 3 4  

Sum of all the numbers: 10 

Product of all the numbers: 24 

Average of all the numbers: 6 
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sum=a+b+c+d; 

product=a*b*c*d; 

avg=sum/4.0; 

printf(“Sum of all the numbers: %d \n”, sum); 

printf(“product of all the numbers : %d \n”, product); 

printf(“Average of all the numbers: %f”, avg); 

getch( ); 

} 

6.6 Explain logical operations (AND, OR, NOT, Equal to, etc.) 

Logical Operators 

C allows usage of three logical operators that are  &&, || and !. 

These are to be read as ‘AND’ ‘OR’ and ‘NOT’ respectively. 

There are several things to note about these logical operators. Most obviously, 

two of them are composed of double symbols: || and &&. Don’t use the single 

symbol | and &. 

The first two operators, &&and ||, allow two or more conditions to be 

combined in an if statement. We explain it with the help of a program. 

Consider the following example. 

Example 2.4: 

The marks obtained by a student in 5 different subjects are input through the 

keyboard. 

The student gets a division as per the following rules are given: 

Percentage above or equal to 60 - First division 

Percentage between 50 and 59 - Second division 

Percentage between 40 and 49 - Third division 

Percentage less than 40 - Fail 

Program 1: Write a program to calculate the division obtained by the 

student and also used logical operators in the program. 

There are two ways in which we can write a program for this example. These 

methods are given below.  
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First Method 

main( ) 

{ 

int m1, m2, m3, m4, m5, per ; 

printf ( "Enter marks in five subjects " ) ; 

scanf ( "%d %d %d %d %d", &m1, &m2, &m3, &m4, &m5 ) ; 

per = ( m1 + m2 + m3 + m4 + m5 ) / 5 ; 

if ( per >= 60 ) 

printf ( "First division ") ; 

else 

{ 

if ( per >= 50 ) 

printf ( "Second division" ) ; 

else 

{ 

if ( per >= 40 ) 

printf ( "Third division" ) ; 

else 

printf ( "Fail" ) ; 

} 

} 

} 

2
nd

 Method 

main( ) 

{ 

int m1, m2, m3, m4, m5, per ; 

printf ( "Enter marks in five subjects " ) ; 

scanf ( "%d %d %d %d %d", &m1, &m2, &m3, &m4, &m5 ) ; 

per = ( m1 + m2 + m3 + m4 + m5 ) / 5 ; 

if ( per >= 60 ) 

printf ( "First division" ) ; 

if ( ( per >= 50 ) && ( per < 60 ) ) 

printf ( "Second division" ) ; 

if ( ( per >= 40 ) && ( per < 50 ) ) 

printf ( "Third division" ) ; 
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if ( per < 40 ) 

printf ( "Fail" ) ; 

} 

6.7 Explain the basics of loops for repetitive operations. 

Loops or iteration statement   

A loop is a statement or set of statements which is executed repeatedly. A 

loop is used using condition. The repetition is done until condition becomes 

condition true. A loop declaration and execution can be done in following 

ways. 

· Check condition to start a loop 

· Initialize loop with declaring a variable. 

· Executing statements inside loop. 

· Increment or decrement of value of a variable. 

Followings are the different types of loop statements used in C. 

1. while loop 

2. do- while loop  

3. for loop 

1. The while loop: 

It is often the case in programming that you want to do something a fixed 

number of times. Perhaps you want to calculate gross salaries of ten different 

persons, or you want to convert temperatures from centigrade to Fahrenheit 

for 15 different cities. 

The condition being tested may use relational or logical operators as shown in 

the following examples: 

while( b < 15 || c < 20 ) ) 

The other example to use relational or logical operators can be as  

while ( i < = 10 )   

while ( i >= 5 && j < = 10 ) 

− The statement within a loop may be a single line or a block of statements.In 

first case the  

Parentheses are optional.  
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For example 

while ( i <= 10 ) 

i = i + 1; 

is same as 

while ( i <= 10) 

{ 

i = i + 1 ; 

} 

As a rule the while must test a condition that will eventually become false, 

otherwise the loop would be executed forever. 

Procedure   

#include<stdio.h> 

#include<conio.h> 

main( ) 

{ 

int i = 1 ; 

while( i <= 10) 

printf (“%d\n”, i); 

i = i+ 1; 

} 

getche(); 

} 

It is not necessary that loop counter will always perform as a increment 

operator, we can even use this operator as a decrement operator and still 

manage to get the body of the loop executed repeatedly, this is shown below 

#include<stdio.h> 

#include<conio.h> 

main( ) 

{ 

int i = 10 ; 

while ( i > = 10) 

{ 

printf ( “\n we are Pakistani”); 

i = i – 1; 

} 
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getche(); 

} 

It is not necessary that a loop counter must only be an int ,it can be a float 

main( ) 

{ 

float a = 10.5 ; 

while ( a < = 10.8 ) 

{ 

printf ( “\n in dark something is shining”); 

printf ( “.....and sparkling”); 

a = a + 0.1; 

} 

}   

2. The For Loop 

The ‘for’ is known as the most popular looping instruction. The ‘for’ allows 

us to specify three things about a loop in a single line that are initial value, 

final value and its increment/decrement. 

a) Setting a loop counter to an initial value. 

b) Testing a loop counter to determine whether its value has reached 

the desired repetition result. 

c) Increasing the value of loop counter each time the program 

segment within the loop has executed. 

Program 1: Write a program in C language that display numbers on 

screen using For-Loop. 

#include<stdio.h> 

#include<conio.h>m 

main( ) 

{ 

int i ; 

for ( i = 1 ; i <= 10 ; ) 

{ 

printf ( "%d\n", i ) ; 

i = i + 1 ; 

} 

getche(); 
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} 

 

 

 

 

 

Here, the incrimination is done within the body of the for loop and not in the 

for statement. Note that in spite of this the semicolon after the condition is 

necessary. 

Method 2: 

#include<stdio.h> 

#include<conio.h> 

main( ) 

{ 

int i = 1 ; 

for ( ; i <= 10 ; i = i + 1 ) 

printf ( "%d\n", i ) ; 

} 

getche(); 

} 

 

Note that the initialization, testing and incrementation of loop counter is done 

in the for statement itself. Instead of i = i + 1, the statements i++ or i += 1 can 

also be used. 

Method 3: 

#include<stdio.h> 

#include<conio.h> 

main( ) 

{ 

int i ; 

for ( i = 1 ; i <= 10 ; ) 

{ 

printf ( "%d\n", i ) ; 

i = i + 1 ; 

} 

Output 

1 2 3 4 5 6 7 8 9 10 

Output 

1 2 3 4 5 6 7 8 9 10 
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getche(); 

} 

 

 

 

 

 

 

Here, the incrementation is done within the body of the for loop and not in the 

for statement. Note that in spite of this the semicolon after the condition is 

necessary. 

Method 4: 

main( ) 

{ 

int i = 1 ; 

for ( ; i <= 10 ; i = i + 1 ) 

printf ( "%d\n", i ) ; 

} 

Here the initialization is done in the declaration statement itself, but still the 

semicolon before the condition is necessary. 

Method 5: 

main( ) 

{ 

int i = 1 ; 

for ( ; i <= 10 ; ) 

{ 

printf ( "%d\n", i ) ; 

i = i + 1 ; 

} 

} 

Here, neither the initialization, nor the incrimination is done in the for 

statement, but still the two semicolons are necessary.  

Output 

1 2 3 4 5 6 7 8 9 10 
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6.8 Explain the components of Flow-Charts for simple computer program 

A flowchart is a type of diagram that represents a workflow or process. 

The flowchart shows the steps as boxes of various kinds, and their order by 

connecting the boxes with arrows. This diagrammatic representation 

illustrates a solution model to a given problem. 

Sr.No Symbols Purpose Description 

1  Flow line Indicates the flow 

of logic by 

connecting 

symbols. 

2 

 

Terminal(Stop/Start) Represents the start 

and the end of a 

flowchart. 

3 

 

Input/Output Used for input and 

output operation. 

4 

 

Processing Used for arithmetic 

operations and data-

manipulations. 

5 

 

Decision Used for decision 

making between 

two or more 

alternatives. 

6 

 

On-page Connector  

Used to join 

different flowline 

 

 

7 

 

Off-page Connector Used to connect the 

flowchart portion on 

a different page. 

 

8 

 

Predefined 

Process/Function 

Represents a group of 

statements 

performing one 

processing task. 
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Examples of flowcharts in programming 

1. Add two numbers entered by the user. 

 

 
Figure 6.1 Flowchart to add two numbers 

3. Find the largest among three different numbers entered by 

the user. 

 

Figure 6.2 Flowchart to find the largest among three numbers. 
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EXERCISE 

Short Questions 

Q #1What is the key features in the C programming language? 

Answer: Features are as follows: 

 Portability: It is a platform-independent language. 

 Modularity: Possibility to break down large programs into small 

modules. 

 Flexibility: The possibility of a programmer to control the language. 

 Speed: C comes with support for system programming and hence it 

compiles and executes with high speed when compared with other high-

level languages. 

 Extensibility: Possibility to add new features by the programmer. 

Q #2What is the basic data types associated with C? 

Answer: 

 Int – Represent the number (integer) 

 Float – Number with a fraction part. 

 Double – Double-precision floating-point value 

 Char – Single character 

 Void – Special purpose type without any value. 

Q #3What is the description for syntax errors? 

Answer: The mistakes/errors that occur while creating a program are called 

syntax errors. Misspelled commands or incorrect case commands, an incorrect 

number of parameters in calling method /function, data type mismatches can be 

identified as common examples for syntax errors. 

Q #4What is the process to create increment and decrement statement in C? 

Answer: There are two possible methods to perform this task. 

 Use increment (++) and decrement (-) operator. 

Example When x=4, x++ returns 5 and x- returns 3. 

 Use conventional + or – sign. 

Example When x=4, use x+1 to get 5 and x-1 to get 3. 

Q #5What is reserved words with a programming language? 

Answer: The words that are a part of the standard C language library are 

called reserved words. Those reserved words have special meaning and it is not 

possible to use them for any activity other than its intended functionality.  
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Example: void, return int. 

Q #6What is the difference between ++a and a++? 

Answer: ‘++a”  is called prefixed increment and the increment will happen 

first on a variable. ‘a++’ is called postfix increment and the increment 

happens after the value of a variable used for the operations. 

Q #7 Describe the difference between = and == symbols in C 

programming? 

Answer: ‘==’ is the comparison operator which is used to compare the value 

or expression on the left-hand side with the value or expression on the right-

hand side. 

‘=’ is the assignment operator which is used to assign the value of the right-

hand side to the variable on the left-hand side. 

Q #8What is the general description for loop statements and available 

loop types in C? 

Answer: A statement that allows the execution of statements or groups of 

statements in a repeated way is defined as a loop. 

There are 4 types of loop statements in C. 

 While loop 

 For Loop 

 Do…While Loop 

 Nested Loop 

Q #9What is a nested loop? 

Answer: A loop that runs within another loop is referred to as a nested loop. 

The first loop is called the Outer Loop and the inside loop is called the Inner 

Loop. The inner loop executes the number of times defined in an outer loop. 

Q #10What is the explanation for prototype function in C? 

Answer: Prototype function is a declaration of a function with the following 

information to the compiler. 

 Name of the function. 

 The return type of the function. 

 Parameters list of the function. 

int Sum(int, int); 

In this example Name of the function is Sum, the return type is the integer 

data type and it accepts two integer parameters.  
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Q#11 Define an algorithm. 

Answer: An algorithm is a precise specification of a sequence of instructions 

to be carried out in order to solve a given problem. Each instruction tells what 

task is to be performed. Actually an algorithm is a series of mathematical 

steps written in simple English sentence. 

Q#12What is the difference between while and do-while statement? 

Answer: The only difference between do-while and while is that the while 

statement evaluates its condition at the top of the loop so that if it is false then 

the statements within the loop will not execute; whereas the do-while 

evaluates its condition at the bottom of the loop so that the statements within 

the do block are always executed at least once. 

Q#13How the static variables are defined? 

Answer: Static variables are defined within a function in the same manner as 

automatic variables, except that the variable declaration must begin with 

the static keyword.  

Q#14Which of the following operators is incorrect and why? ( >=, <=, <>, 

==) 

Answer: <> is incorrect. While this operator is correctly interpreted as 

"not equal to" in writing conditional statements, it is not the proper operator to 

be used in C programming. Instead, the operator  !=  must be used to indicate 

"not equal to" condition. 

Q#15 Compare and contrast compilers from interpreters. 

Answer: Compilers and interpreters often deal with how program codes are 

executed. Interpreters execute program codes one line at a time, while 

compilers take the program as a whole and convert it into object code, before 

executing it. The key difference here is that in the case of interpreters, a 

program may encounter syntax errors in the middle of execution, and will stop 

from there. On the other hand, compilers check the syntax of the entire 

program and will only proceed to execution when no syntax errors are found. 

Q#16 Can the curly brackets { } be used to enclose a single line of code? 

Answer: While curly brackets are mainly used to group several lines of codes, 

it will still work without error if you used it for a single line. Some 

programmers prefer this method as a way of organizing codes to make it look 

clearer, especially in conditional statements.  
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Q#17What are header files and what are its uses in C programming? 

Answer: Header files are also known as library files. They contain two 

essential things: the definitions and prototypes of functions. C programming is 

actually functions that are defined from within each header files. Each header 

file contains a set of functions. For example: stdio.h is a header file that 

contains definition and prototypes of commands like printf and scanf. 

Q#18What is syntax error? 

Answer: A syntax error is an error in the source code of a program. Since 

computer programs must follow strict syntax to compile correctly, any aspects 

of the code that do not conform to the syntax of the programming language 

will produce a syntax error. 

Q#19 What are variables and in which way is it different from constants? 

Variables are the terms which can change or vary over time. It does not 

remain constant, unlike constant. For example, the height and weight of a 

person do not remain constant always, and hence they are variables. 

The difference between variables and constants is that variables can change 

their value at any time but constants can never change their value.  

 Both will also hold a particular value.  Values held by a variable can be 

changed. Constants are given values at one time only, placed at the beginning 

of a program. This value is not altered in the program. 

 

M u l t i p l e  C h o i c e s  

Q u e s t i o n s  

1. Who is known as the father of C Language? 

1. James A. Sosling 

2. Vjarne Stroustrup 

3. Dennis Ritchie 

4. Dr. E. F. Codd 

2. C Language was developed in the year ____ 

1. 1970 

2. 1975 

3. 1980 

4. 1985 
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3. Which one is not a reserve keyword in C Language? 

1. auto 

2. main 

3. case 

4. register 

4. A C variable name can start with a ____ 

1. Number 

2. Plus Sign (+) 

3. Underscore 

4. Asterisk (*) 

5. Prototype of a function means _____ 

1. Name of Function 

2. Output of Function 

3. Declaration of Function 

4. Input of a Function 

6. Name the loop that executes at least once. 

1. For 

2. If 

3. do-while 

4. While 

7. C Language developed at 

1. AT & T’s Bell Laboratories of USA in 1972 

2. AT & T’s Bell Laboratories of USA in 1970 

3. Sun Microsystems in 1973 

4. Cambridge University in 1972 

8. Which of the following are fundamental control structures? 

1. Iteration 

2. Branching 

3. Sequencing 

4. All the above   
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9. The&& and || operators compare two 

1. boolean values 

2. boolean value 

3. numeric values 

4. numeric value 

10. C Language program are converted to machine language with 

the help of; 

1. Compiler 

2. Editor 

3. Interpreter 

4. Linker 

11. C variable cannot start with  

1. An alphabet 

2. Numeric value 

3. Symbol 

4. Both 2 and 3 

12. Which of the following shows correct hierarchy in arithmetic 

operators? 

1. + - * / 

2. / * + - 

3. */+- 

4. -+*/ 

13. An array element are always stored in _____ memory location 

1. Sequential 

2. Random 

3. Both random and sequential  

4. None of these 

 

14. Bitwise operators can operate upon 

1. 1.Double and chars 

2. 2.Float and ints 

3. Float and double 

4. Ints and chars  
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15. Which was the first computer language for an electronic device? 

1. Machine Language 

2. Assembly Language 

3. Short Code 

4. FORTRAN 

16: Visual Basic (VB) was derived from which of the following? 

1. BASIC 

2. ALGOL 

3. PERL 

4. C++ 

17. FORTRAN was developed at ____? 

1. Apple 

2. Sun Technology 

3. IBM 

4. Intel 

18. What will be the output of the following statement ? 

int a=10; printf("%d &i",a,10); 

1. error 

2. 10 

3. 100 

4. none of these 

19. What will be the output of the following statements ? 

int i = 3; 

printf ("%d%d",i,i++); 

1. 1.34 

2. 43 

3. 44 

4. 33 

20. Which one of the following is not a linear data structure? 

1. Array 

2. Binary Tree 

3. Queue 

4. Stack  
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ANSWER KEYS 

1 3 11 4 

2 1 12 3 

3 2 13 1 

4 3 14 4 

5 3 15 3 

6 3 16 1 

7 1 17 3 

8 4 18 4 

9 2 19 2 

10 1 20 2 
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C H A P T E R  7  

I N T E R N E T  &  E M A I L  

G e n e r a l  O b j e c t i v e :  

 

Understand basic concepts of Internet and Email. 

 

S p e c i f i c  o b j e c t i v e s :  

After studying this chapter students should be able to: 

 

1. Learn about Internet & browser window  

2. Search, Save and Print a page from internet  

3. Create, Read & Send E-Mail  

4. Learn about Drop Box / Online/ Sky drive/ Cloud data etc.  

5. Work on File attachment.  

6. Upload and download file(s) and software(s)  

7. Explain some advance features over the internet and search engines  

8. Differentiate Internet, Intranet and Extranet  
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7.1 - LEARN ABOUT INTERNET & BROWSER 

WINDOW 

“The network of networks around the whole world is called Internet.” 

OR “Internet can be defined as a huge collection of millions of computers, all 

linked together on a computer network. This is a global network that allows 

all of the computers to communicate with one another”. Due to this network 

all computers can communicate with each other. 

The Internet started in the 1960s as a way for government researchers 

to share information. Computers in the '60s were large and immobile and in 

order to make use of information stored in any one computer, one had to 

either travel to the site of the computer or have magnetic computer tapes sent 

through the conventional postal system. 

Another catalyst in the formation of the Internet was the heating up of 

the Cold War. The Soviet Union's launch of the Sputnik satellite spurred the 

U.S. Defense Department to consider ways information could still be 

disseminated even after a nuclear attack. This eventually led to the formation 

of the ARPANET (Advanced Research Projects Agency Network), the 

network that ultimately evolved into what we now know as the Internet. 

ARPANET and the Defense Data Network officially changed to the TCP/IP 

standard on January 1, 1983, therefore, January 1, 1983 is considered to be the 

official birthday of the Internet. 

 

Figure 7.1 (a) - Brief History of the Internet 
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DESCRIBE HOW INTERNET WORKS 

To view a web page from your browser, the following sequence happens: 

1. You either type an address (URL) into your "Address Bar" or click on 

a hyperlink. 

2. Your browser sends a request to your ISP server asking for the page. 

3. Your ISP server looks in a huge database of internet addresses and 

finds the exact host server which houses the website in question, then 

sends that host server a request for the page. 

4. The host server sends the requested page to your ISP server. 

5. Your ISP sends the page to your browser and you see it displayed on 

your screen. 

 

Figure 7.2 (b) - 3D Internet Architecture 

A home computer may be linked to the Internet using a phone – line 

ISP. A computer in a business or university will usually have a network 

interface card (NIC) that directly connects it to a Local Area Network (LAN) 

inside the business. 

The business can then connect its LAN to an ISP using a high speed 

phone line like a T1 line. A T1 line can handle approximately 1.5 million bits 

per second, while a normal phone line using a modern can typically handle 

30,000 to 50,000 bits per second.  



COMP-162 COMPUTER APPLICATIONS 

 

 
250 | P a g e  

 

ISPs then connect to larger ISPs, and the largest ISPs maintain fiber – 

optic backbones” for an entire region. Backbones around the world are 

connected through fiber-optic lines, undersea cables or satellite links. In this 

way, every computer on the internet is connected to every other computer on 

the Internet. Internet is a data communication system. Through this system 

millions of computers in the world have linked together. In only one second 

several thousands of bytes travel on the Internet. This extremely large network 

of computer networks combines all the three major methods of 

communications i.e 

1. Earth-based telephone lines (WAN system) 

2. Sea-based Fiberglass cables (Submarine cables) 

3. Ether based satellite communications systems (Cyber Space) 

 

 

Figure 7.1 (c) - Wide Area Network (WAN) 

The internet is not a real entity or a place that has building or a place. 

Instead, it is the result of a collaborative effort of people and computers 

throughout the world. The end result is an electronic link to the world of 

information and entertainment. 

In simply words, the Internet is a network of connected computers that 

provide us a facility of exchange data, messages, and files with other 

computers that are connected to the Internet. The Internet has grown rapidly 

since 1990. 
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To understand how the Internet works, we need to have sufficient 

knowledge of “Networking” i.e. the connection of different computers in 

network. 

7.2 - SEARCHING, SAVING AND PRINT A PAGE 

FROM INTERNET 

Searching: 

Searching the internet can be a frustrating business. You enter a word or a 

phrase into a search engine and up comes a stack of irrelevant information. 

What you need is the ability to refine your search to get exactly what you 

want. In this article, we explore seven steps that you can take to pinpoint 

specific information online. 

 Vary Your Search Engine: 

Search engines sort through about 625 million active websites to provide you 

with content. You may favor one, but don't let habit restrict you. No search 

engine is perfect, and they all have different blind spots. 

 Use Specific Keywords 

Keywords are the terms that you use to find content on the internet. Making 

your keywords as specific as possible will help your search engine to track 

down the information that you want. 

Say, for example, that you want to find a local supplier that can design an 

exhibition stand for your company. If you type stand design into your search 

engine, the results will include many pages about other types of stand, 

whereas typing exhibition stand designer will return a more concise range of 

companies. 

You can further refine your search by including other specific keywords. If 

you add your location, for example, you'll likely find someone local. 

 Use Quotation Marks 

Enclosing a search term within quotation marks prompts the search engine to 

search for that specific word or phrase. If the term is a single word, using 

quotation marks will cut out stemmed variations of it. For example, if you 

search for the word director, you'll likely receive a lot of results for direct, 

direction, directions, and so on, too. Typing "director" (with quotation marks), 

however, will ensure that you only get results for that stem word.  
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If the search term is a phrase, your search will be for that specific phrase, 

rather than for all the component words as individual items. So, for example, 

if you search for the phrase director of human resources, without quotation 

marks, your search will return results based on all of the words in the phrase 

(except of, which is a stop word.) Surrounding the term with quotation marks, 

however, will generate results that feature this specific term. 

 Refine Your Search Using Operators 

Other characters or terms, known as operators, allow you to narrow down 

your internet search in more targeted ways. We explore a few, below: 

o Wildcard Searches: use the * symbol as a placeholder for another 

word. For example, searching for * man in the world returns results for 

the richest man in the world, the tallest, the oldest, and so on. Wildcard 

searches are also useful when, for example, you don't know the full 

text of a quote. 

o Combination Searches: the OR operator enables you to search for 

two or more terms simultaneously, and is most useful when those 

terms are very similar. Typing selling OR retailing, for example, will 

return pages where either of the terms is used, without both needing to 

be present. 

 Use of AND. This operator ensures that you receive only search results 

that include two or more terms. For example, the search "Smee 

Computers" AND "Devlin Corporation" would only deliver search results 

that includes the names of both companies. 

o Search a Specific Site: when you type site: followed by the URL of 

the website that you wish to search and a search term, you limit your 

search to a single website. So, site: mindtools.com "human 

resources" will return all the pages from MindTools.com that feature 

the term "human resources." 

o Finding Related Sites: another useful operator is related: Typing this 

in front of a web address that you already know – as 

in related:xyz.com – your search results will deliver a range of 

websites that are similar to xyz.com.  
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 Key Points 

The internet is vast and often confusing, and in order to find what you want, 

you need to take some basic steps to make your search as focused and 

rewarding as possible. Strategies for pinpointing the best, most relevant 

content include the following: 

o Vary your search engine: in fact, get used to using several, as they 

have different strengths. 

o Use specific keywords: be as specific as you can in your wording. 

o Simplify your search terms: strip out unnecessary stop words and 

avoid suffixes. 

o Use quotation marks: this narrows searches down to particular words 

and phrases. 

o Remove unhelpful words: remove confusing or misdirecting terms 

from your searches with the - (minus) operator. 

o Refine your search using operators: use operators to search specific 

sites, related sites, and particular combinations of terms. 

o Avoid search pitfalls: the internet is a selling tool as well as a 

fantastic resource. Be sure that you only view advertisements if you 

want to. 

Saving a Webpage: 

Saving a webpage can be useful when you plan on accessing a particular 

webpage offline, or if you want to capture the content on a webpage 

indefinitely without having to worry about the content changing or being 

removed at a later date. All web browsers can save web pages for offline 

viewing, and you can even use special programs to download every page on a 

site at once.  
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Here are steps to save a webpage; 

STEP-1: Open any web page 

 

Figure 7.2 (a) - Open any web page 

STEP-2: Right Click on the page and click “Save Page As” 

 

Figure 7.2 (b) - Right Click on the page and click on “Save page as…”  
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STEP-3: Type the name for file 

 

Figure 7.2 (c) - Type File Name 

 

STEP-4: Select location for file. 

 

 

Figure 7.2 (d) - Browse for Location to save the webpage  
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STEP-5: Select “Save As Type” and click “Save” 

 

 
Figure 7.2 (e) - Choose “Save As” Type 

Printing a Webpage: 

A web page's screen appearance is no guarantee of how it prints. There are 

many different elements, including pictures, words, and frames, that you have 

to consider before printing. Many modern printers have an option that allows 

you to print a page exactly as it appears on screen. 

Printing a web page is a fairly simple process, but it differs slightly depending 

on the Internet browser you use. To proceed, select your preferred browser 

from the list below and follow the instructions. 

 

 Microsoft Edge  

If you are using Microsoft Edge, follow these steps. 

1. Open Microsoft Edge. 

2. Click the More  icon in the upper-right corner of the screen. 

3. Select Print from the drop-down menu that appears. 

4. In the window that appears, under the Printer section, choose 

the printer you'd like to use or print to PDF. 

5. Click the Print button at the bottom of the window. 
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 Internet Explorer  

If you are using Internet Explorer, follow these steps. 

1. Open the Internet Explorer browser then open the page you want to 

print. 

2. Click Tools  in the upper-right corner of the browser window. 

3. Move your mouse pointer over Print in the drop-down menu that 

appears. 

4. Click on Print... to bring up the Print Menu. 

5. Make sure the appropriate printer is selected and adjust settings. 

6. Click Apply (if you made any changes), then Print. 

 Google Chrome  

If you are using Google Chrome, follow these steps. 

1. Open the Chrome browser and pull up the page you want to print. 

2. Click Customize and control Google Chrome  in the upper-right 

corner of the browser window. 

3. Select Print... from the drop-down menu that appears. 

4. In the window that appears, under Destination, you can see where your 

document prints. 

5. If you need to change printers or print to PDF, click  and 

make your selection. 

6. When you're done making changes, click the  button. 

 Mozilla Firefox  

If you are using Firefox, follow these steps. 

1. Open the Firefox browser and pull up the page you want to print. 

2. Click Open menu  in the upper-right corner of the browser 

window. 

3. Click the Print icon on the drop-down menu that appears. 

4. In the window that appears, click the Print... button in the upper-left 

corner. 

5. Make sure the appropriate printer is selected and adjust settings. 

6. Click OK to print. You can also press Ctrl+P or Cmd+P to bring up the 

Print Menu. 

7. You may highlight and print only a portion of a page to save paper and 

ink.  
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7.3 - E-MAIL 

Email is a system for delivering messages over the Internet. An e-mail sender 

or recipient can be anywhere in the world. E-mail is the first really popular 

internet application; it allows people to hold discussions over great 

distances. It can be sent to anywhere in the world to anyone who uses the 

Internet. E-mail can take as little as few seconds to go across a country, or 

even around the world. 

It leaves a written record. You can keep copies of e-mail messages you send 

and receive, for your record. One message can be send to a number of 

people. Pictures, documents and other computer files can also be sent along 

with the message.  

CREATING, READING & SENDING E-MAIL 

Creating & sending an email: 

 

 
Figure 7.3 (a) - Gmail Compose View 

1.  Open Gmail. 

2.  On the left, click  Compose. 

3.  (Optional) To change your window size, in the upper corner, click 

Maximize  or Exit full Screen . 

4.  Add recipients and a subject. 

5.  Enter your message. Email you start writing but don't send are 

automatically saved in Drafts on the left. 

6.  (Optional) Add attachments, such as Drive files  or photos . 

7.  Click Send. 

To cancel sending an email, at the bottom of the window, click Undo. 
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Reading an Email: 

Unread emails are bold. To open an email, click it. 

By default, replies to email are grouped into conversations. Keeping all email 

together in a thread makes it easier to keep track of them and saves space in 

your inbox. 

If you prefer to separate your existing email from future email, you can turn 

off conversation view. 

 

 

Figure 7.3 (b) - Gmail Inbox View 

Turn off conversation view: 

1. At the top right, click Settings. 

2. In the General tab, scroll to Conversation View and 

select Conversation view off. 

3. At the bottom, click Save Changes. 

 

7.4 - FILE ATTACHMENTS 

In order to attach files with email, follow these steps; 

1. Open the Gmail home page. 

2. Click Compose. 

3. Click Attach. 

4. Click Attach file or Insert from Drive. 

5. Choose the file you want to attach. 



COMP-162 COMPUTER APPLICATIONS 

 

 
260 | P a g e  

 

7.5 - UPLOADING AND DOWNLOADING FILE(S) 

AND SOFTWARE(S) 

Uploading means data is being sent from your computer to the 

Internet. Examples of uploading include sending email, posting photos on a 

social media site and using your webcam. Even clicking on a link on a web 

page sends a tiny data upload. Downloading means your computer is receiving 

data from the Internet. 

 

Figure 7.6 - Uploading and Downloading files 

 

While exploring the Internet, you’ve probably encountered the 

terms downloading and uploading. Downloading means receiving data or a 

file from the Internet on your computer. Uploading means sending data or a 

file from your computer to somewhere on the Internet. 

These terms describe activities you may have already learned how to do. If 

you've ever opened an example document in one of our tutorials, you've 

downloaded that file. If you’ve ever shared a photo you took on Face book or 

another social media site, you've uploaded that photo. 

There are built in features with email services to upload and download files. 

However, there are several applications which allow users to upload and 

download files on the internet. Google Drive App is one of the popular 

software to upload and download files. IDM (Internet Download Manager) is 

another software used to download files.  
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7.6 - SOME ADVANCE FEATURES OVER THE 

INTERNET 

 Web Hosting: 

A service that allows the users (organizations / individuals) to publish the 

websites on internet is called web hosting. Any person or company having its 

own server and rents out web space for hosting the websites on internet can be 

called Web Host. A Web Hosting Company rents out space on their server for 

monthly fee with different packages. By using this service, users become able 

to show their websites on internet. Websites are stored on special computers 

called servers. 

 

Figure 7.7 (a) - Web Hosting 

When the users enter website address on browser, the computer automatically 

connect to the server and then the WebPages will be delivered to them. Today, 

there are thousands of web hosting services from free service to special 

packaged hosting service. In Paid hosting package, Web Hosting Service 

gives the full backup of websites, security, credit card processing, email, 

integrity of content and all kind of maintenance. 

 Fast Data Downloading 

Everyone wants to increase the downloading speed of their audio, video, 

gaming and other files. On internet, there is a variety of downloading software 

and tools. Internet Downloading Manager (IDM) is best tool available on 

internet to increase downloading speed. IDM is efficient tool that divide 

downloading speed to segments. Its efficiency can also be increase by using 

some tricks.   
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 Web Conferencing Software 

Web conferencing software allows participants to conduct or attend meetings 

via the internet. This is also known as online meeting software or sometimes 

simply video conferencing itself. It enables remote meetings based on VoIP, 

online video, instant messaging, file sharing, and screen sharing. 

Web and video conferencing tools have become fundamental to how many 

organizations conduct business. The software enables remote employees, 

customers, and partners to connect easily and often. Specific uses for web 

conferencing software include: 

 Presentations or webinars 

 Conference calls 

 Video meetings with multiple participants 

 Running product demos and training 

 1-on-1 meetings with remote employees 

 Face-to-face customer support 

The top three benefits of using web and video conferencing software are: 

 Enhanced communications 

 Reduced travel costs 

 Increased efficiency 

Meet and Skype are examples of such software. 

Ecommerce software is the engine behind the scenes of an online store, 

making it possible to easily manage inventory, add or remove products, 

calculate taxes, and everything else required to manage a website and fulfill 

orders. 

WWW: 

WWW stands for World Wide Web, which is also known as a Web, is a 

collection of websites or web pages stored in web servers and connected to 

local computers through the internet. These websites contain text pages, 

digital images, audios, videos, etc. Users can access the content of these sites 

from any part of the world over the internet using their devices such as 

computers, laptops, cell phones, etc. The WWW, along with internet, enables 

the retrieval and display of text and media to your device. 
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Figure 7.7 (b) - World Wide Web 

The World Wide Web was launched in 1989 by English Scientist Tim 

Berners-Lee for adding footnote, and cross-references in hypertext documents. 

www used to identify (distinguish)  the content. The www uses http (Hyper 

Text Transfer Protocol) to link hypertext documents (web pages) on the 

World Wide Web. A web page is a document that is written in HTML 

(Hypertext Markup Language). 

A hypertext document is also called a Web Page. The process of launching 

web page is called publishing the page. A collection of related web pages is 

called a Web Site. Web sites are hosted on server computers on the Internet. 

These computers are called Web Servers. 

Use of Uniform Resource Locator (URL): 

Each web page has a unique address on World Wide Web. This is called 

Uniform Resource Locator (URL). If you want to access a web page on the 

World Wide Web, you will have to specify the URL of the required page in 

the web browser. Protocol Identifier is the first part of the URL and Resource 

Name is the second part of the URL.  
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Basic Components of the URL: 

1. Protocol 

2. www 

3. Domain Name 

4. Resource Name 

5. Question Mark signal 

6. Parameters 

SEARCH ENGINE 

A program (software system) or a web-based tool that is used to search the 

documents (information) by using the keywords on World Wide Web (www) 

is called search engine. World Wide Web is full of information. Today, there 

are thousands of search engines with different abilities and powerful features. 

Google, Yahoo, Bing, MSN and Ask.com are the popular search engines.  

 

Figure 7.7 (c) - Internet Search Engines 

Google has become so powerful and well known search engine now a day. 

First text-based search engine was Veronica. 

 Search Engine Result Page (SERP): 

When a searcher types a keyword query then the search engine displays a 

page called Search Engine Result Page (SERP). SERP is a listing of results in 

response to a keyword queries by a searcher. These results are of two types: 

first type is organic results and the second is sponsored results.  
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Organic results are retrieved by the search engine’s algorithm and 

sponsored are advertisements. The results are ranked on a search engine 

according to the queries. For organic results, each result has the title of post or 

article, permalink and short summary (description) on the SERP while in 

sponsored results, the advertiser makes decision & chooses what to display on 

SERP. 

 How Search Engine Works? 

Internet search engines are special sites that are designed for help the people 

to find information stored on other websites. Crawling, indexing and ranking 

are the steps of a search engine. 

 Crawling: 

Each search engine on the internet has its own spiders that go to different 

websites to discover the new URLs and different contents. Search engines 

have special and advance program for the crawling process. Web crawlers are 

the computer programs that scan and reading the websites. They also called 

spiders, bots and automatic indexers.  

 

Figure 7.7 (d) - How internet Search Engines Work 

When a new web page is found, the spider reads the content and images.  First 

Spiders go to the website and look at the robots.txt file (used for crawling 

restrictions by the webmasters). After crawling the URLs, they generate a 

copy of each page of the website and then pass it to index.  
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 Indexing: 

Index is the sets of database that contain millions of pages to display on 

search. Index is the big list of web pages and words. Indexed data is stored in 

encoded format to save the space. When a user types a query on search bar of 

a search engine, the search engine goes to its index library to fetch the 

required information for display. The search engine find millions of 

information in library but the algorithm of a search engine decides what 

information to display on SERP (Search Engine Result Page). Regularly 

updated websites with unique and genuine contents are given better position 

on SERP. 

 Ranking: 

The last step of search engine is ranking.  Each Search engine has its own 

ranking algorithm to rank the web pages of a website based on keywords. 

Search engines regularly update their algorithms. 

 List of Top 10 Search Engines in the World: 

1. Google 

2. Bing    

3. Yahoo 

4. Baidu 

5. Ask.com 

6. AOL.com 

7. Excite 

8. DuckDuckGo 

9. WolframAlpha 

10. ChaCha.com  



COMP-162 COMPUTER APPLICATIONS 

 

 
267 | P a g e  

 

HOW TO SEARCH TOPICS ON DIFFERENT SEARCH 

ENGINES 

 Search Topics Using GOOGLE Search Engine: 

STEP-1: Open www.google.com 

 

Figure 7.7 (e) - Google Search Page 

STEP-2: Type the topic in the search bar and press ENTER 

 

Figure 7.7 (f) - Google Search Engine 

STEP-3: From the searched list, click on any link close to your desired search. 

 

Figure 7.7 (g) - List of searched web links 
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You may add more words to search bar in order to get the most desired 

results. 

 Search Topics Using YAHOO Search Engine: 

STEP-1: Open YAHOO home page i.e www.yahoo.com 

 

Figure 7.7 (h) - Yahoo Search Engine Interface 

STEP-2: Type the search related words in the search bar and click on the 

search button next to the search box 

STEP-3: Out of the given list of topics select the most suitable one or you may 

repeat the process by adding more words to your search for getting the best 

results. 

7.7 DIFFERENCE BETWEEN INTERNET, 

INTRANET AND EXTRANET 

 Internet: 

1. Internet can be described as a global system of interconnected 

computer network. 

2. Internet is the largest network in as far as the number of connected 

devices is concerned. 

3. Internet is a means of sharing information throughout the world. 

4. It is not regulated by any authority. 

5. Content in the network is readily accessible by everyone who is 

connected. 

6. Internet has no known ownership. 

7. Internet is unregulated and uncensored. 

8. Users have unrestricted access and can access internet anonymously. 

9. Security is dependent of the user of the device connected to network. 

10. An example of internet is the network you use to google words with. 

11. Internet contains different source of information and is available for 

all. 

12. Users need no training on how to work with the network.  
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 Intranet: 

1. Intranet can be described as a network of computers or a private 

network designed for a specific group of users (organization). 

2. It is a small network with a few number of connected devices. 

3. It is used to share confidential information within the organization. 

4. It is regulated by a specific organization. 

5. The data in the network is accessible by the organization members 

only. 

6. Ownership of intranet is by a single organization. 

7. Intranet is regulated by the organization policies. 

8. An intranet may be accessible from the internet, but it is protected by a 

password and accessible only to authorized users. 

9. Security of the network is enforced through a firewall. 

10. An example intranet is a company like ExxonMobil using internal 

network for its business operations. 

11. Intranet contains only specific group information. 

12. Time is required to train users on how to work with the network. 

 Extranet: 

1. Extranet can be described as a private network that uses public 

network to share information with clients (suppliers and vendors). 

2. It is a small network with a few number of connected devices. 

3. Extranet is a means of conveying information between members of the 

organization and external members. 

4. It is regulated by multiple organizations. 

5. The content on the network is accessible to members of the 

organization and external members with access to the network. 

6. Ownership of extranet is by a single or multiple organizations. 

7. Extranet is regulated by contractual agreements between organizations. 

8. An intranet may be accessible from the internet, but it is protected by a 

password and accessible only to authorized users. 

9. Security of the network is enforced through a firewall that separates 

internet and extranet. 

10. Example of extranet is when companies like HP, Intel and Lenovo 

decide to use the same network for related business operations. 

11. Extranet contains only specific group information. 
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12. Time is required to train users on how to work with the network. 

EXERCISE 

Multiple Choice Questions 

1. The network of a company’s own computers is called; 

 (a) Internet (b) Intranet (c) Extranet (d) All of these 

2. Global network of computers is called; 

 (a) Internet (b) Networking (c) Intranet (d) Extranet 

3. The software used to transfer data from one computer to another 

computer in internet is called; 

 (a) HTTP  (b) TCP (c) FTP (d) All these 

4. To receive data in computer from internet is called; 

 (a) Downloading   (b) Uploading  

 (c) Transferring   (d) None of these 

5. First page of website is called; 

 (a) Title page    (b) Home page 

 (c) Webpage    (d) First page 

6. The protocol used to transfer files on internet; 

 (a) TCP  (b) ISP  (c) FTP (d) HTTP 

7. Example of World Wide Web document is  

 (a) MS Word (b) Email (c) Web page (d) World document 

8. In an email address, the symbol used between username and email 

service provider is; 

 (a) $  (b) #  (c) @  (d) A 

9. URL is a short form of; 

 (a) Universal Resource Locator (b) Unlimited Resource Line 

 (c) Under Rule Law   (d) None of these 

10. Common name of web address is; 

 (a) HTML  (b) URL (c) WWW (d) Web 

11. A web page may contain; 

(a) Text  (b) Pictures (c) Audio or video (d) All 

12. FTP stands for; 

 (a) First transmission plate form (b) File transfer protocol 

 (c) First Transfer Protocol  (d) File Transmission Protocol  
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13. A website is a combination of; 

 (a) Web addresses   (b) Web pages  

 (c) Web pictures   (d) Web sites 

14. Software used to see website from internet.  

 (a) Search engine   (b) Web browser  

 (c) Web searcher   (d) Web processor 

15. WWW stands for;  

 (a) Wild Work Web   (b) World Wide Web  

 (c) Word Wide Web   (d) Whole Word Web 

16. To interconnect the computer, this medium is used; 

 (a) Telephone line   (b) Fiber optical cable 

 (c) Satellite or wireless  (d) Any of these 

17. The computer from which information can be gain through internet 

from anywhere in the world. 

 (a) Host  (b) Server (c) Main Hub (d) Both a & b 

18. All the emails received are stored in this folder of your email account. 

 (a) Email folder (b) Mail box (c) Inbox (d) Home box 

19. The website which is used to search different web sites from internet is 

called; 

 (a) Search web   (b) Search engine  

 (c) Search directory   (d) Search tool 

20. The default browser of windows 10 is; 

 (a) Google chrome   (b) Edge  

 (c) Firefox    (d) Opera 

21. This is not Microsoft browser; 

 (a) Edge    (b) Internet explorer  

 (c) Firefox    (d) All these 

22. Search engine is basically a; 

 (a) Powerful website   (b) Powerful engine  

 (c) Powerful webpage   (d) Net driver  
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23. The service of internet by which data can be stored on remote saver.  

 (a) Internet disk   (b) Internet store  

 (c) Cloud storage   (d) Mass storage 

24. The example of cloud storage is; 

 (a) Hard disk    (b) One drive  

 (c) Flash drive    (d) None of these 

25. Limit of free data storage on “one drive “is; 

 (a) 2.5 GB (b) 5 GB (c) 500 MB (d) 700 MB 

26. This is an example of online cloud storage. 

 (a) One drive (b) Drop box (c) Google drive (d) All these 

27. In email window, cc stands for; 

 (a) Carbon copy   (b) Clear copy 

 (c) Close copy    (d) None of these 

28. HTTP stands for; 

 (a) Heavy Traffic Transfer Plan  

 (b) Hyper Text Transfer Protocol  

 (c) High Tension Transmission Project  

 (d) None of these 

29. This feature is not related to internet. 

 (a) World Wide Web   (b) Google  

 (c) FTP    (d) None of these 

30. Network of computers of an organization which gives access to some 

specific consumers is called; 

 (a) Networking (b) Internet (c) Extranet (d) Intranet 

31. If a person is connected with internet, then it is called; 

 (a) Connected    (b) Online 

 (c) Internet attach   (d) Any of these 

32. The most popular search engine is; 

 (a) Google.com   (b) Bing.com  

 (c) Yahoo.com   (d) Ask.com  
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33. This option is available in window of edge browser. 

 (a) Download  (b) History (c) Favorites (d) All these 

34. To transfer a file from computer to internet is called; 

 (a) File transferring   (b) Uploading  

 (c) Downloading   (d) File loading 

35. This file cannot be attached with email message. 

 (a) Text document   (b) Spread sheet  

 (c) Video    (d) None of these 

36. In email address, siralibutt@gmail.com, this part is the username; 

 (a) sirali    (b) siralibutt@  

 (c) siralibutt    (d) gmail.com 

37. With reference to internet, ISP stands for; 

 (a) Inter Services Protocol (b) Internet Service Provider 

(c) Internet Service Payment (d) None of these 

38. Different web pages are linked with each other through; 

 (a) Email    (b) Fiber optical cable 

 c) Hyper link     (d) Net link 

39. FTP facility is used to; 

 (a) Web designing   (b) Web browsing 

 (c) Transfer of files through internet (d) All these 

 

ANSWERS KEY 

 

 

Short Questions 

1. What is internet? 

2. What is intranet? 

3. Which medium are used to connect the computers with each other. 
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4. Which software is used to transfer data on internet from one computer to 

another computer? 

5. What is internet server? 

6. Write 8 advantages of internet. 

7. What is WWW and for what it stands? 

8. What is web page? 

9. Define website. 

10. For what ISP stands? 

11. What is web browser? 

12. Define search engine. 

13. What is modem? 

14. What is URL?            

15. Write full name of following domain names. 

16. What is an email? 

17. What is FTP stands for and for which purpose it is used. 

18. What is meant by home page? 

19. Write two advantages of email. 

20. Write names of three email service provider companies. 

21. What is meant by become "online". 

22. What is an Edge browser? 

23. Write name of four search engines. 

24. What is meant by "Sign in" with respect to email? 

25. What is meant by cloud storage? 

26. What is meant by uploading and downloading? 

27. What is "Inbox" in email? 

28. For what FTP and HTTP stands for? 

29. What is difference between intranet and extranet. 

30. What is a host computer? 

31. What is google? 

32. What is meant by CC and BCC in email?  
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Long Questions 

1. What is an internet? Write its advantages. 

2. What is difference between web page & website? Also write 

disadvantages of internet. 

3. Explain the following. 

4. For which sector, following domains are used. 

1. .com  2. .gov         3. .edu  4. .mil 

5. Explain the four components of a web address given below.  

www.pbte.edu.pk 

6. Which software is used for uploading and downloading file on internet? 

What is meant by home page of a browser? 

7. Give brief introduction of components of "edge" browser window. 

8. Write method of saving web page on computer hard disk. 

9. Write method of printing a web page. 

10. Define search engine. Write names of two famous search engines. Write 

method of searching a website using search engine. 

11. Write method of sending and reading an e-mail. 

12. Write names of two email service provider companies and write method of 

sending a file through email. 

13. Write some advance features of internet. 

14. Write method of opening a website using “Microsoft Edge” browser. 

15. What is cloud storage? Write note on sky drive and one drive. 

16. Write difference between internet, extranet and intranet. 


